
IBM® User’s Reference

ServeRAID™ -4 Ultra160 SCSI Controller

SC25-P257-90

���





IBM® User’s Reference

ServeRAID™ -4 Ultra160 SCSI Controller

SC25-P257-90

���



Note: Before using this information and the product it supports, be sure and read the general information under
“Appendix B. Warranty information” on page 173.

Fourth Edition (October 2001)

© Copyright International Business Machines Corporation 2001. All rights reserved.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.



Safety

Before installing this product, read the Safety Information book.

Antes de instalar este produto, leia o Manual de Informações sobre Segurança.

Před instalací tohoto produktu si přečtěte příručku bezpečnostních instrukcí.

Læs hæftet med sikkerhedsforskrifter, før du installerer dette produkt.

Lue Safety Information -kirjanen, ennen kuin asennat tämän tuotteen.

Avant de procéder à l’installation de ce produit, lisez le manuel Safety Information.

Vor Beginn der Installation die Broschüre mit Sicherheitshinweisen lesen.

Przed zainstalowaniem tego produktu należy przeczytać broszurę Informacje Dotyczące
Bezpieczeństwa.

Prima di installare questo prodotto, leggere l’opuscolo contenente le informazioni
sulla sicurezza.

Lees voordat u dit product installeert eerst het boekje met veiligheidsvoorschriften.

Les heftet om sikkerhetsinformasjon (Safety Information) før du installerer dette
produktet.

Antes de instalar este produto, leia o folheto Informações sobre Segurança.

Перед установкой продукта прочтите брошюру по технике безопасности
(Safety Information).

© Copyright IBM Corp. 2001 iii



Pred inštaláciou tohto produktu si pre ítajte Informa nú brožúrku o bezpe nosti.

Preden namestite ta izdelek, preberite knjižico Varnostne informacije.

Antes de instalar este producto, lea la Información de Seguridad.

Läs säkerhetsinformationen innan du installerar den här produkten.
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Statement 1

Danger
Electrical current from power, telephone, and communication cables is hazardous.

To avoid a shock hazard:

v Do not connect or disconnect any cables or perform installation, maintenance, or
reconfiguration of this product during an electrical storm.

v Connect all power cords to a properly wired and grounded electrical outlet.

v Connect to properly wired outlets any equipment that will be attached to this
product.

v When possible, use one hand only to connect or disconnect signal cables.

v Never turn on any equipment when there is evidence of fire, water, or structural
damage.

v Disconnect the attached power cords, telecommunications systems, networks, and
modems before you open the device covers, unless instructed otherwise in the
installation and configuration procedures.

v Connect and disconnect cables as described in the following table when installing,
moving, or opening covers on this product or attached devices.

To connect:

1. Turn everything OFF.

2. First, attach all cables to devices.

3. Attach signal cables to connectors.

4. Attach power cords to outlet.

5. Turn device ON.

To disconnect:

1. Turn everything OFF.

2. First, remove power cords from outlet.

3. Remove signal cables from connectors.

4. Remove all cables from devices.

Statement 2
CAUTION:

When replacing the lithium battery, use only IBM Part Number 33F8354 or an
equivalent type battery recommended by the manufacturer. If your system has a
module containing a lithium battery, replace it only with the same module type made
by the same manufacturer. The battery contains lithium and can explode if not
properly used, handled, or disposed of.

Do not:

v Throw or immerse into water.

v Heat to more than 100° C (212° F)

v Repair or disassemble

Dispose of the battery as required by local ordinances or regulations.

Safety v



Statement 5

CAUTION:
The power control button on the device and the power switch on the power supply do
not turn off the electrical current supplied to the device. The device also might have
more than one power cord. To remove all electrical current from the device, ensure
that all power cords are disconnected from the power source.

1
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Preface

This book provides information for configuring an IBM
®

ServeRAID™ controller,
installing device drivers, and installing and using the ServeRAID utility programs
and the IBM ServeRAID Cluster Solution.

Note: The IBM ServeRAID product can be either a controller on an adapter, such
as the one in this option package, or a controller on the system board of
your server. For consistency in this manual, the ServeRAID product is
referred to as a ServeRAID controller, unless it is specifically noted
otherwise.

To install device drivers and utility programs for an IBM ServeRAID controller
that comes as a standard feature on an IBM server system board, see the
installation instructions and CDs provided with your server for instructions.

How this book is organized
“Chapter 1. Product information” on page 3 contains introductory information and
specifications for the IBM ServeRAID-4H, ServeRAID-4M, ServeRAID-4Mx,
ServeRAID-4L, and ServeRAID-4Lx controllers.

“Chapter 2. Installing and cabling a ServeRAID controller” on page 9 explains how
to install and cable a ServeRAID controller.

“Chapter 3. Understanding RAID technology” on page 15 contains general
information about RAID technology.

“Chapter 4. Configuring ServeRAID controllers” on page 29 explains the ServeRAID
configuration process. You can refer to the information in this chapter when
configuring one or more devices attached to a ServeRAID controller.

“Chapter 5. Installing ServeRAID device drivers” on page 43 contains information
about installing and updating the ServeRAID device drivers.

“Chapter 6. Configuring two ServeRAID controllers in a failover environment” on
page 45 contains instructions for configuring two ServeRAID controllers in a failover
environment. These instructions are for Microsoft® Windows NT® 4.0 and Microsoft
Windows® 2000 only.

“Chapter 7. Using the ServeRAID Mini-Configuration program” on page 59,
“Chapter 8. Installing and using the IPSSEND command-line program” on page 63,
and “Chapter 9. Using the IPSMON command-line program (NetWare only)” on
page 85 contain instructions for installing, starting, and using the Mini-Configuration,
IPSSEND, and IPSMON programs. You can use these operating-system-specific
programs to maintain and monitor your ServeRAID subsystem.

“Chapter 10. Installing and starting the ServeRAID Manager program” on page 87
contains instructions for installing and starting the ServeRAID Manager program.
You can use this program to maintain and monitor your ServeRAID subsystem.

“Chapter 11. Introduction to the IBM ServeRAID Cluster Solution” on page 97 and
“Chapter 12. Preparing to install or change a cluster solution” on page 101 provide
general information about the IBM ServeRAID Cluster Solution, including terms,
definitions, and considerations.

© Copyright IBM Corp. 2001 xi



“Chapter 13. Configuring ServeRAID controllers for clustering” on page 105 explains
the procedure for configuring ServeRAID controllers for clustering when using the
Microsoft Cluster Service (MSCS).

“Chapter 14. Installing the Microsoft Cluster Service software” on page 113 provides
the procedure for installing Microsoft Cluster Service on Windows 2000 and
Windows NT 4.0.

“Chapter 15. Monitoring and updating an IBM ServeRAID Cluster Solution” on
page 129 contains information for monitoring and updating an IBM ServeRAID
Cluster Solution.

“Chapter 16. Obtaining ServeRAID updates” on page 135 and “Chapter 17.
Updating the ServeRAID BIOS, firmware, and software code for clustering” on
page 137 provide information for obtaining IBM ServeRAID and IBM ServeRAID
Cluster Solution updates from the World Wide Web.

“Chapter 18. Upgrading a ServeRAID controller” on page 139 contains instructions
for upgrading your ServeRAID controller.

“Chapter 19. Solving ServeRAID problems” on page 141 describes the ServeRAID
POST error codes and startup messages. This chapter also includes some basic
information about rebuilding a defunct drive and troubleshooting failover and cluster
problems.

“Chapter 20. Getting information, help, and service” on page 165 provides
information about accessing the IBM HelpCenter® and World Wide Web sites to
obtain future code and information updates for the ServeRAID controller.

“Appendix A. Creating ServeRAID diskettes” on page 171 contains instructions for
creating the ServeRAID Support diskettes, which contain device drivers and the
IPSSEND utility program.

“Appendix B. Warranty information” on page 173 contains warranty information.

“Appendix C. Notices” on page 183 contains product notices and trademarks.

Notices that are used in this book
This book contains the following notices designed to highlight key information:

v Notes: These notices provide important tips, guidance, or advice.

v Important: These notices provide information or advice that might help you avoid
inconvenient or difficult situations.

v Attention: These notices indicate possible damage to programs, devices, or
data. An attention notice is placed just before the instruction or situation in which
damage could occur.

IBM ServeRAID Support CD
The IBM ServeRAID Support CD contains the following:

v ServeRAID ROM Update wizard

v Device drivers

v ServeRAID Manager program

v IPSSEND command-line program
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v Diskette images

v ServeRAID files needed to install Microsoft Cluster Service (MSCS)

v ServeRAID publications

ServeRAID ROM Update Wizard
The IBM ServeRAID ROM (read-only memory) Update Wizard is a program
designed to automatically identify and scan each ServeRAID controller installed in
your server. If the BIOS and firmware code need updating, the wizard will give you
the opportunity to do so.

Device drivers
The device drivers are located in the following directory on the IBM ServeRAID
Support CD:

e:/operatingsystem/DRIVER

where e is the CD-ROM drive and operatingsystem is the specific operating system
used in the ServeRAID installation.

The device drivers are also located on the operating-system-specific IBM
ServeRAID Support diskettes.

ServeRAID Manager program
Use this program to configure arrays and logical drives using ServeRAID
controllers. ServeRAID Manager operates in two ways: in startable-CD mode and
as an installed program. In startable-CD mode, you can configure your ServeRAID
adapter before you install an operating system.

This program is available in the following directory:

e:/operatingsystem/MANAGER

where e is the CD-ROM drive and operatingsystem is the specific operating system
used in the ServeRAID installation.

IPSSEND command-line program
Use this program to configure and manage your ServeRAID controllers. This
program is available on both the IBM ServeRAID Support CD and the
operating-system-specific IBM ServeRAID Support diskettes.

Diskette images
Use these images to create the ServeRAID diskettes. These diskettes include the
following:

v IBM ServeRAID BIOS and Firmware Update (1 of 2) diskette.

v IBM ServeRAID BIOS and Firmware Update (2 of 2) diskette.

v IBM ServeRAID Cluster Solution for Windows NT 4.0 and Windows 2000
diskette.

v IBM ServeRAID Support for Windows 2000 Server diskette

v IBM ServeRAID Support for Windows (Professional Editions) diskette

v IBM ServeRAID Support for Windows NT 4.0 diskette

v IBM ServeRAID Support for IBM OS/2 diskette
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v IBM ServeRAID Support for Novell NetWare diskette

v IBM ServeRAID Support for Caldera UnixWare and Open UNIX diskette

v IBM ServeRAID Support for SCO OpenServer diskette

v IBM ServeRAID Support for Red Hat Linux (1 of 2) diskette

v IBM ServeRAID Support for Red Hat Linux (2 of 2) diskette

v IBM ServeRAID Support for Caldera OpenLinux diskette

v IBM ServeRAID Support for SuSE Linux diskette

v IBM ServeRAID Support for Turbolinux diskette

v IBM ServeRAID Support for DOS diskette

These files are available in the e:/DISKETTE directory, where e is the CD-ROM
drive.

For instructions on creating the diskettes, refer to “Appendix A. Creating ServeRAID
diskettes” on page 171.

ServeRAID files needed to install Microsoft Cluster Service (MSCS)

Note: The IBM ServeRAID Cluster Solution requires either Windows 2000 or
Windows NT 4.0.

These files are available in the following directory:

e:/operatingsystem/CLUSTER

where e is the CD-ROM drive and operatingsystem is the specific operating system
used in the ServeRAID installation.

ServeRAID publications
The following books are available in Portable Data Format (PDF) on the IBM
ServeRAID Support CD in the /BOOKS directory:

v IBM ServeRAID-4 Ultra160 SCSI Controller User’s Reference (4SRAIDUR.PDF)

v IBM ServeRAID-4 Ultra160 SCSI Controller Device Driver Installation Instructions
(4DEVDRV.PDF)

The following booklets are extracted from the IBM ServeRAID-4 Ultra160 SCSI
Controller User’s Reference and are available on the IBM ServeRAID Support CD
in the /BOOKS directory:

v IBM ServeRAID-4 Ultra160 SCSI Controller Installation Guide (4INSTALL.PDF)

v Configuring IBM ServeRAID Controllers for Failover (4FAILCFG.PDF)

v Installing the IBM ServeRAID Cluster Solution (4CLUSTER.PDF)

v Understanding IBM ServeRAID Technology (4TECHNOL.PDF)

Note: Use Adobe Acrobat Reader to view these files. The IBM ServeRAID Support
CD contains the Acrobat Readers for Microsoft Windows, IBM OS/2, and
Linux in the /BOOKS/READERS directory.

If you are installing the IBM ServeRAID Cluster Solution, you might need to refer to
the IBM Shared Disk Clustering Hardware Reference. This book provides general
information about planning and configuring a shared-disk cluster using IBM server
products. It contains illustrations, descriptions, and parts listings for various
high-availability, shared-disk cluster examples.
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Note: You can obtain this publication from the IBM Support Web site. See
“Chapter 16. Obtaining ServeRAID updates” on page 135 for additional
information.

In addition, the following IBM Red books might be of interest:

v Implementing Netfinity Disk Subsystems: ServeRAID SCSI, Fibre Channel, and
SSA

v Tuning Netfinity Server for Performance: Getting the most out of Windows 2000
and Windows NT 4.0

v Netfinity Director: Integration and Tools

v Netfinity Clustering Planning Guide

You can download these books from the following IBM Web site:

http://www.ibm.com/redbooks

Supported operating systems
The following operating systems are supported with a ServeRAID-4 Ultra160 SCSI
controller:

v Microsoft Windows XP Professional (ServeRAID-4Lx controller only)

v Microsoft Windows 2000

v Microsoft Windows NT 4.0

v Novell NetWare (version 4.2 and later)

v IBM OS/2® WARP® Server for E-Business

v Red Hat Linux (version 6.2 or later)

v SuSE Linux 7.1

v Caldera OpenLinux 3.1

v Turbolinux 6.5

v SCO OpenServer 5.0.6a

v Caldera UnixWare 7.1

v Caldera Open UNIX 8.0
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Part 1. Installation and configuration
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Chapter 1. Product information

This book provides the information needed to install and configure the following:

v IBM ServeRAID-4H Ultra160 SCSI controller

v IBM ServeRAID-4M Ultra160 SCSI controller

v IBM ServeRAID-4Mx Ultra160 SCSI controller

v IBM ServeRAID-4L Ultra160 SCSI controller

v IBM ServeRAID-4Lx Ultra160 SCSI controller

Hereafter, these controllers are referred to as IBM ServeRAID-4 Ultra160 SCSI
controllers. These high-performance, redundant array of independent disk (RAID)
controllers are ideally suited for data-storage environments that require superior
performance, flexibility, and reliable data storage. (See “Controller features” for
more information.)

You also can use the configuration and reference information in this book to
configure the IBM ServeRAID controllers provided on some IBM server system
boards.

Option package contents
In addition to this book, the ServeRAID option package contains:

v IBM ServeRAID Support CD

See “IBM ServeRAID Support CD” on page xii for more detailed information.

v One of the following:

– IBM ServeRAID-4H Ultra160 SCSI controller

– IBM ServeRAID-4Mx Ultra160 SCSI controller

– IBM ServeRAID-4Lx Ultra160 SCSI controller

Attention: Do not open the static-protective package containing the controller
until you are instructed to do so.

Contact your place of purchase if any items are missing or damaged.

Controller features
The standard features of the ServeRAID-4 Ultra160 SCSI controllers are as follows.

Feature ServeRAID-4H ServeRAID-4M ServeRAID-4Mx ServeRAID-4L ServeRAID-4Lx

Arrays (max.) 8 8 8 8 8

Battery-backup cache Yes Yes Yes No No

Cache memory 128 MB 64 MB 64 MB 16 MB 32 MB

Hard disk drives (max.) 60 30 30 15 15

Logical drives (max.) 8 8 8 8 8

Microprocessor 266 MHz 100 MHz 100 MHz 100 MHz 100 MHz

SCSI channels 4 2 2 1 1

SCSI transfer speed
(max.)

160 MB per
sec.

160 MB per
sec.

160 MB per sec. 160 MB per
sec.

160 MB per sec.
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Feature ServeRAID-4H ServeRAID-4M ServeRAID-4Mx ServeRAID-4L ServeRAID-4Lx

Supported RAID levels 0, 1, 5,
Enhanced-1
(1E), and
Enhanced-5
(5E), 00, 10,
1E0, 50

0, 1, 5,
Enhanced-1
(1E), and
Enhanced-5
(5E), 00, 10,
1E0, 50

0, 1, 5,
Enhanced-1 (1E),
and Enhanced-5
(5E), 00, 10, 1E0,
50

0, 1, 5,
Enhanced-1
(1E), and
Enhanced-5
(5E), 00, 10,
1E0, 50

0, 1, 5,
Enhanced-1 (1E),
and Enhanced-5
(5E), 00, 10,
1E0, 50

System PCI data bus 64 bit at 33
MHz

64 bit at 33
MHz

64 bit at 33 to 66
MHz

64 bit at 33
MHz

64 bit at 33 to 66
MHz

Connector locations
This section provides illustrations of the SCSI channel connectors and cable
connectors for the ServeRAID-4H, ServeRAID-4M, ServeRAID-4Mx, ServeRAID-4L,
and ServeRAID-4Lx controllers.

The light-emitting diodes (LEDs) on the controllers indicate activity on the SCSI
channels and provide diagnostic information for trained service technicians.

ServeRAID-4H controller
The ServeRAID-4H controller has four independent SCSI channel connectors:
Channel 1, Channel 2, Channel 3, and Channel 4. Each of these SCSI channels
supports up to 15 physical devices.

Note: In the event of a power outage or failure, the battery-backup cache protects
the data stored in the ServeRAID cache memory when using the write-back
setting of the write-cache mode.

You can attach internal SCSI devices to the internal Channel 1 and Channel 2
connectors. You can attach external SCSI devices to the external Channel 1,

Internal Channel 2

Internal Channel 1

Battery for Backup Cache

External Channel 1

External Channel 2

External Channel 3

External Channel 4

Figure 1. ServeRAID-4H controller

4 IBM® User’s Reference: ServeRAID™ -4 Ultra160 SCSI Controller



Channel 2, Channel 3, and Channel 4 connectors. You cannot attach internal and
external SCSI devices to the same channel. For example, you cannot attach
devices to both external Channel 1 and internal Channel 1. The ServeRAID-4
controllers do not support configurations that use both the internal and external
connectors on the same channel concurrently.

Note: The ServeRAID-4H controller uses the module (P/N 38L3386) containing a
lithium battery.

Statement 2
CAUTION:

When replacing the lithium battery, use only IBM Part Number 33F8354 or an
equivalent type battery recommended by the manufacturer. If your system has a
module containing a lithium battery, replace it only with the same module type made
by the same manufacturer. The battery contains lithium and can explode if not
properly used, handled, or disposed of.

Do not:

v Throw or immerse into water.

v Heat to more than 100° C (212° F)

v Repair or disassemble

Dispose of the battery as required by local ordinances or regulations.

ServeRAID-4M and ServeRAID-4Mx controller
The ServeRAID-4M and ServeRAID-4Mx controllers have two independent SCSI
channel connectors: Channel 1 and Channel 2. Each of these SCSI channels
supports up to 15 physical devices.

Note: In the event of a power outage or failure, the battery-backup cache protects
the data stored in the ServeRAID cache memory when using the write-back
setting of the write-cache mode.
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You can attach internal SCSI devices to the internal Channel 1 and Channel 2
connectors. You can attach external SCSI devices to the external Channel 1 and
Channel 2 connectors. You cannot attach internal and external SCSI devices to the
same channel. For example, you cannot attach devices to both external Channel 1
and internal Channel 1. The ServeRAID-4 controllers do not support configurations
that use both the internal and external connectors on the same channel
concurrently.

Note: The ServeRAID-4M and ServeRAID-4Mx controllers use the module (P/N
38L3386) containing a lithium battery.

Statement 2
CAUTION:

When replacing the lithium battery, use only IBM Part Number 33F8354 or an
equivalent type battery recommended by the manufacturer. If your system has a
module containing a lithium battery, replace it only with the same module type made
by the same manufacturer. The battery contains lithium and can explode if not
properly used, handled, or disposed of.

Do not:

v Throw or immerse into water.

v Heat to more than 100° C (212° F)

v Repair or disassemble

Dispose of the battery as required by local ordinances or regulations.

Internal Channel 2

Internal Channel 1

Battery for Backup Cache

External Channel 2

External Channel 1

Figure 2. ServeRAID-4M and ServeRAID-4Mx controller
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ServeRAID-4L and ServeRAID-4Lx controller
The ServeRAID-4L and ServeRAID-4Lx controllers have one independent SCSI
channel connector, Channel 1. This SCSI channel supports up to 15 physical
devices.

You can attach internal SCSI devices to the internal Channel 1 connector. You can
attach external SCSI devices to the external Channel 1 connector. You cannot
attach internal and external SCSI devices to the same channel. For example, you
cannot attach devices to both external Channel 1 and internal Channel 1. The
ServeRAID-4 controllers do not support configurations that use both the internal and
external connectors on the same channel concurrently.

Internal Channel 1

External Channel 1

Figure 3. ServeRAID-4L controller

Internal Channel 1

External Channel 1

Figure 4. ServeRAID-4Lx controller
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Note: The ServeRAID-4L and ServeRAID-4Lx controllers use the module (P/N
38L3386) containing a lithium battery.

Statement 2
CAUTION:

When replacing the lithium battery, use only IBM Part Number 33F8354 or an
equivalent type battery recommended by the manufacturer. If your system has a
module containing a lithium battery, replace it only with the same module type made
by the same manufacturer. The battery contains lithium and can explode if not
properly used, handled, or disposed of.

Do not:

v Throw or immerse into water.

v Heat to more than 100° C (212° F)

v Repair or disassemble

Dispose of the battery as required by local ordinances or regulations.
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Chapter 2. Installing and cabling a ServeRAID controller

This chapter provides installation and cabling instructions for the IBM ServeRAID-4
Ultra160 SCSI controllers.

If you are using a ServeRAID controller on an IBM server system board, you will
not need the information in this section. Go to “Updating BIOS and firmware code”
on page 30.

Using a ServeRAID controller in a server with Active™ PCI features
Some IBM servers support Active PCI (also called hot-plug PCI) features. You can
use these features to install or remove PCI controllers without turning off the server.
The ServeRAID-4 controller supports Active PCI functions on Windows NT 4.0,
Windows 2000, and NetWare. The following table summarizes which operating
systems support these features.

Feature Windows NT
4.0

Windows 2000 NetWare 4.x NetWare 5.x

Hot add Yes Yes No Yes

Hot remove No Yes Yes Yes

Hot replace Yes No No No

You can use the hot-add feature to add a controller to a running server, thus
expanding its capacity.

Note: If you are not using the hot-add feature, restore the controller to the
factory-default settings before configuring arrays and logical drives.

Use the hot-remove feature to remove a controller from a running server. If a
controller fails, use the hot-replace feature to replace a controller with an identical
controller.

Attention: Do not attempt a hot-replace operation on Windows 2000 or NetWare
by hot-removing a failed controller and then hot-adding a new controller. Loss of
data can occur. If a controller fails on these operating systems, you must shut down
the server to replace the controller.

Using Windows NT 4.0 with Active PCI features
To use Active PCI with Windows NT 4.0 and a ServeRAID-4 controller, you must
install the following software components in this order:

1. DMI Service provider. A free version is included on the IBM ServeRAID Support
CD in the following directory:

e:\WINNT\DMISP\setup.exe

where e is the CD-ROM drive.

Note: This version is sufficient for most users’ needs, but a Y2K compliant
version is available at the following Web site:

http://www.enablers.com
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2. IBM Hot Plug for Windows NT 4.0 Package, version 4.2 or later. This package is
available from the IBM Support Web site. See “Downloadable files from the
World Wide Web” on page 135 for additional information.

Note: Be sure to read the instructions and restrictions for this software
program.

3. ServeRAID Active PCI DMI component. This is an optional component that you
can install during the ServeRAID Manager installation.

To perform a hot-replace operation, start the IBM ServeRAID Hot Replace Wizard.
You can start this program from within either the IBM Hot Plug for Windows NT 4.0
program or the ServeRAID Manager program. You can use the ServeRAID
Manager program to start the wizard either on the server with the failed controller,
or across the network from a remote installation of the ServeRAID Manager.

Note: It is useful to start the IBM ServeRAID Hot Replace Wizard from a remote
installation when the server with the failed controller does not have a
monitor.

Installing the ServeRAID controller
During the installation, you might need a small, flat-blade screwdriver and the
documentation that comes with your server.

To install the ServeRAID-4 controller:

1. Review “Safety” on page iii and the Safety Information book provided with your
server.

Note: Some IBM servers support Active PCI features, which enable you to
install or remove PCI controllers without turning off the server. If your
server model provides Active PCI support and you are using Windows
2000, Windows NT 4.0, or NetWare 5.x, you do not need to turn off
your server to install this controller. This operation is referred to as a
hot-add operation. Review the following information before performing
this operation:

v Refer to the information provided with your server to determine
whether your model supports these features.

v Refer to the documentation provided with your operating system for
information concerning using these features.

v Refer to “Using a ServeRAID controller in a server with Active™ PCI
features” on page 9.

v Refer to the documentation that is provided with the IBM Hot Plug for
Windows NT 4.0 package, if you intend to perform a hot-add
operation using Windows NT 4.0.
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2. If your server model does not support Active PCI, turn off the server and
disconnect all power cords and cables from the server.

Statement 5

CAUTION:
The power control button on the device and the power switch on the power supply do
not turn off the electrical current supplied to the device. The device also might have
more than one power cord. To remove all electrical current from the device, ensure
that all power cords are disconnected from the power source.

1

2

3. Remove the server cover and locate an empty PCI expansion slot for the
controller. Choose a slot that is farthest from other installed components, such
as the microprocessor. If necessary, see your server documentation for more
detailed information about the expansion slots.

Note: For Netfinity® 3000 servers, the ServeRAID controllers are supported
only when installed in PCI slot 3. Do not install these controllers in PCI
slot 1 or 2. Before you can install a ServeRAID controller in a Netfinity
3000 server, you must first remove the standard SCSI controller that
comes in PCI slot 3. You can install and use the standard SCSI
controller in PCI slots 1 or 2, but devices that are attached to the
standard SCSI controller will no longer provide startup (boot) support.

4. Remove the expansion-slot cover, if applicable.

5. Touch the static-protective package containing the controller to an unpainted
metal expansion-slot cover on the server. This discharges any static electricity
from the package and your body.

6. Holding the controller by the edges, remove it from the static-protective
package. Do not touch any exposed components on the controller.

7. Insert the controller into the PCI expansion slot. Press the controller firmly into
the slot so that it is fully seated.
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8. Secure the controller by either tightening the expansion-slot screw on the top
of the controller or closing the latch, depending on your server.

9. Connect the SCSI cables to the controller. If you intend to attach external
devices only, go to step 13 on page 13. Otherwise, go to step 10.

10. Connect one end of a 68-pin standard cable (separately purchased or already
in your server) to the internal channel connector on the ServeRAID controller.

Note: See “Connector locations” on page 4 for the channel connector
locations.

Figure 5. Inserting a ServeRAID-4H controller into the PCI expansion slot
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11. Connect the other end of the SCSI cable to the SCSI backplane or to a SCSI
device in the server. (See your server documentation or the system label inside
the server cover for the location of the SCSI connector on the backplane.)

12. If you have physical drives to install, install them now. See your server
documentation for drive installation instructions.

13. Install the server cover.

14. If you disconnected the cables and power cords in step 2 on page 11,
reconnect the cables and cords. See your server documentation if you need
detailed instructions.

15. If you want to attach an external SCSI device to the ServeRAID controller, go
to “Connecting external devices”. Otherwise, go to “Chapter 3. Understanding
RAID technology” on page 15.

Connecting external devices

Note: You cannot attach internal and external SCSI devices to the same channel.
For example, you cannot attach devices to both external Channel 1 and
internal Channel 1. The ServeRAID-4 controllers do not support
configurations that use both the internal and external connectors on the
same channel concurrently.

To attach SCSI devices to an external channel connector on the ServeRAID
controller:

1. Connect one end of a 68-pin very-high-density connector interface (VHDCI)
SCSI cable to an external channel connector on the ServeRAID controller.

Note: See “Connector locations” on page 4 for the channel connector locations.

Figure 6. Connecting a ServeRAID-4H controller internal channel connector
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2. Connect the other end of the SCSI cable to the external SCSI device.

3. Go to “Updating BIOS and firmware code” on page 30.

Figure 7. Connecting a ServeRAID-4H controller external channel connector
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Chapter 3. Understanding RAID technology

Redundant array of independent disk (RAID) is the technology of grouping several
physical drives in a computer into an array that you can define as one or more
logical drives. Each logical drive appears to the operating system as a single drive.
This grouping technique greatly enhances logical-drive capacity and performance
beyond the physical limitations of a single physical drive.

When you group multiple physical drives into a logical drive, the ServeRAID
controller can transfer data in parallel from the multiple drives in the array. This
parallel transfer yields data-transfer rates that are many times higher than with
nonarrayed drives. This increased speed makes the system better able to meet the
throughput (the amount of data processed in a given amount of time) or productivity
needs of the multiple-user network environment.

The ability to respond to multiple data requests provides not only an increase in
throughput, but also a decrease in response time. The combination of parallel
transfers and simultaneous responses to multiple requests enables disk arrays to
provide a high level of performance in network environments.

Note: If you already understand these concepts, go to “Chapter 4. Configuring
ServeRAID controllers” on page 29.

Stripe-unit size
With RAID technology, data is striped across an array of physical drives. This
data-distribution scheme complements the way the operating system requests data.

The granularity at which data is stored on one drive of the array before subsequent
data is stored on the next drive of the array is called the stripe-unit size.

You can set the stripe-unit size to 8 KB, 16 KB, 32 KB, or 64 KB. You can
maximize the performance of your ServeRAID controller by setting the stripe-unit
size to a value that is close to the size of the system I/O requests. For example,
performance in transaction-based environments, which typically involve large blocks
of data, might be optimal when the stripe-unit size is set to 32 KB or 64 KB.
However, performance in file and print environments, which typically involve multiple
small blocks of data, might be optimal when the stripe-unit size is set to 8 KB or
16 KB.

The collection of stripe units, from the first drive of the array to the last drive of the
array, is called a stripe.
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Selecting a RAID level and tuning performance
Disk arrays are used to improve performance and reliability. The amount of
improvement depends on the application programs that you run on the server and
the RAID levels that you assign to the logical drives.

Each RAID level provides different levels of fault-tolerance (data redundancy),
utilization of physical drive capacity, and read and write performance. In addition,
the RAID levels differ in regard to the minimum and maximum number of physical
drives that are supported.

When selecting a RAID level for your system, consider the following factors.

RAID level Data
redundancy

Physical drive
capacity
utilization

Read
performance

Write
performance

Built-in
spare
drive

Min.
number
of drives

Max.
number
of drives

RAID level-0 No 100% Superior Superior No 1 16

RAID level-1 Yes 50% Very high Very high No 2 2

RAID level-1E Yes 50% Very high Very high No 3 16

RAID level-5 Yes 67% to 94% Superior High No 3 16

RAID level-5E Yes 50% to 88% Superior High Yes 4 16

RAID level-00 No 100% Superior Superior No 2 60

RAID level-10 Yes 50% Very high Very high No 4 60

RAID
level-1E0

Yes 50% Very high Very high No 6 60

RAID level-50 Yes 67% to 94% Superior High No 6 60

Physical drive utilization, read performance, and write performance depend on the
number of drives in the array. Generally, the more drives in the array, the better the
performance.

Supported RAID levels
The ServeRAID controllers support RAID level-0, level-1, level-1E, level-5, level-5E,
level-00, level-10, level-1E0, and level-50.
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Understanding RAID level-0
RAID level-0 stripes the data across all the drives in the array. This offers
substantial speed enhancement but provides no data redundancy. RAID level-0
provides the largest storage capacity of the RAID levels that are offered, because
no room is taken for redundant data or data-parity storage.

RAID level-0 requires a minimum of one drive and, depending upon the level of
firmware and the stripe-unit size, supports a maximum of 8 or 16 drives.

The following illustration shows an example of a RAID level-0 logical drive.

Start with two physical drives.

Create an array using the two physical drives.

Then create a logical drive within that array.

The data is striped across the drives, creating blocks.

Notice that the data is striped across all the drives in
the array, but no redundant data is stored.

1 2

3 4

5 6

7 8

A physical drive failure within the array results in loss of data in the logical drive
assigned RAID level-0, but only in that logical drive. If you have logical drives
assigned RAID level-1, level-1E, level-5, or level-5E in the same array, they will not
lose data.

Note: If you have an array that contains only one physical drive, you can assign
only RAID level-0 to the logical drive in that array.
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When you replace a failed drive, the ServeRAID controller can rebuild all the RAID
level-1, level-1E, level-5, and level-5E logical drives automatically onto the
replacement physical drive. However, any data stored in a failed RAID level-0
logical drive is lost.

Although the risk of data loss is present, you might want to assign RAID level-0 to a
logical drive to take advantage of the speed this RAID level offers. You can use this
logical drive to store data that you back up each day and can re-create easily. You
also might want to use a RAID level-0 logical drive when you require maximum
capacity.

RAID level-0 offers the following advantages and disadvantages.

Advantages Disadvantages

v Substantial speed enhancement

v Maximum utilization of physical drive
storage capacity, because no room is
taken for redundant data or data-parity
storage

No data redundancy, resulting in data loss in
the event that a physical drive fails

Understanding RAID level-1
RAID level-1 uses data mirroring. Two physical drives are combined into an array,
and data is striped across the array. The first half of a stripe is the original data; the
second half of a stripe is a mirror (that is, a copy) of the data, but it is written to the
other drive in the RAID level-1 array.

RAID level-1 provides data redundancy and high levels of performance, but the
storage capacity is diminished. Because the data is mirrored, the capacity of the
logical drive when assigned RAID level-1 is 50% of the array capacity.

RAID level-1 requires two physical drives.

The following illustration shows an example of a RAID level-1 logical drive.

Start with two physical drives.

Create an array using the two physical drives.
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Then create a logical drive within that array.

The data is striped across the drives, creating blocks.

Notice that the data on the drive on the right is a copy
of the data on the drive on the left.

1 1

2 2

3 3

4 4

With RAID level-1, if one of the physical drives fails, the ServeRAID controller
switches read and write requests to the remaining functional drive in the RAID
level-1 array.

RAID level-1 offers the following advantages and disadvantages.

Advantages Disadvantages

v 100% data redundancy

v High performance

Allows only 50% of the physical drive
storage capacity to be used

Understanding RAID level-1 Enhanced
RAID level-1 Enhanced (RAID level-1E) combines mirroring and data striping. This
RAID level stripes data and copies of the data across all of the drives in the array.
As with the standard RAID level-1, the data is mirrored, and the capacity of the
logical drive is 50% of the array capacity.

RAID level-1E has a similar profile to RAID level-1; it provides data redundancy and
high levels of performance, but the storage capacity is diminished. However, RAID
level-1E allows a larger number of physical drives to be used.

RAID level-1E requires a minimum of three drives and, depending upon the level of
firmware and the stripe-unit size, supports a maximum of 8 or 16 drives.

The following illustration is an example of a RAID level-1E logical drive.

Start with three physical drives.
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Create an array using the physical drives.

Then create a logical drive within that array.

The data is striped across the drives, creating
blocks.

Notice that the stripe labeled . is the data
stripe and the stripe labeled .. is the copy of
the preceding data stripe. Also, notice that
each block on the mirror stripe is shifted one
drive.

1 2

6

3

5

4

1

4 6

5

3

2

*

*

**

**

With RAID level-1E, if one of the physical drives fails, the ServeRAID controller
switches read and write requests to the remaining functional drives in the RAID
level-1E array.

RAID level-1E offers the following advantages and disadvantages:

Advantages Disadvantages

v 100% data redundancy

v High performance

Allows only 50% of the physical drive
storage capacity to be used

Understanding RAID level-5
RAID level-5 stripes data and parity across all drives in the array.

RAID level-5 offers both data protection and increased throughput. When you
assign RAID level-5 to an array, the capacity of the array is reduced by the capacity
of one drive (for data-parity storage). RAID level-5 gives you higher capacity than
RAID level-1, but RAID level-1 offers better performance.

RAID level-5 requires a minimum of three drives and, depending upon the level of
firmware and the stripe-unit size, supports a maximum of 8 or 16 drives.
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The following illustration is an example of a RAID level-5 logical drive.

Start with four physical drives.

Create an array using three of the
physical drives, leaving the fourth as a
hot-spare drive.

Then create a logical drive within that
array.

The data is striped across the drives,
creating blocks.

Notice that the storage of the data
parity (denoted by .) also is striped,
and it shifts from drive to drive.

A parity block (.) contains a
representation of the data from the
other blocks in the same stripe. For
example, the parity block in the first
stripe contains data representation of
blocks 1 and 2.

1 2

3

5

7

4

6

8

2*

*

*

*

If a physical drive fails in the array,
the data from the failed physical drive
is reconstructed onto the hot-spare
drive.

2

3

5

4

8

2*

*

*

1

7

6

*

Chapter 3. Understanding RAID technology 21



RAID level-5 offers the following advantages and disadvantages.

Advantages Disadvantages

v 100% data protection

v Offers more physical drive storage
capacity than RAID level-1 or level-1E

Lower performance than RAID level-1 and
level-1E

Understanding RAID level-5 Enhanced
RAID level-5E is the same as RAID level-5 with a built-in spare drive. Like RAID
level-5, this RAID level stripes data and parity across all of the drives in the array.

RAID level-5E offers both data protection and increased throughput. When an array
is assigned RAID level-5E, the capacity of the logical drive is reduced by the
capacity of two physical drives in the array (one for parity and one for the spare).

Reading from and writing to four physical drives is more efficient than reading from
and writing to three physical drives and an idle hot spare. Therefore, RAID level-5E
provides a higher level of performance than RAID level-5.

The spare drive is actually part of the RAID level-5E array, as shown in the
following example. With such a configuration, you cannot share the spare drive with
other arrays. If you want a spare drive for any other array, you must have another
spare drive for those arrays.

RAID level-5E requires a minimum of four drives and, depending upon the level of
firmware and the stripe-unit size, supports a maximum of 8 or 16 drives. RAID
level-5E is also firmware-specific.

Note: For RAID level-5E, you can have only one logical drive in an array. When
using RAID level-5E, you can have a maximum of seven logical drives on
the controller.

The following illustration is an example of a RAID level-5E logical drive.

Start with four physical drives.

Create an array using all four physical
drives.
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Then, create a logical drive (labeled
as 1) within the array.

Notice that the distributed spare drive
is the free space (labeled as 2) shown
below the logical drive.

2

1

The data is striped across the drives,
creating blocks in the logical drive.

The storage of the data parity
(denoted by .) is striped, and it shifts
from drive to drive as it does in RAID
level-5.

Notice that the spare drive is not
striped.

5

7

1*

*

2

6

8

4

*

3

9

If a physical drive fails in the array,
the data from the failed drive is
reconstructed. The array undergoes
compression, and the distributed
spare drive becomes part of the array.
The logical drive remains RAID
level-5E.

When you replace the failed drive, the
data for the logical drive
decompresses and returns to the
original striping scheme.

9

3

5

7

1*

*

*

*

2

6

8

4

*

If you use a RAID level-5E logical drive in a failover or cluster configuration, the
RAID level-5E logical drive will not failover while undergoing compression or
decompression.

RAID level-5E offers the following advantages and disadvantages.

Advantages Disadvantages

v 100% data protection

v Offers more physical drive storage
capacity than RAID level-1 or level-1E

v Higher performance than RAID level-5

v Lower performance than RAID level-1 and
level-1E

v Supports only one logical drive per array

v Cannot share a hot-spare drive with other
arrays

Note: The ServeRAID Manager program Configuration wizard does not default to
RAID level-5E. If you have four physical drives, Express configuration
defaults to RAID level-5 with a hot-spare drive.
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Understanding RAID level-x0

Note: RAID level-x0 is available only on IBM ServeRAID-4 Ultra160 SCSI
controllers.

RAID level-x0 refers to RAID level-00, level-10, level-1E0, and level-50. RAID
level-x0 uses an array of arrays, or a spanned array. The operating system uses
the spanned array logical drive in the same way as a regular array logical drive.

RAID level-x0 allows more physical drives in an array. The benefits of doing so are
larger logical drives, increased performance, and increased reliability. RAID level-0,
level-1E, level-5, and level-5E cannot use more than 16 physical drives in an array;
however, RAID level-1E0 and level-50 support 60 drives.

RAID level-x0 requires a minimum of two drives and supports a maximum of 60
drives.

The following illustration is an example of a RAID level-10 logical drive.

Start with six physical drives.

Create three arrays (labeled
A, B, and C), each array
using two physical drives.

AA B CA

Then, create a spanned array
(labeled as *) that spans the
three arrays. AA B CA

*
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A sub-logical drive is created
within each array (A, B, and
C). Then, the data is striped
across the physical drives in
the array, creating blocks.

Notice that, in each array, the
data on the drive on the right
is a copy of the data on the
drive on the left. This is
because the sub-logical drives
(A, B, and C) are RAID
level-1 in a RAID level-10
implementation (see the
following table).

AA B C

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

A
*

Then, create a logical drive
within the spanned array (*).
The data is striped across this
logical drive, creating blocks
(1-12). Notice that none of
these blocks are redundant.
This is because the logical
drive is RAID level-0 in a
RAID level-x0 implementation
(see the following table).

AA B C

1

2

3

4

5

7

6

8
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3

4

5

7

6
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2

3

4

5

7

6
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1

2

3

4

5

7

6

8

1

2

3

4

5

7

6
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1

2

3

4

5

7

6

8

A

1

*

2 3

54

7

10

8

11

6

9

12

RAID level Sub-logical drive Spanned array logical drive
00 RAID level-0 RAID level-0
10 RAID level-1 RAID level-0
1E0 RAID level-1E RAID level-0
50 RAID level-5 RAID level-0

With RAID level-10, level-1E0, and level-50, if one of the physical drives fails in a
sub-logical drive, the ServeRAID controller switches read and write requests to the
remaining functional drives in the sub-logical drive. With RAID level-00, a physical
drive failure within the sub-logical drive results in loss of data.

RAID level-x0 offers the following advantages and disadvantages.

Advantages Disadvantages

v Supports up to 60 physical drives

v 100% data redundancy (except for RAID
level-00)

v Available only on the IBM ServeRAID-4
Ultra160 SCSI controllers

v No data redundancy for RAID level-00
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Drive-state descriptions
This section provides descriptions of the physical and logical drive states.
ServeRAID publications frequently refer to these states.

Physical-drive-state descriptions
The following table provides descriptions of the valid physical drive states.

Drive state Meaning

Defunct A physical drive in the online, hot-spare, or rebuild state has become defunct. It does not
respond to commands, which means that the ServeRAID controller cannot communicate
properly with the drive.

If a physical drive has become defunct, refer to “Rebuilding a defunct drive” on page 153.

Hot spare A hot-spare drive is a physical drive that is defined for automatic use when a similar drive
fails.

Online The drive is online. It is functioning properly and is part of an array.

Rebuilding The drive is being rebuilt.

For more information on rebuilding a drive, refer to “Rebuilding a defunct drive” on page 153.

Ready The ServeRAID controller recognizes a ready drive as being available for definition.

Standby hot spare A standby hot spare is a hot-spare drive that the ServeRAID controller has spun down. If an
online drive becomes defunct and no suitable hot-spare drive is available, a standby
hot-spare drive of the appropriate size automatically spins up and enters the rebuild state.

Logical-drive-state descriptions
The following table provides descriptions of the valid logical drive states.

Drive state Meaning

Blocked During a rebuild operation, the ServeRAID controller sets the state of any RAID level-0 logical
drives associated with a failed array to the blocked state; then, it reconstructs the data that
was stored in RAID level-1, level-1E, level-5 and level-5E logical drives.

After the rebuild operation is completed, you can unblock the RAID level-0 logical drives and
access them once again. However, the logical drive might contain damaged data. You must
re-create, reinstall, or restore the data from the most recent backup disk or tape to the RAID
level-0 logical drive.

Critical migrating A logical drive in the critical state that is undergoing a logical-drive migration (LDM).

Critical system The ServeRAID controller uses this reserved state during a logical-drive migration when the
logical drive is in the critical state.

Critical A RAID level-1, level-1E, level-5, or level-5E logical drive that contains a defunct physical
drive is in the critical state. A critical logical drive is accessible, despite a physical drive
failure.

Attention: If the state of the logical drive is critical, refer to “Rebuilding a defunct drive” on
page 153.

Migrating The logical drive is undergoing a logical-drive migration; that is, a change in RAID levels, a
change in logical-drive size, an increase in free space, or a RAID level-5E compression or
decompression.
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Drive state Meaning

Offline The logical drive is offline and not accessible. This state occurs when one of the following is
true:

v One or more physical drives in a RAID level-0 logical drive are defunct.

v Two or more physical drives in a RAID level-1, level-1E, or level-5 logical drive are defunct.

v Three or more drives in a RAID level-5E logical drive are defunct.

If any of these is true, refer to “Rebuilding a defunct drive” on page 153.

Okay The logical drive is working properly. It is in a good, functional state.

System The ServeRAID controller uses this reserved state during logical-drive migration.
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Chapter 4. Configuring ServeRAID controllers

This chapter provides information on obtaining ServeRAID updates, updating
ServeRAID BIOS and firmware code, and configuring ServeRAID controllers.

Obtaining ServeRAID updates
IBM periodically makes updated versions of the ServeRAID software available from
the IBM Support page on the World Wide Web.

Note: If you download ServeRAID software, you must download and install all
ServeRAID software at the same time. This will ensure that all levels of the
software are compatible. The ServeRAID software includes the following:
v BIOS and firmware code
v Device drivers
v ServeRAID Manager program
v Command-line programs

If you do not have access to the World Wide Web, contact your place of
purchase, your IBM reseller, or your IBM marketing representative for
replacement CDs.

Downloadable files from the World Wide Web
You can download files for the IBM ServeRAID and Clustering products from the
IBM Support Web site:

http://www.ibm.com/pc/support/

To access ServeRAID and Clustering support, do the following:

1. From the Browse the support site list box, select Servers. The IBM xSeries,
Netfinity, and PC Server Support page opens.

2. From the Family list box, select ServeRAID or Clustering. The ServeRAID or
Clustering Support page opens.

3. Click one of the following options that appear in the left margin:

Downloadable files
Download the latest versions of Clustering software, the ServeRAID
Manager program, BIOS and firmware code, device-driver updates, and
other important information.

Hints and tips
Obtain useful information about IBM Clustering and ServeRAID
products, as well as tips for troubleshooting potential problems.

Online publications
Download the installation and user’s guides, references, white papers,
and other IBM publications.

4. From the By Category list box, select RAID; a list of downloadable files
appears below the list box.

© Copyright IBM Corp. 2001 29



Updating BIOS and firmware code
Before configuring the ServeRAID controller, you must have the latest BIOS and
firmware code installed on your server. To update the levels of BIOS and firmware
code, do the following:

1. Insert the IBM ServeRAID Support CD into the server CD-ROM drive, and turn
on the server.

The IBM ServeRAID ROM Update Wizard automatically starts. The IBM
ServeRAID ROM (read-only memory) Update Wizard is a program that updates
the BIOS and firmware code on ServeRAID controllers. The wizard
automatically identifies and scans each ServeRAID controller.

If the BIOS and firmware code do not require updating, the wizard automatically
stops and the ServeRAID Manager program starts. Continue with “Configuring
the ServeRAID controller”.

If the BIOS and firmware code require updating, a report screen opens with the
following information:
v Controller types found.
v Controller slot number, if known.
v Firmware version.
v BIOS version.
v Update status. If a controller has outdated BIOS or firmware code, the IBM

ServeRAID ROM Update Wizard marks the controller as a candidate for
update.

The IBM ServeRAID ROM Update Wizard asks if you want to update. You
decide whether to update, but you must update all or none of the controllers in
your server; you cannot selectively update.

2. If you want to update your ServeRAID controllers, click Update. If the wizard
detects an error, an error message appears and you are prompted to insert a
diskette into your diskette drive. The wizard saves details about the error to a
file on the diskette.

If you do not want to update your ServeRAID controllers, click Cancel.

3. When all updates are completed, scroll through the Features window. This
window reports the changes that the IBM ServeRAID ROM Update Wizard
applied to your ServeRAID controllers.

4. Leave the IBM ServeRAID Support CD in the CD-ROM drive; shut down and
restart the server.

Configuring the ServeRAID controller
This section provides information about starting and using the ServeRAID Manager
program. You can use the ServeRAID Manager program to configure your
ServeRAID controllers, view the ServeRAID configuration and associated devices,
change controller settings, monitor your ServeRAID controllers, and more.

The information in this section focuses on using the ServeRAID Manager program
in startable-CD mode to configure your controllers or change specific settings. For
information about other uses of ServeRAID Manager, refer to the ServeRAID
Manager online help.
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Important

If you intend to use your ServeRAID controllers in a Microsoft Windows failover or clustering
environment, do the following:

v For failover, go to Chapter 6, “Configuring two ServeRAID controllers in a failover
environment,” in the IBM ServeRAID-4 Ultra160 SCSI Controller User’s Reference.

v For clustering, go to Part 3, “Installing the IBM ServeRAID Cluster Solution,” in the IBM
ServeRAID-4 Ultra160 SCSI Controller User’s Reference.

The IBM ServeRAID-4 Ultra160 SCSI Controller User’s Reference is located on the IBM
ServeRAID Support CD.

Using ServeRAID Manager
The ServeRAID Manager program operates in two ways:

v Startable-CD mode.

v As an installed software program. For more information, refer to the ServeRAID
Manager online help.

When you run the ServeRAID Manager program from the startable IBM ServeRAID
Support CD, you are using startable-CD mode. Startable-CD mode enables you to
configure your ServeRAID controller before you install your operating system. After
you have configured the ServeRAID controller and installed the operating system,
you also can use startable-CD mode to change specific ServeRAID controller
settings. Refer to “Fine-tuning your configuration” on page 38 for additional
information.

To run the ServeRAID Manager program in startable-CD mode, turn on the server;
then, insert the IBM ServeRAID Support CD (or the CD that contains the
ServeRAID Manager program that came with your server) into the CD-ROM drive.

If the ServeRAID Manager program detects unconfigured ServeRAID controllers
and ready drives, the program automatically starts the Configuration wizard, and a
window similar to that shown in Figure 8 on page 32 opens.
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You can use the Configuration wizard to create up to eight arrays and up to eight
logical drives for each ServeRAID controller. The Configuration wizard provides two
configuration options: Express and Custom. Express configuration automatically
configures your ServeRAID controller, and Custom configuration enables you to
configure your controller manually. If you want to use RAID level-1E, RAID-level-5E,
or RAID level-x0, you must use Custom configuration. For more information about
RAID levels, refer to “Chapter 3. Understanding RAID technology” on page 15.

Using Express configuration
Express configuration automatically configures your ServeRAID controller. This
feature does the following:

v Creates arrays by grouping together same-sized physical drives.

v Creates one logical drive per array.

v Assigns a RAID level based on the number of physical drives in an array:

– An array with a single physical drive is assigned RAID level-0.

– An array with two physical drives is assigned RAID level-1.

– An array with three or more physical drives is assigned RAID level-5.

v Designates a hot-spare drive for the controller. If one or more arrays has four or
more physical drives, the largest-sized drive from those arrays is designated the
hot-spare drive.

To use Express configuration, do the following:

1. In the ServeRAID Manager tree, click the ServeRAID controller that you want to
configure.

2. Click Express configuration.

3. Click Next. The “Configuration summary” window opens.

Figure 8. “Configuration wizard” window
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4. Review the information that is displayed in the “Configuration summary” window.
To change the configuration, click Modify arrays or Modify logical drives.

Note: Some operating systems have size limitations for logical drives. Before
you save the configuration, verify that the size of the logical drive is
appropriate for your operating system. For more detailed information, see
your operating-system documentation.

5. Click Apply; then, click Yes when asked if you want to apply the new
configuration. The configuration is saved in the ServeRAID controller and in the
physical drives.

6. If you have multiple controllers, do the following:

a. Click the ServeRAID controller that you want to configure.

b. From the toolbar, click (Configure RAID).

c. Repeat steps 2 on page 32 through 6 for each controller.

7. When you have completed configuring your controllers, you can change certain
controller settings. See “Fine-tuning your configuration” on page 38 for more
information. If you do not want to change any settings, exit from the ServeRAID
Manager program and remove the CD from the CD-ROM drive.

8. Restart the server.

9. Continue with “Chapter 5. Installing ServeRAID device drivers” on page 43.

Note: If you are configuring your startup (boot) ServeRAID controller, you must
install the device driver while installing the operating system.

Figure 9. “Configuration summary” window
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Using Custom configuration
Choose Custom configuration to configure your controller manually. To use Custom
configuration, do the following:

1. In the ServeRAID Manager tree, click the ServeRAID controller that you want
to configure.

2. Click Custom configuration.

3. Click Next. The “Create arrays” window opens. If you want to create spanned
arrays, go to step 2 of “Creating spanned arrays” on page 37.

4. Click the appropriate tab in the right panel; then, from the list of ready drives,
select the drives you want to move to the array.

5. Click (Add selected drives) to add the drives to the array. You can

click (Add all drives) to move all ready drives to an array.

6. Repeat steps 4 and 5 for each additional array or hot-spare drive that you
want to configure.

7. After you select the ready drives for your arrays and hot-spare drive, click
Next. The ″Create logical drives″ window opens.

Figure 10. “Create arrays” window
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8. Click the appropriate Array tab.

9. Select a RAID level from the drop-down list. (Refer to “Supported RAID levels”
on page 16 for more information.)

Notes:

a. RAID level-5E allows only one logical drive per array.

b. If you are configuring a spanned array, you can set the RAID level only for
the first logical drive you create.

10. If you do not want to use the maximum size for the logical drive, type the size
in the Data (MB) field

Notes:

a. You can define up to eight logical drives per controller. There are two
exceptions:

v If an array contains a logical drive assigned RAID level-5E

v If you want to use the logical-drive migration feature

In these cases, one logical drive slot must be left free; therefore, you
cannot define more than seven logical drives.

b. Some operating systems have size limitations for logical drives. Before you
save the configuration, verify that the size of the logical drive is appropriate
for your operating system. For more detailed information, see your
operating-system documentation.

c. Typically, the first logical drive defined on the first ServeRAID controller
found by system BIOS during startup will be your startup (boot) drive.

11. If you have free space available and want to create additional logical drives,
click Create new logical drive.

Figure 11. ″Create logical drives″ window
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12. Repeat steps 9 on page 35 through 11 on page 35 for each logical drive that
you want to define in this array.

13. Repeat steps 8 on page 35 through 12 for each additional array you want to
configure.

14. Click Next. The ″Configuration summary″ window opens.

Figure 12. ″Adding another logical drive″ window

Figure 13. ″Configuration summary″ window
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15. Review the information that is displayed in the ″Configuration summary″
window. To change the configuration, click Back.

16. Click Apply; then, click Yes when asked if you want to apply the new
configuration. The configuration is saved in the ServeRAID controller and in
the physical drives.

17. If you have multiple controllers, do the following:

a. Click the ServeRAID controller that you want to configure.

b. From the toolbar, click (Configure RAID).

c. Repeat steps 2 on page 34 through 17b for each controller.

18. When you have completed configuring your controllers, you can change certain
controller settings. See “Fine-tuning your configuration” on page 38 for more
information. If you do not want to change any settings, exit from the
ServeRAID Manager program, and remove the CD from the CD-ROM drive.

19. Restart the server.

20. Continue with “Chapter 5. Installing ServeRAID device drivers” on page 43.

Note: If you are configuring your startup (boot) ServeRAID controller, you
must install the device driver while installing the operating system.

Creating spanned arrays: If you want to assign RAID level-x0 to an array, you
must create a spanned array. For more information about spanned arrays, refer to
“Understanding RAID level-x0” on page 24.

Note: Spanned arrays are supported only by IBM ServeRAID-4 Ultra160 SCSI
controllers.

To create one or more spanned arrays, do the following:

1. If you have not completed steps 1 on page 34 to 3 on page 34 in “Using Custom
configuration” on page 34, do so now.

2. Create identical arrays by doing the following:

a. Click the Array tab in the right panel; then, from the list of ready drives,
select the drives you want to move to the array.

b. Click (Add selected drives) to add the drives to the array.

c. Repeat steps 2a and 2b for each additional array that you want to configure.

Note: To create a spanned array, the arrays to be spanned must be
identical (that is, they must have the same number of physical
drives).

d. Select the Span arrays check box; then, click Next. The ″Create
spanned arrays″ window opens.
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3. Create spanned arrays by doing the following:

a. In the list of arrays, click the arrays that you want to add to your spanned
array.

b. Click (Add selected arrays) to add the arrays to the spanned array.

You can click (Add all arrays) to move all arrays to the spanned array.

c. To create additional spanned arrays, click the New spanned array tab in the
right pane; then, repeat steps 3a and 3b.

4. Click Next; the ″Create logical drives″ window opens. Continue with step 8 of
“Using Custom configuration” on page 34.

Fine-tuning your configuration
You can use ServeRAID Manager to view information about ServeRAID controllers
and the ServeRAID subsystem (such as arrays, logical drives, hot-spare drives, and
physical drives).

To view information, expand the ServeRAID Manager tree; then, click the relevant
tree object. Detailed information about the selected device appears in the right
pane.

Figure 14. ″Create spanned arrays″ window
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To display available actions for an item, click the item in the ServeRAID Manager
tree and click Actions.

Before you store data on the controller, you will need to determine the correct
stripe-unit size for your configuration and change the stripe-unit size, if necessary.

Changing the stripe-unit size
The new controller stripe-unit size is set at the factory to 8 KB. If you need to
change this setting, you must change the stripe-unit size before you store data in
the logical drives. After you store data in the logical drives, you cannot change the
stripe-unit size without destroying data in the logical drives. To change the
stripe-unit size, do the following:
1. In the ServeRAID Manager tree, click the new controller to select it.
2. Click Actions → Change stripe-unit size.
3. Select the new stripe-unit size for your installation.

Note: Consider your server application environment when you select the
controller stripe-unit size setting.

Environment Stripe-unit size

Groupware (such as Lotus Notes or Exchange) 16 KB

Transaction processing database 16 KB

Decision support database 16 KB

Thin client environments 8 KB

File server (Windows 2000, Windows NT 4.0, Novell NetWare) 16 KB

File server (other) 8 KB

Web server 8 KB

Other 8 KB

Figure 15. ServeRAID Manager window
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Write-cache mode
If you are preparing to install Novell NetWare 5.x from the startable Novell NetWare
5.x CD, you must set the write-cache mode for all logical drives to write through. To
accomplish this, do the following:

1. In the ServeRAID Manager tree, click the logical drive.

2. Click Actions → Change write-cache mode to write through.

3. Repeat steps 1 and 2 for every logical drive.

Getting assistance
For more information about ServeRAID Manager, consult the online help system. To

start the help system, either click (Information about this window) on the
toolbar or select an item from the Help menu.

The help system (ServeRAID Assist) will open within the ServeRAID Manager
interface.

Hints and tips
To learn more about the ServeRAID Manager tree objects and the actions that
apply to them, use the “Hints and Tips” feature. Select a tree object and click
Actions → Hints and tips. ServeRAID Assist will start, and information about the
tree object will appear in the right pane of ServeRAID Manager.

Figure 16. ServeRAID Manager help menu
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Figure 17. Hints and tips feature
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Chapter 5. Installing ServeRAID device drivers

The ServeRAID device drivers are provided on the IBM ServeRAID Support CD.
Refer to the IBM ServeRAID-4 Ultra160 SCSI Controller Device Driver Installation
Instructions (4DEVDRV.PDF) located in the /BOOKS directory on the IBM
ServeRAID Support CD. This booklet provides detailed instructions for installing the
device drivers on the following operating systems:

v Microsoft Windows XP Professional (ServeRAID-4Lx controller only)

v Microsoft Windows 2000

v Microsoft Windows NT 4.0

v Novell NetWare (version 4.2 and later)

v IBM OS/2® WARP® Server for E-Business

v Red Hat Linux (version 6.2 or later)

v SuSE Linux 7.1

v Caldera OpenLinux 3.1

v Turbolinux 6.5

v SCO OpenServer 5.0.6a

v Caldera UnixWare 7.1

v Caldera Open UNIX 8.0

If you are installing files for an IBM ServeRAID controller that comes as a standard
feature on your IBM server system board, use the installation instructions and CDs
provided with your server.
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Chapter 6. Configuring two ServeRAID controllers in a failover
environment

You can configure two ServeRAID controllers in a failover environment when using
Microsoft Windows 2000 or Microsoft Windows NT 4.0. Recent versions of
ServeRAID device drivers utilize fault-tolerant technology. With fault tolerance, you
can pair two controllers and connect them to the same enclosure to ensure access
to the physical drives, even after one controller fails.

Hardware requirements

Important

To implement fault tolerance, you must use only matched pairs of controllers. The
controllers must be identical, including stripe-unit size and the level of BIOS and firmware
code.

You can use the following pairs to provide fault tolerance:
v Two ServeRAID-4H
v Two ServeRAID-4M
v Two ServeRAID-4Mx
v Two ServeRAID-4L
v Two ServeRAID-4Lx
v Two ServeRAID-3HB
v Two ServeRAID-3H
v Two ServeRAID-3L
v Two ServeRAID-II

Note: If your system has a built-in ServeRAID controller on the system board, you
cannot use the built-in controller in the failover pair.

To use fault-tolerant technology with ServeRAID controllers, you must use one of
the following enclosures:

v IBM Netfinity EXP15 Rack Enclosure

v IBM Netfinity EXP200 Rack Enclosure

v IBM Netfinity EXP300 Rack Enclosure

Installation guidelines and restrictions

Important

If the following guidelines and restrictions are not met, failover is disabled for the controller
pair, and an error explaining the problem is logged in the system event log.

To achieve fault tolerance with ServeRAID, you must adhere to the following
guidelines and restrictions:

v You must configure the controllers as an active-passive pair, where all logical
drives are defined on only the active controller.

Note: If both controllers have logical drives configured, the controllers will not be
configured as a failover pair.
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v The stripe-unit size and level of BIOS and firmware code must be the same on
both controllers.

v A failover pair must not contain any physical drives in the ready state. All physical
drives must be configured in arrays.

v Hot-spare drives are not supported in a failover environment. The exception is
the built-in hot-spare that is part of a RAID level-5E logical drive.

v RAID level-x0 is not supported in a failover environment.

v All logical drives must have unique shared merge-group numbers.

v You must set the write-cache mode of all logical drives on the controller to write
through.

Note: If your ServeRAID controller has a battery-backup cache, it is disabled
when you create a failover pair. The write-cache mode is automatically
changed from write back to write through.

v A failover pair and a ServeRAID adapter defined as a Microsoft Cluster Service
(MSCS) resource cannot coexist in the same server.

v When you use multiple failover pairs in a system, each set of controllers must
have unique controller and partner names.

v You cannot hot add a controller and then configure it as part of a failover pair.

v All on-board ServeRAID controllers must be enabled, even if the controller is not
used.

v A logical drive cannot failover if it is any of the following:

– A RAID level-5 or level-5E logical drive in a critical state

– A RAID level-5 or level-5E logical drive that is undergoing a rebuild operation

– A RAID level-5E logical drive that is undergoing a compression or
decompression operation

– A logical drive undergoing a logical-drive migration

Preparing the controllers

Note: The cables to the drive enclosures must not be attached when you start the
server.

1. Insert the IBM ServeRAID Support CD (or the configuration CD that was
included with your server) into the CD-ROM drive; then, turn on the server.
The ServeRAID Manager program starts.

2. If the ServeRAID Manager program starts the Configuration wizard, a window
similar to the following opens. Click Cancel to exit the Configuration wizard;
then, in the confirmation window, click Yes.
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3. In the ServeRAID Manager tree, click the ServeRAID controller that you want
to configure as the active controller.

Attention

Restore the ServeRAID controller to factory-default settings only once, when the controller
is first installed. This process removes all configuration information from NVRAM, including
the SCSI initiator IDs, the controller and partner names, and the array information.

This point is especially important if the Windows 2000 or Windows NT 4.0 system startup
drive is attached to the IBM ServeRAID controller. If this process occurs after the
startup-drive array has been created, the array information will be removed, and the system
will no longer start in Windows 2000 or Windows NT 4.0.

If you already have logical drives defined on the controller that you want to keep, go to step
6. Steps 4 and 5 will cause loss of data by deleting all logical drives already defined.

4. Click Actions → Restore to factory-default settings.

5. If a confirmation window opens, click Yes. When the operation is complete, a
message appears at the bottom of the window indicating that the ServeRAID
Manager has successfully restored the configuration to the factory-default
settings.

6. In the ServeRAID Manager tree, click the ServeRAID controller that you want
to configure as the passive controller; then, repeat steps 4 through 5. Continue
to step 7 for the second ServeRAID controller.

7. In the ServeRAID Manager tree, click the ServeRAID controller that you want
to configure as the active controller.

8. Click (Configure for clustering) on the toolbar. The “Configure
controller 1 for clustering” window opens.

Figure 18. Configuration wizard
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9. Provide the following information:

Controller name
Type a name to identify the first controller, for example, Controller A.

Partner name
Type a name that you will use to identify the second controller, for
example, Controller B.

Initiator IDs
The system presets these SCSI initiator IDs to 7. Set each ID to 6 for
shared channels. (The ServeRAID Manager program does not permit
you to select numbers other than 6 and 7.)

Notes:

a. The controller name and partner name are case sensitive.

b. If your configuration will contain multiple ServeRAID controller pairs, each
controller name must be unique.

10. Click OK.

11. In the ServeRAID Manager tree, click the ServeRAID controller that you want
to configure as the passive controller.

12. Click (Configure for clustering) on the toolbar. The “Configure
controller 2 for clustering” window opens.

13. Provide the following information:

Controller name
Type the same name as the partner name in step 9, for example,
Controller B.

Figure 19. “Configure controller 1 for clustering” window

Figure 20. “Configure controller 2 for clustering” window
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Partner name
Type the same name as the controller name in step 9 on page 48, for
example, Controller A.

Initiator IDs
The system presets these SCSI initiator IDs to 7. When configuring the
passive controller, do not change these values. (The ServeRAID
Manager program does not permit you to select numbers other than 6
and 7.)

Notes:

a. The controller name and partner name are case sensitive.

b. If your configuration will contain multiple ServeRAID controller pairs, each
controller name must be unique.

14. Click OK.

Connecting the enclosure
After you prepare the controllers, you must connect the enclosure to the ServeRAID
controllers.

1. Shut down the server.

2. Connect the enclosure to each of the ServeRAID controllers.

Important

When connecting the cables, you must connect the same channel connectors on both
ServeRAID controllers to the same enclosure. For example, if you connect the cable from
Channel 1 on the first ServeRAID controller to the enclosure, you must connect the cable
from Channel 1 on the second ServeRAID controller to the enclosure.

3. Restart the server with the IBM ServeRAID Support CD (or the configuration CD
that came with your server) in the CD-ROM drive.
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Configuring ServeRAID arrays and logical drives
Notes:

1. You must configure arrays and logical drives only on the active controller.

2. You can create only one logical drive for each array in a failover environment.

To configure arrays and logical drives, do the following:

1. On the toolbar, click (Configure RAID). The Configuration wizard opens.

2. In the ServeRAID Manager tree, click the ServeRAID controller that you want
to configure as the active controller.

3. Click Custom configuration.

4. Click Next. The “Create arrays” window opens.

Figure 21. Configuration wizard
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5. Click the appropriate Array tab in the right panel; then, from the ready drives
list, select the drives that you want to move to the array.

6. Click (Add selected drives) to add the drives to an array. You can click

(Add all drives) to move all ready drives to an array.

7. Repeat steps 5 to 6 for each additional array that you want to configure.

Notes:

a. You must use all the ready drives when creating your arrays (that is, all
ready drives in the ServeRAID Manager tree must be online).

b. Hot-spare drives are not supported in a failover environment. The
exception is the built-in hot-spare that is part of a RAID level-5E logical
drive.

8. After you select the ready drives for your arrays, click Next. The “Create
logical drives” window opens.

Figure 22. “Create arrays” window

Chapter 6. Configuring two ServeRAID controllers in a failover environment 51



9. Click the appropriate Array tab.

10. Select a RAID level from the drop-down list. (Refer to “Supported RAID levels”
on page 16 for more information.)

Notes:

a. Create only one logical drive for each array.

b. Typically, the first logical drive defined on the first ServeRAID controller
found by system BIOS during startup will be your startup (boot) drive.

11. Repeat steps 9 and 10 for each additional array you want to configure.

12. Click Next. The “Configuration summary” window opens.

Figure 23. “Create logical drives” window
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13. Review the information that is displayed in the “Configuration summary”
window. To change the configuration, click Back.

14. Click Apply; then, click Yes when asked if you want to apply the new
configuration. The configuration is saved in the ServeRAID controller and on
the physical drives.

15. Click Continue to return to ServeRAID Manager. After creating the arrays and
logical drives, you must assign merge-group numbers to the shared logical
drives.

16. In the ServeRAID Manager tree, click the active controller (that is, the
ServeRAID controller that contains the logical drives).

17. Click (Configure for clustering) on the toolbar. The “Configure
controller for clustering” window opens.

Figure 24. ″Configuration summary″ window

Chapter 6. Configuring two ServeRAID controllers in a failover environment 53



18. Select the Shared check boxes for all the logical drives.

19. Do not change the merge-group number from the default provided.

20. Record the controller name, partner name, and merge-group numbers; store
them in a safe place. You will need this information to recover the configuration
if the ServeRAID controller fails.

Note: You can save this information to a file by using the ServeRAID Manager
program:

a. In the ServeRAID Manager tree, click the server.

b. Click Actions → Save printable configuration.

21. Click OK.

22. To exit the ServeRAID Manager program, click File → Exit.

Completing the failover environment installation
To complete the installation of the failover environment, install the appropriate
ServeRAID device drivers to a system already running Windows 2000 or Windows
NT 4.0 or while installing Windows 2000 or Windows NT 4.0. Refer to the following:

v The documentation that came with the Windows 2000 or Windows NT 4.0
software

v The ServeRAID device driver installation instructions on the IBM ServeRAID
Support CD

To verify that the configuration is correct, install and start the ServeRAID Manager
program on the Windows 2000 or Windows NT 4.0 server. Refer to “Chapter 10.
Installing and starting the ServeRAID Manager program” on page 87. If your failover
pair is correctly configured, the ServeRAID Manager tree will designate the
controllers as active and passive, as shown in the following figure.

Figure 25. “Configure controller 1 for clustering” window
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For troubleshooting in a failover environment, refer to “Solving problems in a
failover environment” on page 155.

Figure 26. ServeRAID Manager window showing a correctly-configured failover pair
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Part 2. Utility programs
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Chapter 7. Using the ServeRAID Mini-Configuration program

This chapter provides the information needed to start and use the ServeRAID
Mini-Configuration program.

The ServeRAID Mini-Configuration program provides a quick way to display the
current settings for a ServeRAID controller. You also can use this program to
perform a limited set of the configuration functions without using the IBM
ServeRAID Support CD.

Accessing the Mini-Configuration program
To access the Mini-Configuration program, do the following:

1. Turn on the server. If the server already is running, shut down the operating
system; then, restart the server.

2. When the following message appears, promptly press Ctrl+I:
Press Ctrl+I to access the Mini-Configuration Program

3. If your server contains more than one ServeRAID controller, a selection screen
appears. To continue, do the following:
a. Use the Up Arrow (↑) or Down Arrow (↓) key to select a controller.
b. Press Enter.

If your server contains only one ServeRAID controller, or after you select a
ServeRAID controller, the main menu appears.

The following choices are available from the main menu:

v View Controller Status shows the current status of the ServeRAID
controller. (See “Viewing the controller status” for more information.)

v View Configuration shows the current configuration information for the
ServeRAID controller. (See “Viewing the configuration” on page 60 for more
information.)

v Advanced Functions is used to restore the controller to the factory-default
settings, import configuration from drives, configure BIOS settings, and view
the controller and PCI information. (See “Using the advanced configuration
functions” on page 60 for more information.)

4. Use the Up Arrow (↑) or Down Arrow (↓) key to highlight your choice; then,
press Enter.

5. Follow the instructions that appear on the screen.

6. Click Exit. If your server contains more than one ServeRAID controller, the
controller selection screen appears. Otherwise, the Mini-Configuration program
closes.

Viewing the controller status
When you select View Controller Status from the main menu, the following
information appears on the screen:

v All physical drives and their states

v Unattend shows the current state of the Unattended mode.

– When this option is set to Off and a startup error occurs, the system stops at
the recovery option screen and waits for you to choose the recovery method.
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– When this option is set to On and a startup error occurs, the system stops at
the recovery option screen and waits 30 seconds for you to respond. Then,
the BIOS automatically selects an appropriate option and continues the
system startup process.

v ReadAhead shows the current state of the read-ahead cache mode.

v CompMode shows the current state of BIOS-compatibility mapping. Off indicates
8 GB (Extended); On indicates 2 GB (Limited).

v Clustered shows the current state for clustering.

v BBC shows the cache size of the battery-backup cache, if it is installed (8 = 8
MB or 32 = 32 MB) or No if there is no battery-backupcache installed.

v Boot Blk shows the version number of the startable microcode (or firmware)
loaded for the ServeRAID controller.

v Code Blk shows the current version number of the microcode (or firmware)
loaded for the ServeRAID controller.

v Rebuild Rate shows the current speed setting for rebuilds: High, Medium, or
Low.

v Number of Defunct drives shows the current number of defunct physical drives.

v Number of Offline drives shows the current number of offline logical drives.

v Number of Critical drives shows the current number of critical logical drives.

v Config Updates shows the number of times that the configuration has been
changed since it was initialized. When you initialize the configuration, the Config
Updates resets to 0.

v Bad Stripe, Locked Stripe, or Blocked Drive identifies the logical drives that
are affected.

– Bad Stripe Drives indicates logical drives that have inaccessible areas.

– Locked Stripe Drives is a reserved field.

– Blocked Drives indicates the logical drives that are blocked. You must
unblock a blocked drive before you can use it. See “Logical-drive-state
descriptions” on page 26 for more information.

Viewing the configuration
You can select View Configuration from the main menu to display the number,
size, RAID level, state, stripe-unit size, write-cache mode, read-ahead cache mode,
and creation date for each logical drive.

Using the advanced configuration functions
You can select the Advanced Functions to restore the controller configuration to
factory-default settings, copy the configuration to the controller from the connected
physical drives, configure BIOS settings, and view the controller and PCI
information.

When you select the Advanced Functions from the main menu, the following
choices are displayed.

Attention: Be careful when making selections from this menu. If you change the
configuration, you might lose data.

v Restore to Factory Default Settings restores all parameters in the configuration
to the factory-default settings. When you reset the configuration, any data or
programs stored on the logical drives attached to the selected ServeRAID
controller will become inaccessible.
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This choice deletes the existing configuration information; that is, it deletes all
logical drives defined for the controller and sets all functional physical drives
attached to the controller to the ready state.

v Copy the Configuration from Drives to Controller reads the most common
configuration from the drives in the server and copies it to the ServeRAID
controller.

v Configure BIOS Settings is used to modify the following BIOS settings for the
ServeRAID controller:

– BIOS support for startable CDROM

– BIOS support for INT13 extensions

– BIOS support for reading partition tables

– Bypass read/verify operations

– BIOS compatibility mapping

– Override temporary write through

– Load ServeRAID BIOS default settings

– Save configuration to the ServeRAID controller

v View Controller and PCI Information shows the ServeRAID controller hardware
and PCI register information.

v Exit is used to exit from the current menu to the previous menu.
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Chapter 8. Installing and using the IPSSEND command-line
program

This chapter provides the information needed to install, start, and use the IPSSEND
command-line program.

IPSSEND is an advanced command-line program that you can use to configure and
manage your ServeRAID controllers. This utility program is provided on the IBM
ServeRAID Support diskettes and the IBM ServeRAID Support CD.

Installing the IPSSEND command-line program
You can use the IPSSEND program with the following operating systems:
v Microsoft Windows XP Professional (ServeRAID-4Lx controller only)
v Microsoft Windows 2000
v Microsoft Windows NT 4.0
v Novell NetWare (version 4.2 or later)
v IBM OS/2 WARP Server for E-Business
v Red Hat Linux (version 6.2 or later)
v SuSE Linux 7.1
v Caldera OpenLinux 3.1
v Turbolinux 6.5
v SCO OpenServer 5.0.6a
v Caldera UnixWare 7.1
v Caldera Open UNIX 8.0
v DOS

Note: IPSSEND for DOS is not intended for DOS windows specific to an
operating system. When using IPSSEND for DOS, you must use the ASPI
device driver. The IBM ServeRAID Support for DOS diskette provides the
ASPI device driver.

Installing IPSSEND for Windows XP, Windows 2000, Windows NT 4.0,
NetWare, or OS/2

You can install this program for Windows XP, Windows 2000, Windows NT 4.0,
NetWare, or OS/2 using either the IBM ServeRAID Support CD or the appropriate
IBM ServeRAID Support diskette.

Installing IPSSEND for Windows XP, Windows 2000, Windows NT
4.0, NetWare, or OS/2 from CD
To install this program for Windows XP, Windows 2000, Windows NT 4.0, NetWare,
or OS/2 from the IBM ServeRAID Support CD, do the following:

1. Start the server.

2. After the operating system starts, insert the IBM ServeRAID Support CD into the
CD-ROM drive. If the CD starts automatically, exit the installation program.

3. If you are using NetWare, go to step 5 on page 64. If you are using Windows
XP, Windows 2000, Windows NT 4.0, or OS/2, create an IPSADM directory on
your hard disk. To do this, go to the operating system command prompt and
type:
md c:\ipsadm

where c is the drive letter of the drive where Windows XP, Windows NT,
Windows 2000, or OS/2 is installed.
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4. Press Enter.

5. Copy IPSSEND to your hard disk by typing one of the following at the command
prompt:

For Windows XP
Professional

copy e:\winpro\cmdline\ipssend.exe c:\ipsadm

For Windows 2000
Server

copy e:\winsrv\cmdline\ipssend.exe c:\ipsadm

For Windows 2000
Professional

copy e:\winpro\cmdline\ipssend.exe c:\ipsadm

For Windows NT 4.0 copy e:\winnt\cmdline\ipssend.exe c:\ipsadm

For NetWare Note: These instructions assume that you installed the following:
v NetWare in the NWSERVER directory
v The DOS CD-ROM device drivers

copy e:\netware\cmdline\ipssend.nlm c:\nwserver

For OS/2 copy e:\os2\cmdline\ipssend.exe c:\ipsadm

where e is the drive letter for the CD-ROM drive that contains the IBM
ServeRAID Support CD and c is the drive letter where Windows XP, Windows
2000, Windows NT 4.0, NetWare, or OS/2 is installed.

6. Press Enter. Remove the CD from the CD-ROM drive.

Installing IPSSEND for Windows XP, Windows 2000, Windows NT
4.0, NetWare, or OS/2 from diskette
To install this program for Windows XP, Windows 2000, Windows NT 4.0, NetWare,
or OS/2 from the appropriate IBM ServeRAID Support diskette, do the following:

1. Start the server.

2. After the operating system starts, insert the appropriate IBM ServeRAID Support
diskette into the diskette drive.

3. If you are using NetWare, go to step 5. If you are using Windows XP, Windows
2000, Windows NT 4.0, or OS/2, create an IPSADM directory on your hard disk.
To do this, go to the operating system command prompt and type:
md c:\ipsadm

where c is the drive letter of the drive where the operating system is installed.

4. Press Enter.

5. Copy IPSSEND to your hard disk by typing one of the following at the command
prompt:

For Windows copy a:\ipssend.exe c:\ipsadm

For NetWare Note: These instructions assume that you installed the following:
v NetWare in the NWSERVER directory
v The DOS CD-ROM device drivers

copy a:\ipssend.nlm c:\nwserver

For OS/2 copy e:\ipssend.exe c:\ipsadm

where a is the drive letter for the diskette drive that contains the appropriate
IBM ServeRAID Support diskette, and c is the drive letter where Windows XP,
Windows 2000, Windows NT 4.0, NetWare, or OS/2 is installed.

6. Press Enter. Remove the diskette from the diskette drive.
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Installing IPSSEND for Linux
You can install this program for Red Hat Linux version 6.2 (or later), SuSE Linux
7.1, Caldera OpenLinux 3.1, or Turbolinux 6.5 using either the IBM ServeRAID
Support CD or the appropriate IBM ServeRAID Support diskette.

Note: For IPSSEND to work properly under Linux, you must have SCSI Generic
support compiled into your kernel. Refer to the Linux Kernel-HOWTO for
more information on configuring and recompiling your kernel.

Installing IPSSEND for Linux from CD
To install this program from the IBM ServeRAID Support CD, do the following:

1. Start the server.

2. After the operating system starts, insert the IBM ServeRAID Support CD into the
CD-ROM drive.

3. If your CD-ROM drive automounts, go to step 4. Otherwise, mount the CD-ROM
drive by typing the following at the console:
mount -r -t iso9660 /dev/cdromdevicefile /mountpoint

where cdromdevicefile is the specific device file for the CD-ROM block device,
and mountpoint is the specific mount point of the Linux system.

4. Press Enter; then, type:
cp /mountpoint/linux/cmdline/ipssend /usr/bin

where mountpoint is the specific mount point of the Linux system.

5. Press Enter; then, type:
chmod 700 /usr/bin/ipssend

6. Press Enter; then, unmount the CD-ROM drive by typing the following:
umount /mountpoint

where mountpoint is the specific mount point of the Linux system.

7. Press Enter. Remove the CD from the CD-ROM drive.

Installing IPSSEND for Linux from diskette
To install this program from the IBM ServeRAID Support diskette for your Linux
operating system, do the following.

1. Start the server.

2. After the operating system starts, insert the appropriate IBM ServeRAID Support
diskette into the diskette drive.

3. Mount the diskette drive by typing the following at the console:
mount -t msdos /dev/diskettedevicefile /mountpoint

where diskettedevicefile is the specific device file for the diskette drive block
device, and mountpoint is the specific mount point of the Linux system.

4. Press Enter; then, type:
gunzip -c /mountpoint/ipssend > /usr/bin/ipssend

where mountpoint is the specific mount point of the Linux system.

5. Press Enter; then, unmount the diskette drive by typing the following:
umount /mountpoint

where mountpoint is the specific mount point of the Linux system.

Chapter 8. Installing and using the IPSSEND command-line program 65



Installing IPSSEND for OpenServer
You can install this program for OpenServer using either the IBM ServeRAID
Support CD or the IBM ServeRAID Support for SCO OpenServer diskette.

Installing IPSSEND for OpenServer from CD
To install this program from the IBM ServeRAID Support CD, do the following:

1. Start the server.

2. After the operating system starts, insert the IBM ServeRAID Support CD into the
CD-ROM drive.

3. Mount the CD by typing the following at the console:
mount -f ISO9660 -o ro,lower /dev/cd0 /mnt

where /dev/cd0 is the specific device file for the CD-ROM block device. If you
have more than one CD-ROM drive, you must replace /dev/cd0 with the specific
name of the CD-ROM drive you want to use.

Note: If you currently have another device mounted on /mnt, you must create a
new directory and substitute its name for /mnt in these instructions.

4. Press Enter; then, type:
cp /mnt/openserv/cmdline/ipssend /usr/bin

5. Press Enter; then, type:
chmod 700 /usr/bin/ipssend

6. Press Enter; then, unmount the CD-ROM by typing the following:
umount /mnt

7. Press Enter. Remove the CD from the CD-ROM drive.

Installing IPSSEND for OpenServer from diskette
To install this program from the IBM ServeRAID Support for SCO OpenServer
diskette, do the following:

1. Start the server.

2. After the operating system starts, insert the IBM ServeRAID Support for SCO
OpenServer diskette into the diskette drive.

3. Mount the diskette drive by typing the following at the console:
139 mount -f S51K /dev/fd0 /mnt

where /dev/fd0 is the specific device file for the diskette drive block device. If
you have more than one diskette drive, you must replace /dev/cd0 with the
specific name of the diskette drive you want to use.

Note:
If you currently have another device mounted on /mnt, you must create a new
directory and substitute its name for /mnt in these instructions.

4. Press Enter.

5. Type the following and press Enter:
cp /mnt/ipssend /usr/bin/ipssend

6. Unmount the diskette drive by typing the following:
umount /mnt

where /mnt is the directory you mounted in step 3.

7. Press Enter, and remove the diskette from the diskette drive.
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8. Change the access permissions by typing the following:
chmod 700 /usr/bin/ipssend

9. Press Enter.

Installing IPSSEND for UnixWare or Open UNIX
You can install this program for UnixWare or Open UNIX using either the IBM
ServeRAID Support CD or the IBM ServeRAID Support for Caldera UnixWare and
Open UNIX diskette.

Installing IPSSEND for UnixWare or Open UNIX from CD
To install this program for UnixWare or Open UNIX from the IBM ServeRAID
Support CD, do the following:

1. Start the server.

2. After the operating system starts, insert the IBM ServeRAID Support CD into the
CD-ROM drive.

3. Mount the CD-ROM drive by typing the following at the console:
mount -F cdfs -r /dev/cdrom/cdromdevicefile /mnt

where cdromdevicefile is the specific device file for the CD-ROM block device.
Look in the /dev/cdrom directory to determine what cdromdevicefile is on your
server, for example, c0b0t010.

Note: If you currently have another device mounted on /mnt, you must create a
new directory and substitute its name for /mnt in these instructions.

4. Press Enter; then, type:
cp /mnt/openunix/cmdline/ipssend /usr/bin

5. Press Enter; then, type:
chmod 700 /usr/bin/ipssend

6. Press Enter; then, unmount the CD-ROM drive by typing the following:
umount /mnt

7. Press Enter. Remove the CD from the CD-ROM drive.

Installing IPSSEND for UnixWare or Open UNIX from diskette
To install this program for UnixWare or Open UNIX from IBM ServeRAID Support
for Caldera UnixWare and Open UNIX diskette, do the following:

1. Start the server.

2. After the operating system starts, insert the IBM ServeRAID Support for Caldera
UnixWare and Open UNIX diskette into the diskette drive.

3. Mount the diskette drive by typing the following at the console:
mount -F s5 /dev/fd0 /mnt

If you have more than one diskette drive, you might need to replace /dev/fd0
with the specific name of the diskette drive that you want to use.

Note: If you currently have another device mounted on /mnt, you must create a
new directory and substitute its name for /mnt in these instructions.

4. Press Enter; then, type:
cp /mnt /ipssend/usr/bin/ipssend

5. Type the following and press Enter:
rm -f /tmp/ipssend.z
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6. Unmount the diskette drive by typing the following:
umount /mnt

where mnt is the directory you mounted in step 3 on page 67.

7. Press Enter. Remove the diskette from the diskette drive.

8. Change the access permissions by typing the following:
chmod 700 /usr/bin/ipssend

9. Press Enter.

Using the IPSSEND command-line program
The IPSSEND command-line program provides a quick way to do the following for
the ServeRAID controller:

v Create backup copies of data (see “FlashCopy function (for Windows XP,
Windows 2000, and Windows NT 4.0 only)” on page 69)

v Copy ServeRAID controller configurations from one server to another (see
“Server roll-out functions” on page 75)

v Recover from a failed physical drive and rebuild an affected logical drive (see
“Error-recovery functions” on page 77)

v Isolate problems and determine their causes (see “Problem-isolation and debug
functions” on page 79)

v Create logical drives; display or modify a limited set of configuration settings (see
“RAID configuration functions” on page 81).

Note: If you do not have the IPSSEND program installed, refer to “Installing the
IPSSEND command-line program” on page 63.

When you run IPSSEND with no parameters, a list of available functions and their
specific parameters is displayed. The available functions and their parameters are
described in the sections that follow.

To run the IPSSEND program with no parameters, do the following:

For Windows XP,
Windows 2000,
Windows NT 4.0, and
OS/2

1. Type:

c:\ipsadm\ipssend

where c is the drive letter of the drive where Windows XP,
Windows 2000, Windows NT 4.0, or OS/2 is installed.

2. Press Enter.

For NetWare 1. From the console, type:

load c:\nwserver\ipssend

where c:\nwserver is where NetWare is installed.

2. Press Enter.

For Linux,
OpenServer,
UnixWare, and Open
UNIX

1. Type:

/usr/bin/ipssend

2. Press Enter.
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For DOS 1. Insert the IBM ServeRAID Support for DOS diskette into the
diskette drive.

2. Restart the server.

3. Type the following and then press Enter:

a:\ipssend

where a is the diskette drive letter.

FlashCopy function (for Windows XP, Windows 2000, and Windows NT
4.0 only)

FlashCopy creates a quick backup copy of data from a source drive to a target
drive at the instant you issue the command. Any changes made to the source drive
after you issue the command are not reflected on the target drive.

You can use the backup copy for tasks such as tape backup and multiserver rollout
(for example, drive cloning). FlashCopy sets up a link between the source and
target partitions, and then it creates a snapshot-like backup of the source data on
the target partition. The target partition is instantly available for access.

Note: To create the backup copy, the following conditions must be met:
v The size of the target partition is equal to or larger than that of the source

partition.
v The partition type is the same on the source and target partitions.
v When using RAID level-x0, there is only one partition for each logical

drive.

When issuing the FlashCopy function, you must specify either the FlashCopy
backup or FlashCopy nobackup function to create a backup.

The FlashCopy backup function sets up a link between the source and target
drives. This link creates a backup of the source data on the target drive. After the
link is set up, a background copy operation is immediately initiated to copy all the
data from the source drive to the target drive. After the background copy operation
is completed, the link between the source and target drives is dissolved.

The FlashCopy nobackup function also sets up a link between the source and
target drives. Unlike the FlashCopy backup function, after the FlashCopy
nobackup link is set up, no background copy operation immediately takes place.
The background copy operation waits until the data on the source logical drive
changes. When a change to the data on the source drive occurs, the backup of the
source logical drive data is copied to the target logical drive. Then, the new data is
written to the source logical drive. This FlashCopy nobackup link exists until you
dissolve the link by issuing a FlashCopy stop command.

Note: You have instant read access to the target partition after a FlashCopy
backup or FlashCopy nobackup command is issued.

Chapter 8. Installing and using the IPSSEND command-line program 69



Important

Before using FlashCopy, consider the following:

v Normal I/O functions can be performed on the source partition while the FlashCopy
operation is in progress. If you are performing a FlashCopy backup, do not write to the
target partition until the FlashCopy backup process is complete.

If you are performing a FlashCopy nobackup, do not write to the target partition at all.

v You can have up to four FlashCopy links active at a time.

v The source and target drives must be on the same controller.

v There is no limit on source and target partition size.

v When FlashCopy is completed, the data on the target partition will be an exact image of
the data on the source partition at the time FlashCopy was issued.

v The target partition must be at least the same size as the source partition. For optimal
space usage, the FlashCopy target partition should be the same size as the source
partition.

v You can use the noprompt option to run some FlashCopy functions without receiving
any interactive prompts.

v Both the source and target drives must be either spanned arrays or non-spanned arrays.

v If the source and target drives are spanned arrays, they must have the same number of
sub-arrays.

v If the source and target drives are part of a spanned array, there can be only one
partition for each logical drive on that spanned array.

The following information shows you how to use the FlashCopy function.

flashcopy map
Use the flashcopy map function to correlate how the ServeRAID
logical drives map to the operating-system drive partitions.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0

Command: ipssend flashcopy controller map

where controller is the ServeRAID controller number (1–12).

For example, if you type ipssend flashcopy 2 map, the following
results appear on the screen:

Found 2 IBM ServeRAID Controller(s).

Partition
Number

Partition
Letter

Partition
Size

Logical
Drive

Array
Letter

Available for
FlashCopy

1 H: 100 1 A No (note 1)

2 I: 100 2 A No (note 1)

3 J: 50 2 A Yes

None None - 3 B No (note 5)

None None - 4 B No (note 5)

Note 1:
This partition is either an active
FlashCopy link or unavailable due
to active FlashCopy links. See the
table below for details. Use the
STOP command to break these links.
Once the link is broken, you can
reissue the FLASHCOPY BACKUP or
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FLASHCOPY NOBACKUP command.

Note 5:
There is no partition defined on
this logical drive.

If a partition is available for FlashCopy, the report states Yes and
there are no notes for that partition. If a partition is not available for
FlashCopy, the report states No with one of the following
explanatory notes:

Note 1
This is either an active FlashCopy link or unavailable due to
active FlashCopy links. See the table below for details. Use
the stop function to break these links. After the link is
broken, you can reissue the FlashCopy backup or
FlashCopy nobackup functions.

Note 2
One or more of the following is true for this partition:
v The partition is the boot partition.
v The partition does not have an NTFS or FAT file system.
v The partition does not have a drive letter assigned.
v There is more than one partition defined on this logical

drive in the spanned array.
v The partition has open files.
v The partition has a memory-paging file.

You can override these requirements by using the force
option. See the FlashCopy backup and FlashCopy nobackup
functions for more details.

Note 3
One or more of the following is true for this partition:
v The partition is in the blocked state.
v The partition is not in the okay or critical state.
v The partition is currently synchronizing, rebuilding, or

migrating.

Note 4
FlashCopy can support up to four active links only.

Note 5
There is no partition defined on this logical drive.

flashcopy backup
Use the flashcopy backup function to create a quick snapshot of
source partitions on corresponding target partitions. After the
snapshot is created, the source partitions are ready for immediate
use. When the process is completed, each target partition will
contain a copy of its source partition data that existed at the exact
time you issued the flashcopy backup function. A link between
each source partition and target partition will exist until all the data
is copied. After all the source data is copied to the target partition
(determined by the ipssend getstatus function), the link is
automatically broken, and you can use the flashcopy delete and
flashcopy import functions to move a logical drive to another
server.
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You can use the flashcopy map function to determine the partition
numbers and if they are available for the flashcopy backup
process.

Notes:

1. Only one flashcopy backup process (involving up to four
source and target partitions) can be active on a controller at a
time. If a flashcopy backup process is in progress, you cannot
issue another flashcopy backup or flashcopy nobackup
command until the previous flashcopy backup process is
completed or until the backup links are broken. You must initiate
multiple FlashCopy links at the same time. For example, if you
want to initiate four FlashCopy links, you must initiate the links
on the same command:
IPSSEND FLASHCOPY BACKUP <1 2> <3 4> <5 6> <7 8>

You cannot initiate the four links across multiple commands,
such as the following:
IPSSEND FLASHCOPY BACKUP <1 2> <3 4>
IPSSEND FLASHCOPY BACKUP <5 6> <7 8>

You can use the flashcopy stop function to break the links
between the source and target partitions. After you use the
flashcopy stop function, reformat the target partition. All data
on the target partition is invalid after you stop the FlashCopy.
This includes stopping in the middle of a flashcopy backup.
Data is valid during the flashcopy backup and after the
flashcopy backup is completed, but not after a flashcopy stop is
issued during the flashcopy backup.

2. For flashcopy backup to function properly, each target partition
must have the same file system type as its source partition.

3. Do not attempt to write to the target partitions until the backup
process is completed.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0

Command: ipssend flashcopy controller backup [source target]
options

where:
v controller is the ServeRAID controller number (1–12)
v Parameters that are enclosed in brackets can be repeated. The

maximum number of repetitions is four.
v source is the source partition number

Note: Use the flashcopy map function to correlate the
ServeRAID logical drive number to the operating system
drive partition number.

v target is the target partition number

Note: Use the flashcopy map function to correlate the
ServeRAID logical drive number to the operating system
drive partition number.

v options is an optional parameter that includes the following:
– POLL displays the progress of the backup function.
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– FORCE creates a flashcopy of a source partition that is the
boot partition and contains open files or contains a memory
paging file.

Note: Using the FORCE option will not guarantee file
consistency between the source and target partitions.

– NOPROMPT overrides the user prompt.

flashcopy nobackup
Use the flashcopy nobackup function to create a quick snapshot
of the source partition data on its target partition. After the snapshot
is created, the source partitions are ready for immediate use. Each
target partition will contain a snapshot of its source partition data
that existed at the exact time you issued the command. A link
between each source partition and its target partition will exist until
you issue the flashcopy stop function. After you issue the
flashcopy stop function, each target partition contents are no
longer valid. The flashcopy nobackup function is useful if you
want a snapshot of your data to perform a tape backup.

You can use the flashcopy map function to determine the partition
numbers and whether they are available for the flashcopy
nobackup function process.

Notes:

1. Only one flashcopy nobackup link (involving up to four source
and target partitions) can exist on a ServeRAID controller. If a
flashcopy nobackup function is invoked, you cannot issue
another flashcopy backup or flashcopy nobackup function
until existing nobackup links are broken. You must initiate
multiple FlashCopy links at the same time. For example, if you
want to initiate four FlashCopy links, you must initiate the links
on the same command:
IPSSEND FLASHCOPY BACKUP <1 2> <3 4> <5 6> <7 8>

You cannot initiate the four links across multiple commands,
such as the following:
IPSSEND FLASHCOPY BACKUP <1 2> <3 4>
IPSSEND FLASHCOPY BACKUP <5 6> <7 8>

You can use the flashcopy stop function to break the links
between the source and target partitions. Following the
flashcopy stop function, reformat the target partition. All data
on the target partition is invalid after you stop the FlashCopy.
This includes stopping in the middle of a flashcopy nobackup.
However, data copied after the flashcopy nobackup function is
issued and before the flashcopy stop function is issued is valid.

2. For the flashcopy nobackup function to operate properly, each
target partition must have the same partition type as its source
partition.

3. Do not attempt to write to the target partition until the nobackup
link is broken.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0
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Command: ipssend flashcopy controller nobackup [source target]
options

where:
v controller is the ServeRAID controller number (1–12)
v Parameters that are enclosed in brackets can be repeated. The

maximum number of repetitions is four.
v source is the source partition number

Note: Use the flashcopy map function to correlate the
ServeRAID logical drive number to the operating system
drive partition number.

v target is the target partition number

Note: Use the flashcopy map function to correlate the
ServeRAID logical drive number to the operating system
drive partition number.

v options is an optional parameter that includes the following:
– FORCE creates a flashcopy of a source partition that is the

boot partition and contains open files or contains a memory
paging file.

Note: Using the FORCE option will not guarantee file
consistency between the source and target partitions.

– NOPROMPT overrides the user prompt.

flashcopy stop all
Use the flashcopy stop all function to break the link between the
source partitions and target partitions. After you issue the
flashcopy stop all function, the target partition contents are no
longer valid. After you issue the flashcopy stop all function,
reformat your target partition.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0

Command: ipssend flashcopy controller stop all [noprompt]

where:
v controller is the ServeRAID controller number (1–12)
v noprompt is an optional parameter to override the user-prompt.

flashcopy delete
Use the flashcopy delete function to delete an array. This is useful
when you have used the flashcopy backup function and you want
to move the target array to another server. After you delete the
array, you can move the drives to the other server; then, you can
issue the flashcopy import function to add the array to the existing
configuration of the other server.

You can use the ServeRAID Manager program to identify the array
you want to delete. This program can make the LEDs blink for the
drives that belong to the specific array.

Important
If your target logical drive is configured with write-back cache enabled, wait 10 minutes after
the flashcopy backup is completed before issuing a flashcopy delete function. This
ensures that all data has been moved from the controller cache to the logical drive.
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Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0

Note: The flashcopy delete function is not available in a cluster
configuration.

Command: ipssend flashcopy controller delete arrayID
[noprompt]

where:
v controller is the ServeRAID controller number (1–12)
v arrayID is the Array ID (A–H)

Note: If the array is a spanned array, arrayID is the array ID
(1–8).

v noprompt is an optional parameter to override the user prompt.

flashcopy import
Use the flashcopy import function to merge logical-drive
information from new physical drives when they are added to the
server. You can use this function to incorporate a target array after
a flashcopy backup function is completed.

Notes:

1. The stripe-unit size of the logical drives being imported must be
the same as the stripe-unit size of the logical drives on the new
controller.

2. The number of physical drives you add must be equal to the
number of physical drives that were in the logical drive defined
originally.

3. The physical drives must be added while the server is on.

4. When a logical drive is imported, all partitions from that logical
drive are also imported automatically. You cannot import a
single partition selectively.

5. You must manually assign drive letters after the import is
completed.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0

Note: The flashcopy import function is not available in a cluster
configuration.

Command: ipssend flashcopy controller import options

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– ALL to specify all logical drives
– n to specify a valid logical drive number (1–8)

Server roll-out functions
The IPSSEND server roll-out functions include the following:

autosync Use the autosync function to synchronize a new logical drive. The
purpose of synchronizing logical drives is to compute and write the
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parity data on the selected drives. Synchronizing a logical drive
verifies that the data redundancy for that logical drive is correct.
Use this function only on RAID level-5 logical drives. This function
starts a background synchronization so you can use the logical
drive immediately.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend autosync controller logicaldrive [noprompt]

where:
v controller is the ServeRAID controller number (1–12)
v logicaldrive is the logical drive number (1–8)
v noprompt is an optional parameter that overrides the user

prompt

backup Use the backup function to save a ServeRAID controller
configuration and BIOS settings to a diskette or to a physical drive.
The ServeRAID controller configuration must be valid.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend backup controller filename [noprompt]

where:
v controller is the ServeRAID controller number (1–12)
v filename is the path and file name where the configuration is to

be written
v noprompt is an optional parameter that overrides the user

prompt.

copyld Use the copyld function to copy a source logical drive to a target
logical drive. The size of the target logical drive must be greater
than or equal to the size of the source logical drive.

Supported operating system: DOS

Command: ipssend copyld controller source target [noprompt]

where:
v controller is the ServeRAID controller number (1–12)
v source is the source logical drive number
v target is the target logical drive number
v noprompt is an optional parameter that overrides the user

prompt.

init Use the init function to initialize the first 0.5 MB of a logical drive.
This process will erase the partition tables and all access to data on
the disk.

Note: (Linux only) You must restart your server to clear the
previous partition tables from memory.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend init controller logicaldrive [noprompt]
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where:
v controller is the ServeRAID controller number (1–12)
v logicaldrive is the logical drive number (1–8)
v noprompt is an optional parameter that overrides the user

prompt.

restore Use the restore function to load a configuration from a file stored
on a diskette or a hard disk. The configuration must be a valid
configuration file from the backup option in IPSSEND. This
operation overwrites the existing configuration information and BIOS
settings stored for the ServeRAID controller.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend restore controller filename [noprompt]

where:
v controller is the ServeRAID controller number (1–12)
v filename is the path and file name where the configuration is to

be written
v noprompt is an optional parameter that overrides the user

prompt.

synch Use the synch function to synchronize the parity information on
redundant logical drives. If the parity information is inconsistent, the
IPSSEND program will repair it automatically.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend synch controller scope scopeID

where:
v controller is the ServeRAID controller number (1–12)
v scope is one of the following:

– DRIVE is a single logical drive
– GROUP is a merge group

v scopeID specifies the scope item:
– If DRIVE, specifies the logical drive number (1–8)
– If GROUP, specifies the merge-group number

Error-recovery functions
The IPSSEND error-recovery functions include the following:

getstatus Use the getstatus function to display the current logical-drive status
for the most recent rebuild, synchronization, or logical-drive
migration. The status includes such information as the remaining
size of the logical drive, the percentage completed for the function
in process, and information about the most recently completed
logical-drive function.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend getstatus controller

where controller is the ServeRAID controller number (1–12).
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rebuild Use the rebuild function to rebuild a designated disk drive. This
function is valid for disk arrays that contain one or more logical
drives that are in the critical state. Progress is indicated during the
rebuild operation, but you can also use the getstatus function to
obtain progress information about the rebuild.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend rebuild controller dch dsid nch nsid

where:
v controller is the ServeRAID controller number (1–12)
v dch is the channel number for the defunct drive (1–4)
v dsid is the SCSI ID for the defunct drive (0–15)
v nch is the channel number for the new drive (1–4)
v nsid is the SCSI ID for the new drive (0–15)

setstate Use the setstate function to change the state of a physical device
from its current state to a new state.

Attention: You must be very careful when you use this function.
For example, you might lose data if you reset a defunct device to
online without first performing a rebuild operation.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend setstate controller channel sid nstate

where:
v controller is the ServeRAID controller number (1–12)
v channel is the channel number for the drive (1–4)
v sid is the SCSI ID for the drive (0–15)
v nstate is the new state for the drive. Valid states are:

– EMP for Empty
– RDY for Ready
– HSP for Hot spare
– SHS for Standby hot spare
– DDD for Defunct disk drive
– DHS for Defunct hot spare
– RBL for Rebuild
– SBY for Standby
– ONL for Online

unblock Use the unblock function to gain access to a blocked logical drive.
RAID level-0 logical drives become blocked if they are in an array
that contains RAID level-1 or level-5 logical drives and the array is
being rebuilt. Because the RAID level-0 logical drives cannot be
rebuilt, the data stored on the RAID level-0 logical drives is
damaged and should not be accessed. After you issue the unblock
function, you must re-create or restore the data previously stored
on the RAID level-0 logical drives.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS
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Command: ipssend unblock controller logicaldrive

where:
v controller is the ServeRAID controller number (1–12)
v logicaldrive is the logical drive number (1–8)

Problem-isolation and debug functions
The IPSSEND problem-isolation and debug functions include the following:

certify Use the certify function to verify the media of a physical drive.
When the program finds a media error, it reassigns the sectors. A
summary of reassignments and Predictive Failure Analysis

®

(PFA)
errors appears upon completion of the verification.

Supported operating system: DOS

Command: ipssend certify controller channel sid

where:
v controller is the ServeRAID controller number (1–12)
v channel is the channel number for the device (1–4)
v sid is the SCSI ID for the device (0–15)

eraseevent Use the eraseevent function to clear all logged entries in the
designated event log. See getevent help for information about the
contents of the device event log and the controller soft and hard
event logs.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend eraseevent controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is the designated event log:

– DEVICE for the device event log
– SOFT for the ServeRAID controller soft event log
– HARD for the ServeRAID controller hard event log
– ALL for the ServeRAID controller device, soft, and hard event

logs

format Use the format function to perform a low-level format of a physical
drive.

Attention:

1. When you issue this function, all data on the disk will be
erased.

2. After a format function is issued, do not stop it. If a format
process is stopped for any reason, the hard disk that was being
formatted will not respond to any functions except the format
function. Thus, the ServeRAID controller will not be able to
recognize functions anymore. To recover the drive, refer to
“Recovering from an incomplete format of a physical drive” on
page 152.

Supported operating system: DOS

Command: ipssend format controller channel sid

Chapter 8. Installing and using the IPSSEND command-line program 79



where:
v controller is the ServeRAID controller number (1–12)
v channel is the channel number for the device (1– 4)
v sid is the SCSI ID for the device (0–15)

getbst Use the getbst function to display the number of bad stripes in the
bad stripe table for each logical drive.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend getbst controller

where controller is the ServeRAID controller number (1–12).

getevent Use the getevent function to display information about various
unexpected events. IBM service representatives use the soft and
hard event logs for development and debugging purposes only. The
device event log contains event counters for each attached physical
device. These counters include:

v Parity: An unexpected event occurred while data was being
transferred on the SCSI bus. This usually indicates a problem
with the SCSI cable, connectors, or terminators.

v Soft: A SCSI device detected a check-condition event.

v Hard: The SCSI controller detected an unexpected event. The
controller is the most likely cause.

v Misc: The ServeRAID controller detected an event that was most
likely caused by the device.

The device event log also provides PFA alerts, which indicate that
the device has signaled the ServeRAID controller that it might fail in
the near future.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend getevent controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is the designated event log:

– DEVICE for the device event log
– SOFT for the ServeRAID controller soft event log
– HARD for the ServeRAID controller hard event log

id Use the id function to list information about the ServeRAID
controllers that are installed in your server. The information includes
controller type, BIOS and firmware code version, boot block
version, slot number.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend id
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selftest The selftest function is used to direct a controller or a device to
perform its self-test.

Supported operating system: DOS

Command: ipssend selftest controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is the designated self-test:

– AD for the ServeRAID controller self-test
– PD channel sid for the device self-test

Note: channel represents the drive channel (1–4), and sid is
the SCSI ID for the device (0–15).

RAID configuration functions
The IPSSEND RAID configuration functions include the following:

create Use the create function to create arrays and logical drives for
ServeRAID controllers. You must type the channel and SCSI ID of
the physical drives to define an array. You must type the logical
drive size and the RAID level for the logical drive. When you type
MAX as the size on the command line, the maximum size of the
logical drive is calculated automatically. If there is free space in an
existing array, you can create additional logical drives for that array.

Note: You cannot create RAID level-x0 logical drives with the
create function.

After the logical drive is created, a quick initialization is done. The
quick initialization process initializes (writes zeroes on) the first
1024 sectors (0.5 MB) of the logical drive. If you assign RAID
level-5 or RAID level-5E to the logical drive and the ServeRAID
controller supports the auto-synchronization feature, the logical
drive automatically synchronizes in the background. If the controller
does not support the auto-synchronization feature, you can use the
IPSSEND synch function to synchronize the RAID level-5 or RAID
level-5E logical drives. After synchronization, the logical drives are
available for storing data.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend create controller logicaldrive options size
raidlevel [channel sid] noprompt

Note: The symbols [ ] above mean that the parameters are
repeatable. The maximum number of repetitions is 16.

where:
v controller is the ServeRAID controller number (1–12)
v logicaldrive indicates that you are creating a logical drive
v options is one of the following:

– NEWARRAY indicates that you are creating a new array and
logical drive
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– arrayID is the Array ID (A–H) of an existing array
v size is the size (MB) of the logical drive. The minimum size is the

number of physical drives in the array. The maximum size is the
available space in the array. Specifying MAX creates the
maximum size for the array.

v raidlevel is the RAID level for the logical drive (0, 1, 1E, 5, or 5E)
v channel is the channel number for the device (1– 4)
v sid is the SCSI ID for the device (0–15)
v noprompt is an optional parameter that overrides the user

prompt.

delete Use the delete function to delete an array. All data contained in the
logical drives defined in that array will be lost.

Note: You cannot delete RAID level-x0 logical drives with the
delete function.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend delete controller array arrayID

where

v controller is the ServeRAID controller number (1–12)

v arrayID is the array identifier (A-H) of an existing array

devinfo Use the devinfo function to retrieve information (such as size and
state) about a specific device.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend devinfo controller channel sid

where:
v controller is the ServeRAID controller number (1–12)
v channel is the channel number for the device (1– 4)
v sid is the SCSI ID for the device (0–15)

drivever Use the drivever function to display the vendor ID, firmware
version, and serial number of a SCSI device. The IPSSEND
program retrieves this information directly from the device.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend drivever controller channel sid

where:
v controller is the ServeRAID controller number (1–12)
v channel is the channel number for the device (1– 4)
v sid is the SCSI ID for the device (0–15)

getconfig Use the getconfig function to display the ServeRAID controller
configuration information. This information includes, but is not
limited to, the following: the firmware version, device driver version,
SCSI initiator ID and rebuild rate, logical-drive status, RAID level,
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and size, physical device type, SCSI ID, PFA error, and
field-replaceable unit (FRU) part number.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend getconfig controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– AD for the controller information.
– LD for the logical drive information.
– PD for the physical device information.
– AL for all information. This is the default option.

hsrebuild Use the hsrebuild function to turn on the ServeRAID controller
hot-swap rebuild feature. Use the getconfig function to display the
current status of the hot-swap rebuild feature.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend hsrebuild controller on

where:
v controller is the ServeRAID controller number (1–12)
v on enables the hot-swap feature.

readahead Use the readahead function to enable, disable, or set the adaptive
mode for the read-ahead feature of the ServeRAID controller.

Supported operating system: DOS

Command: ipssend readahead controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– ON enables the read-ahead feature
– OFF disables the read-ahead feature
– ADAPTIVE indicates that the controller will determine the best

mode to use at any given time.

scandrives Use the scandrives function to scan all SCSI channels on a
controller for the following:

v physical drives that have been added

v ready drives that have been removed

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS Command: ipssend scandrives controller

where controller is the ServeRAID controller number (1–12)

setconfig Use the setconfig function to modify the current configuration on
the controller.
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Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend setconfig controller options noprompt

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– DEFAULT to set the factory-default settings. All logical drives
that are currently defined will be deleted.

– IMPORTDRIVE to copy the configuration from the drives
attached to the controller. To import from a specific physical
drive, type the channel number and the SCSI ID; otherwise,
the controller selects the drive from which to import the
configuration. This option is useful when you are replacing a
controller and reestablishing the original configuration on the
new controller.

v NOPROMPT overrides the user prompt.

startdely Use the startdely function to set the number of drives in a group to
start up simultaneously and to set the delay, in seconds, between
the startup of these groups of drives.

Supported operating system: DOS

Command: ipssend startdely controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– A number (1–16) that specifies the new concurrent drive
startup count.

– A number (1–16) that specifies the new concurrent drive
startup count and a number (3–15) that specifies the startup
delay time, in seconds.

unattended Use the unattended function to enable or disable the unattended
feature of the ServeRAID controllers.

Supported operating systems: Windows XP, Windows 2000,
Windows NT 4.0, NetWare, OS/2, Linux, OpenServer, UnixWare,
Open UNIX, and DOS

Command: ipssend unattended controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– ON to enable the feature
– OFF to disable the feature
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Chapter 9. Using the IPSMON command-line program
(NetWare only)

This chapter provides the information about installing, starting, and using the
IPSMON command-line program.

You can use the IPSMON program to monitor a ServeRAID controller for defunct
drives, Predictive Failure Analysis (PFA) warnings, rebuild operations, FlashCopy
operations, synchronizations, logical-drive migrations, and RAID level-5E
compressions. Whenever activities occur, this program can log a message to the
screen, to a file, or to both the screen and a file.

You can use the IPSMON program with Novell NetWare 4.x and 5.x only.

This utility program is provided on the IBM ServeRAID Support for Novell NetWare
diskette.

Installing the IPSMON command-line program
You can install this program for NetWare using the IBM ServeRAID Support for
Novell NetWare diskette. To install the IPSMON program for NetWare, do the
following:

1. Start the server.

2. After the operating system starts, insert IBM ServeRAID Support for Novell
NetWare diskette into the diskette drive.

Note: These instructions assume that you installed the following:
v NetWare in the NWSERVER directory
v The DOS CD-ROM device drivers

3. Copy IPSMON to your hard disk by typing the following at the DOS command
prompt:
copy a:\ipsmon.nlm c:\nwserver

where a is the diskette drive letter and c:\nwserver is where NetWare is
installed.

4. Press Enter. Remove the diskette from the diskette drive.

Using the IPSMON command-line program
To run the IPSMON program, do the following:

1. From the console, type:
load c:\nwserver\ipsmon

where c:\nwserver is where NetWare is installed.

2. Press Enter.

When you start IPSMON, it immediately begins polling all ServeRAID controllers for
specific conditions. If a condition is found, this program logs a message to the
screen, to a file, or to both the screen and a file.

Note: IPSMON continuously polls the ServeRAID controllers until you type unload
ipsmon at the system console.
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Command: ipsmon options

where options is one of the following optional parameters:
v -F:filename to specify the name of the file in which to record messages. The

default file name is IPSMON.LOG.
v -S to display messages on the standard output (usually the screen).
v -? to obtain a current list of valid parameters.

Note: If you start this program without any command-line parameters, the IPSMON
program will log the messages to the IPSMON.LOG file, and the messages
will not be displayed on the screen.

During operation, IPSMON logs various messages. Each message contains an alert
code and a location specifier.

v The alert code begins with the message type and number:

– INF (information) followed by the message number

– WRN (warning) followed by the message number

– CRT (critical) followed by the message number

v The location specifier comes after the alert code:

– A followed by the controller number

– C followed by the channel number (if required)

– SID followed by the SCSI ID (if required)

For example, a message of CRTxxx:A2C3SID04 signifies that a Critical condition
(CRTxxx) was found on Controller 2 (A2), Channel 3 (C3), SCSI ID 4 (SID04).

The IPSMON program can log the following messages, based on the condition
being monitored and errors detected.

Information Messages:
<Date and Time> INF000:A1C-SID-- (no errors detected)
<Date and Time> INF001:A1C-SID-- (rebuild started)
<Date and Time> INF002:A1C-SID-- (rebuild completed)
<Date and Time> INF003:A1C-SID-- (synchronization started)
<Date and Time> INF004:A1C-SID-- (synchronization completed)
<Date and Time> INF005:A1C-SID-- (migration started)
<Date and Time> INF006:A1C-SID-- (migration completed)

Warning Messages:
<Date and Time> WRN001:A2C3SID12 (PFA error detected)

Critical Messages:
<Date and Time> CRT001:A3C2SID04 (dead drive detected)
<Date and Time> CRT002:A1C-SID-- (controller is not responding to commands)
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Chapter 10. Installing and starting the ServeRAID Manager
program

After installing the operating system on your server, you can install the ServeRAID
Manager program. The ServeRAID Manager program provides a graphical interface
that you can use while your server is running. You can use the interface to do the
following:

v Monitor ServeRAID configuration changes

v Perform configuration functions, including create an array, delete an array, create
a logical drive, change the RAID level, dynamically increase the logical drive
size, rebuild an array, configure ServeRAID controllers for failover, and configure
a cluster

To use the ServeRAID Manager program, see the ServeRAID Manager online help
or refer to “Chapter 4. Configuring ServeRAID controllers” on page 29.

Installing the ServeRAID Manager program
This section provides instructions for installing the ServeRAID Manager program.

When using: Go to:
Windows XP “Installing ServeRAID Manager on Windows XP, Windows 2000,

Windows NT 4.0, Windows Me, Windows 98, or Windows 95” on
page 88.

Windows 2000 “Installing ServeRAID Manager on Windows XP, Windows 2000,
Windows NT 4.0, Windows Me, Windows 98, or Windows 95” on
page 88.

Windows NT 4.0 “Installing ServeRAID Manager on Windows XP, Windows 2000,
Windows NT 4.0, Windows Me, Windows 98, or Windows 95” on
page 88.

Figure 27. ServeRAID Manager installed on a server
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When using: Go to:
Windows Me “Installing ServeRAID Manager on Windows XP, Windows 2000,

Windows NT 4.0, Windows Me, Windows 98, or Windows 95”.
Windows 98 “Installing ServeRAID Manager on Windows XP, Windows 2000,

Windows NT 4.0, Windows Me, Windows 98, or Windows 95”.
Windows 95 “Installing ServeRAID Manager on Windows XP, Windows 2000,

Windows NT 4.0, Windows Me, Windows 98, or Windows 95”.
NetWare “Installing ServeRAID Manager on NetWare”.
Linux “Installing ServeRAID Manager on Red Hat Linux, SuSE Linux, Caldera

OpenLinux, or TurboLinux” on page 89.
OS/2 “Installing ServeRAID Manager on OS/2” on page 90.
OpenServer “Installing ServeRAID Manager on OpenServer” on page 90.
UnixWare “Installing ServeRAID Manager on UnixWare or Open UNIX” on page 91.
Open UNIX “Installing ServeRAID Manager on UnixWare or Open UNIX” on page 91

Installing ServeRAID Manager on Windows XP, Windows 2000,
Windows NT 4.0, Windows Me, Windows 98, or Windows 95

Notes:

1. When installed on Windows XP Professional, Windows 2000, or Windows NT
4.0, this version of the ServeRAID Manager program supports up to 12
ServeRAID controllers.

2. When installed on Windows Millennium Edition (Me), Windows 98, and Windows
95, the ServeRAID Manager program works only as a console. You can use the
console to connect to remote servers that contain ServeRAID controllers.
Servers installed with Windows Me, Windows 98, or Windows 95 as the
operating system do not support ServeRAID controllers.

3. If ServeRAID Manager 3.50 is already installed on your server, do not remove it
prior to upgrading to the new version. If you remove version 3.50 before
installing the new version, you will lose all customization files (such as Managed
system tree nodes and the Notification list).

To install the ServeRAID Manager program on Windows XP, Windows 2000,
Windows NT 4.0, Windows Me, Windows 98, or Windows 95, do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. When the installation program starts, follow the instructions on the screen to
install the program.

Note: If you are installing ServeRAID Manager on an IBM server that supports
Active PCI under Windows NT 4.0, select the IBM ServeRAID Hot
Replace Wizard to enable the hot-replace feature. This feature also
requires that you install the DMI Service provider and the IBM Hot Plug
for Windows NT 4.0 Package, version 4.2 or later. For more information,
see “Using a ServeRAID controller in a server with Active™ PCI features”
on page 9.

Installing ServeRAID Manager on NetWare
Notes:

1. To install the NetWare version of the ServeRAID Manager program, you must
install it from a Microsoft Windows client that is connected to the NetWare
system.
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2. ServeRAID Manager supports only NetWare 5.x and later. Use the
command-line utilities IPSSEND and IPSMON for NetWare 4.x. For more
information, refer to “Chapter 8. Installing and using the IPSSEND
command-line program” on page 63 and “Chapter 9. Using the IPSMON
command-line program (NetWare only)” on page 85.

3. The NetWare version of the ServeRAID Manager program supports up to eight
ServeRAID controllers.

Important

To install the ServeRAID Manager program, you must have a network drive mapped to the
root directory of the SYS partition.

Before you install the ServeRAID Manager program, do the following:

v Install the latest Support Pack before installing the Novell Java™ Virtual Machine (JVM)
for NetWare. You can download the latest Support Pack from the following address:

http://support.novell.com/misc/patlst.htm#nw

v Check that your Novell JVM is version 1.1.7b or later. Versions older than 1.1.7b are not
compatible with the ServeRAID Manager program. To check your JVM version, load Java
and type at the NetWare command prompt:

JAVA -VERSION

You can download the latest JVM from the following address:
http://www.novell.com/download

To install the ServeRAID Manager program on Novell NetWare, do the following:

1. On a client that is running Microsoft Windows and is connected to the NetWare
system, map a network drive to the root directory of your NetWare SYS
partition.

2. Insert the IBM ServeRAID Support CD into the CD-ROM drive of the client. The
installation program starts.

3. When prompted, select Novell NetWare.

4. When prompted for the installation directory, provide only the drive letter to the
NetWare SYS partition that you mapped in step 1.

5. Follow the instructions on the screen to install the program.

Installing ServeRAID Manager on Red Hat Linux, SuSE Linux, Caldera
OpenLinux, or TurboLinux

Notes:

1. The ServeRAID Manager program comes with the IBM Java Runtime
Environment (JRE).

2. If the ServeRAID Manager program has previously been installed on your
server, you must remove that version before upgrading. All customization files
(such as Managed system tree nodes and the Notification list) are saved and
used in the upgrade. To remove the ServeRAID Manager program from Linux,
type the following command:
rpm --erase RaidMan

3. When installed on Linux, this version of the ServeRAID Manager program
supports up to eight ServeRAID controllers.
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To install the ServeRAID Manager program on Red Hat Linux (version 6.2 or later),
SuSE Linux 7.1, Caldera Open Linux 3.1, or TurboLinux 6.5, do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. If your CD-ROM drive automounts, type the following command and go to step
6. Otherwise, go to step 3.
rpm -install /mnt/cdrom/linux/manager/RaidMan-4.80.i386.rpm

3. If your CD-ROM drive does not automount, type the following and press Enter:
mount -r -t iso9660 /dev/cdromdevicefile /mountpoint

where cdromdevicefile is the specific device file for the CD-ROM block device,
and mountpoint is the mountpoint of the Linux system.

4. Type the following and press Enter:
rpm -install /mountpoint/cdrom/linux/manager/RaidMan-4.80.i386.rpm

where mountpoint is the mountpoint of the device file used in step 3.

5. When the installation is complete, type the following:
umount /mountpoint

where mountpoint is the mountpoint of the Linux system.

6. Press Enter. You can now remove the CD from the CD-ROM drive.

Installing ServeRAID Manager on OS/2

Note: When installed on OS/2, this version of the ServeRAID Manager program
supports up to eight ServeRAID controllers.

To install the ServeRAID Manager program on OS/2, do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. Open an OS/2 command window.

3. Type the following and press Enter:
e:

where e is the CD-ROM drive letter.

4. Type the following and press Enter:
cd \os2\manager

5. Type the following and press Enter:
install

6. The installation program starts. Follow the instructions on the screen. On the
final installation panel, specify the location where you want to install the
ServeRAID Manager program.

Installing ServeRAID Manager on OpenServer
Notes:

1. When installed on OpenServer, this version of the ServeRAID Manager program
supports up to eight ServeRAID controllers.

2. To install or remove the ServeRAID Manager package, you must have root
privileges.

3. If ServeRAID Manager is installed on your system, you must remove the old
version before upgrading. All customization files (such as Managed system tree
nodes and the Notification list) are saved and used in the upgrade.
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To remove the ServeRAID Manager program from OpenServer, type the
following command:
pkgrm RaidMan

To install the ServeRAID Manager program on OpenServer, do the following.

Note: The ServeRAID Manager requires that you install either the SCO
OpenServer Java Development Kit (JDK) or Java Runtime Environment,
version 1.1.7b or 1.1.8. You can download the JDK and JRE from the SCO
Web site:

http://www.sco.com/java/

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. Type the following:
mount -r -f HS,lower /dev/cd0 /mnt

3. Then, type the following (all on the same line) and press Enter:
pkgadd -a /mnt/openserv/manager/RaidMan.adm -d
/mnt/openserv/manager/RaidMan.ds

4. When the installation is complete, type the following and press Enter:
umount /mnt

5. You can now remove the CD from the CD-ROM drive.

Installing ServeRAID Manager on UnixWare or Open UNIX
Notes:

1. The ServeRAID Manager requires that you install either the SCO OpenServer
Java Development Kit (JDK) or Java Runtime Environment, version 1.1.7b or
1.1.8. You can download the JDK and JRE from the SCO Web site:

http://www.sco.com/java/

2. To install or remove the ServeRAID Manager package, you must have root
privileges.

3. If the ServeRAID Manager program has previously been installed on your
server, you must remove that version before upgrading. All customization files
(such as Managed system tree nodes and the Notification list) are saved and
used in the upgrade. To remove the ServeRAID Manager program from
UnixWare or Open UNIX, type the following command:
pkgrm RaidMan

4. When installed on UnixWare or Open UNIX, the current version of the
ServeRAID Manager program supports up to eight ServeRAID controllers.

To install the ServeRAID Manager program for UnixWare or Open UNIX, do the
following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. Type the following and press Enter:
mount -r -F cdfs /dev/cdrom/cdromdevicefile /mnt

where cdromdevicefile is the specific device file for the CD-ROM block device.
Look in the /dev/cdrom directory to determine what cdromdevicefile is on your
server, for example, c0b0t010.

3. Type the following and press Enter:
pkgadd -d /mnt/openunix/manager/RaidMan.ds
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4. When the installation is complete, type the following and press Enter:
umount /mnt

5. You can now remove the CD from the CD-ROM drive.

Starting the ServeRAID Manager program
After you have configured your ServeRAID controller, installed the device drivers,
installed the operating system, and installed the ServeRAID Manager program on
your server, you can administer and monitor your ServeRAID controllers, as well as
modify the ServeRAID controller configuration.

Starting the ServeRAID Manager program in Windows XP, Windows
2000, Windows NT 4.0, Windows Me, Windows 98, or Windows 95

To start the ServeRAID Manager program in Windows 2000, Windows NT, Windows
Me, Windows 98, or Windows 95, click Start → Programs → ServeRAID Manager →
ServeRAID Manager. The ServeRAID Manager program opens, and a window
similar to the following appears.

Starting the ServeRAID Manager program in NetWare
To start the ServeRAID Manager program in NetWare:

1. From the NetWare console, type the following and press Enter:
LOAD RAIDMAN

2. The ServeRAID Manager program opens, and a window similar to that shown in
Figure 28 appears.

Figure 28. ServeRAID Manager window
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Starting the ServeRAID Manager program in OS/2
To start the ServeRAID Manager program from the OS/2 desktop, double-click the
ServeRAID Manager icon. To start the ServeRAID Manager program from an OS/2
command line, do the following:

1. Type the following to change to the directory where you installed the ServeRAID
Manager program:
cd \RaidMan

2. Press Enter.

3. Type the following and press Enter:
RaidMan

4. The ServeRAID Manager program opens, and a window similar to that shown in
Figure 28 appears.

Starting the ServeRAID Manager program in OpenServer, UnixWare,
Open UNIX, and Linux

To start the ServeRAID Manager program in OpenServer, UnixWare, Open UNIX, or
Linux, do the following:

Note: Ensure that you have superuser privileges before starting these procedures.

1. Type the following to change to the directory where you installed the ServeRAID
Manager program:

For OpenServer cd /opt/RaidMan
For UnixWare and Open UNIX cd /opt/RaidMan
For Linux cd /usr/RaidMan

2. Press Enter.

3. Type the following and press Enter:
sh RaidMan.sh

4. The ServeRAID Manager program opens, and a window similar to that shown in
Figure 28 appears.

Note: (UnixWare and Open UNIX only) When installed on UnixWare or Open
UNIX, the ServeRAID Manager program might list the installed ServeRAID
controllers in a different order than the ServeRAID Manager program in
startable-CD mode. To identify a specific controller, refer to its physical slot
number.
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Part 3. Installing the IBM ServeRAID Cluster Solution
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Chapter 11. Introduction to the IBM ServeRAID Cluster
Solution

A cluster is a group of independent computer systems that work together as a
single logical system. A client interacts with a cluster as though it is a single server.
In other words, a cluster is a group of computers linked together in such a way that
they share and manage a set of resources that can support a number of users at
the same time.

This high-availability clustering solution is based on a two-server cluster, where both
servers can access the same storage devices, but only one server at a time
controls the storage devices shared by both servers. If one of the two running
servers fails, the remaining server automatically assumes control of the shared
resources managed by the failed server while still controlling its own resources at
the same time. Then, the failed server can be repaired offline without the loss of
time or work efficiency, because the shared data and applications earlier managed
by the failed server are still online to the clients.

When the failed server is operational again, it can be placed back into the cluster;
the resources are reallocated between the two servers and the cluster resumes
normal operation.

A controller is a device that coordinates and controls the operation of one or more
input and output devices, such as workstations, and synchronizes the operation of
such devices with the operation of a system as a whole.

The IBM ServeRAID Cluster Solution, as discussed in this book, uses the IBM
ServeRAID-4 Ultra160 SCSI controller. The IBM ServeRAID Cluster Solution also
uses IBM expansion enclosures, such as the following:
v IBM Netfinity EXP15 Rack Expansion Enclosure
v IBM Netfinity EXP200 Rack Expansion Enclosure
v IBM Netfinity EXP300 Rack Expansion Enclosure

You can install the IBM ServeRAID Cluster Solution by using one of the following
software applications:

v Microsoft Cluster Service, which is part of Windows NT Server Enterprise Edition

v Microsoft Cluster Service using Windows 2000, which is part of Windows 2000
Advanced Server Edition.

The following figures show an example of a simple high-availability clustering
solution. The first figure shows a high-level view of a cluster; the second figure
shows a more detailed view of a cluster.
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Note A: Server A
v Shared Channel 1 - SCSI ID 6
v Non-shared Channel 2 - SCSI ID 6

Note B: Server B
v Shared Channel 1 - SCSI ID 7
v Non-shared Channel 2 - SCSI ID 7

Server A Server B

Clients

SCSI Bus

Expansion Enclosure

Public Network

Crossover
Cable
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Figure 29. A high-level view of a cluster
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Figure 30. A detailed view of a cluster
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The solution you use for your installation depends on your specific requirements.
For more information about requirements and types of installations, refer to the IBM
Shared Disk Clustering Hardware Reference. You can obtain this publication from
the IBM Support Web site. See “Downloadable files from the World Wide Web” on
page 135 for additional information.
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Chapter 12. Preparing to install or change a cluster solution

Note: If you are going to upgrade an existing high-availability cluster solution and
are already familiar with the concepts of a cluster, go to “Chapter 17.
Updating the ServeRAID BIOS, firmware, and software code for clustering”
on page 137. If you are setting up a high-availability cluster solution for the
first time, continue reading this section.

Before you begin installing and setting up a high-availability cluster solution,
familiarize yourself with the following terms and definitions, as well as some
considerations concerning the ServeRAID controller.

Terms and definitions
The following terms are used in this section. For a detailed explanation of these
terms, refer to the Server Cluster Glossary in the Windows Platform Software
Developers Kit.

Failover is the process of relocating the cluster resources from a failed server to
the remaining server. The resource-monitor program responsible for the resource
detects the failure. If a resource failure occurs, the resource-monitor program
notifies the Cluster Service, which triggers the actions that are defined in the
failover policy for that resource. A failover can occur automatically, such as when an
application or a server fails, or it can occur manually, such as when a system
administrator moves all applications onto one server and then shuts down the other
server for scheduled maintenance. Failover generally includes three tasks:
v Failure detection
v Resource relocation
v Application restart

Failback is a special case of failover. It is the process of moving back some or all
groups of resources to the preferred owner after a failover has occurred. The
preferred owner is the server in the cluster on which you prefer each group of
resources to run. If the preferred owner fails, its resources are transferred to the
other server. When the preferred owner is repaired and comes back online and
allow failback is enabled in the Microsoft Cluster Administration program, the
resources are automatically transferred back to that server.

Resource Group is a set of dependent resources that you can group together.
Some cluster resources cannot go online unless other cluster services are running.
These services are resource dependencies. When one resource is listed as a
dependency for another resource, the two resources must be placed in the same
group. If all resources are ultimately dependent on one resource (for example, one
physical disk resource), all resources must be in the same group. Therefore, all
resources in a cluster might need to be in the same group.

Furthermore, any cluster operation performed on a group is performed on all
resources that are in that group. For example, if a resource must be moved from
Server A to Server B, all resources that are in the same group as the resource will
be moved also.
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ServeRAID considerations
It is important to understand the following ServeRAID considerations before you set
up your high-availability cluster solution.

Hardware considerations
v You must cable the SCSI channels in a controller pair so that the controllers

share the same channels.

v You must connect all disks that will be shared to the shared channels. This
includes hot-spare drives, as well as data drives.

v Each shared physical drive must be part of a logical drive or defined as a hot
spare to one or the other servers. You must remove all other physical drives from
the shared disk enclosure to ensure proper operation.

v Do not connect nondisk devices, such as CD-ROM or tape drives, to shared
channels. These devices will be accessible to both servers, and conflicts might
arise.

Controller considerations
v Controller pair is a term that refers to two controllers, one in each system, that

are connected to each other through the same SCSI bus.

v Each ServeRAID controller must have a different SCSI initiator ID assigned to
the shared channels. For example, set one server, Server A, to ID 6, and set the
other server, Server B, to ID 7. The setup instructions describe this in more
detail.

v You must set the stripe-unit size of each ServeRAID controller in a pair to the
same value (8 KB, 16 KB, 32 KB, or 64 KB).

v Each ServeRAID controller must have a unique controller name assigned.

v Do not change the controller name on both ServeRAID controllers in a pair at the
same time. Doing so can cause problems and might require that you restart the
server.

v You cannot share hot-spare drives between controllers in a cluster pairing. If you
want hot-spare protection, each ServeRAID controller must have a hot-spare
drive defined. You must connect hot-spare drives only to shared channels. Both
servers must be able to access their uniquely-defined hot-spare drives in case a
failover occurs after a hot-spare drive replaces a failed shared drive.

v Physical drives that are configured by one controller in the pair must appear as
ready drives to the other controller in the pair. Be sure to verify this criterion
when you add drives. Restart both servers, or scan for new devices using the
ServeRAID Manager program on both servers, to make sure the added physical
drives appear as ready drives on both servers before creating logical drives.

Array or logical drive considerations
v Create only one logical drive for each array.

v Every logical drive that is shared by the two servers must have its write-cache
mode set to write through; this will help ensure that data integrity is maintained.
For logical drives that are not shared between the two servers, set the
write-cache mode to write back; this will improve performance.

v You must assign merge-group numbers in the range 1–8 to each logical drive
that will be shared. Merge-group numbers must be unique for each shared logical
drive in the cluster. You must assign merge-group numbers 206 or 207 to the
non-shared logical drives.
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v If you are starting (booting) the operating system from a shared controller, define
the first logical drive as the startup drive and assign a merge-group number for a
non-shared drive, for example, 206 for Server A.

v The total number of logical drives per controller must be eight or less before or
after a failover. If you exceed this number, a failover will not be completed.

v The following logical drives will not failover:

– Logical drives currently undergoing Logical Drive Migration (LDM) operations

– RAID level-5E logical drives undergoing compression or decompression

– RAID level-5 logical drives in a critical state

However, all other logical drives will failover if necessary.

v The ServeRAID controller does not permit the failover of RAID level-5 or level-5E
logical drives that are in a critical state. For this reason, do not use RAID level-5
or level-5E for the quorum drive. You must configure the quorum drive as a RAID
level-1 logical drive.

Note: Define hot-spare drives in your array to minimize the time that logical
drives remain in critical state.

v If a failover occurs while a critical RAID level-1,level-1E, level-10 or level-1E0
logical drive is rebuilding to a spare disk, the rebuild operation automatically
restarts.

v The cluster support software will initiate a synchronization of all RAID level
logical drives except for the following:

– RAID level-0 logical drives

– Any critical or offline logical drives.

If a drive fails before this synchronization is complete, logical drive access is
blocked and is no longer accessible.

v When a logical drive spans multiple SCSI channels and a failure within the drive
subsystem occurs that is unique to a channel (for example, a disconnected
cable), the entire physical array will be identified as failed even though access
from the surviving server can occur. Therefore, if you have small arrays, consider
not spanning multiple channels.
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Chapter 13. Configuring ServeRAID controllers for clustering

Before configuring the ServeRAID controllers, you must first install the BIOS and
firmware code. Refer to “Chapter 17. Updating the ServeRAID BIOS, firmware, and
software code for clustering” on page 137. Then, you must configure the ServeRAID
controllers, define logical drives, and set up merge-group numbers for your servers.

Configuring the controller for Microsoft Cluster Service using
Windows 2000 or Windows NT 4.0

If you are configuring ServeRAID controllers for Microsoft Cluster Service on
Windows 2000 or Windows NT 4.0, do the following:

1. If necessary, perform any operating-system shutdown procedure on both
servers that you are going to use in the cluster.

2. Turn off both servers.

3. If you have not done so, connect any shared external drive enclosures to both
servers; then, turn on the enclosures.

4. Follow the procedure “Configuring a controller for clustering” on page 106 for
each shared controller in Server A, and then return to this step.

5. Continue with the procedure “Configuring ServeRAID arrays and a logical
drive” on page 108 for Server A, and then return to this step.

6. Before you configure Server B, for complicated clusters you might want to use
View shared drives to identify online drives in Server B as reserved.

a. From Server A, right-click the controller and select View shared drives.

b. Select the Enable view shared drives check box.

c. Set the channel and SCSI ID for the drives that are identified as ready on
Server A and online on Server B.

Drives used in the cluster will be displayed as reserved on Server B.

7. Follow the procedure “Configuring a controller for clustering” on page 106 for
each shared controller in Server B, and then return to this step.

8. Remove the IBM ServeRAID Support CD from the CD-ROM drive.

9. Restart Server A; then, restart Server B.

10. If you are installing the IBM ServeRAID Cluster Solution using Microsoft
Cluster Service on Windows 2000, go to “Installing the Microsoft Cluster
Service software on Windows 2000” on page 120.

If you are installing the IBM ServeRAID Cluster Solution using Microsoft
Cluster Service on Windows NT 4.0, go to “Installing the Microsoft Cluster
Service software on Windows NT 4.0” on page 113.

Note: After you have completed installing the IBM ServeRAID Cluster Solution, use
the Validate cluster action in the ServeRAID Manager program to verify the
cluster configuration. See “Validating a cluster” on page 131 for more
information.
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Configuring a controller for clustering
To configure a controller, do the following.

Note: For complete information on using the ServeRAID Manager program, refer to
the ServeRAID Manager online help.

1. Insert the IBM ServeRAID Support CD (or the configuration CD that was
included with your server) into the CD-ROM drive; then, turn on the server. The
ServeRAID Manager program starts.

2. If the ServeRAID Manager program detects unconfigured ServeRAID controllers
and ready drives, the program automatically starts the Configuration wizard, and
a window similar to the following opens. To exit the Configuration wizard, click
Cancel; then, in the confirmation window, click Yes.

3. In the ServeRAID Manager tree, click the ServeRAID controller that you want to
configure.

Attention

Restore the ServeRAID controller to factory-default settings only once, when the controller
is first installed. This process removes all configuration information from NVRAM, including
the SCSI initiator IDs, the controller and partner names, and the array information.

This point is especially important if the Windows 2000 or Windows NT 4.0 system startup
drive is attached to the IBM ServeRAID controller. If this process occurs after the startup
drive array has been created, the array information will be removed, and the system will no
longer start in Windows 2000 or Windows NT 4.0.

If you already have logical drives defined that you want to keep, go to step 6. Steps 4 and 5
will cause loss of data by deleting all logical drives already defined.

Figure 31. Configuration wizard
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4. Click Actions → Restore to factory-default settings.

5. If a confirmation window opens, click Yes. When the operation is complete, a
message appears at the bottom of the window indicating that ServeRAID
Manager has successfully restored the configuration to the factory-default
settings.

6. In the ServeRAID Manager tree, click the ServeRAID controller that you are
configuring.

7. Click (Configure for clustering) on the toolbar. The “Configure for
clustering” window opens.

8. Provide the following information.

Controller name
Type a name to identify the first controller, for example, Server A.

Partner name
Type a name that you will use to identify the second controller, for
example, Server B.

Initiator IDs
The system presets these SCSI initiator IDs to 7. For Server A, set each
ID to 6 for shared channels. For Server B, do not change these values.
(The ServeRAID Manager program does not permit you to select
numbers other than 6 and 7.)

Notes:

a. The controller name and partner name are case sensitive.

b. If your configuration will contain multiple ServeRAID controller pairs, each
controller name must be unique.

9. Click OK. The controller is now configured for clustering.

Figure 32. “Configure for clustering” window
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Configuring ServeRAID arrays and a logical drive

Important

v Define all shared logical drives on Server A.

v When defining shared logical drives, create only one logical drive for each array.

v Each controller must have its own hot-spare or standby hot-spare drive defined. This
means that you must not define the same hot-spare or standby hot-spare drive on both
controllers in the pair.

v Define hot-spare and standby hot-spare drives only on a shared channel.

To configure arrays and logical drives, do the following.

1. Click (Configure RAID) on the toolbar. The Configuration wizard opens.

2. In the ServeRAID Manager tree, click the ServeRAID controller that you want
to configure.

3. Click Custom configuration.

4. Click Next. The “Create arrays” window opens.

5. Click the appropriate Array tab in the right panel; then, from the ready drives
list, select the drives that you want to move to the array.

Figure 33. “Create arrays” window
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6. Click (Add selected drives) to add the drives to an array. You can click

(Add all drives) to move all ready drives to an array.

Notes:

a. Unless you define a drive as a hot-spare drive, you must use all the ready
drives when creating your arrays (that is, all ready drives in the tree must
be online).

b. Hot-spare drives are not shared between controllers in a cluster pairing. If
you want hot-spare protection, each ServeRAID controller must have a
hot-spare drive defined.

c. You must connect hot-spare drives only to shared channels. Both servers
must be able to access their uniquely-defined hot-spare drives in case a
failover occurs after a hot-spare drive replaces a failed shared drive.

d. You must create at least one logical drive to store the quorum resource
information. This logical drive (the quorum drive) must be assigned RAID
level-1.

e. For improved reliability, do not create arrays that span channels.

7. After you select the ready drives for your arrays, click Next. The ″Create
logical drives″ window opens.

8. Click the appropriate Array tab.

9. Select a RAID level from the drop-down list. (Refer to “Supported RAID levels”
on page 16 for more information.)

Notes:

a. If you have four or more ready drives in an array, the recommended RAID
level is RAID level-5E.

Figure 34. ″Create logical drives″ window
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b. Only one logical drive can be defined for each array.

10. Click Next. The ″Configuration summary″ window opens.

11. Review the information that is displayed in the Configuration summary window.
Click Apply; then, click Yes when asked if you want to apply the new
configuration. The configuration is saved in the ServeRAID controller and on
the physical drives.

12. Click Return to the ServeRAID Manager to continue working with your
ServeRAID configuration. After creating the arrays and logical drives, you must
assign merge-group numbers to the shared logical drives.

Note: A merge-group number uniquely identifies each shared logical drive,
even when the logical drive moves between servers.

13. In the ServeRAID Manager tree, click the ServeRAID controller that contains
the logical drives.

Notes:

a. Valid merge-group numbers for non-shared logical drives are 206 and 207.
For example, set all non-shared drives on Server A to merge-group number
206 and all non-shared drives on Server B to merge-group number 207.

b. The merge-group number must be unique for each logical drive that is
shared by the controller pair. For example, if you have a logical drive with a
merge-group number 1 on Server A, you cannot assign the same group
number to a logical drive on Server B. Valid merge-group numbers for
shared logical drives are from 1 through 8.

14. Click (Configure for clustering) on the toolbar. The “Configure for
clustering” window opens.

Figure 35. ″Configuration summary″ window
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15. Select the Shared check boxes for all the logical drives.

16. Do not change the merge-group number from the default that is provided.

17. Record the controller name, partner name, and merge-group numbers, and
store them in a safe place. You will need this information to recover the
configuration if the ServeRAID controller fails.

Note: You can save this information to a file by using the ServeRAID Manager
program:

a. In the ServeRAID Manager tree, click the server.

b. Click Actions → Save printable configuration.

18. Click OK.

19. To exit the ServeRAID Manager program, click File → Exit.

20. Click Shutdown or Restart.

21. Remove the IBM ServeRAID Support CD from the CD-ROM drive.

22. Continue with “Chapter 14. Installing the Microsoft Cluster Service software” on
page 113.

Figure 36. “Configure for clustering” window
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Chapter 14. Installing the Microsoft Cluster Service software
Important

Before beginning the procedure, consider the following:

v Read “ServeRAID considerations” on page 102, which contains important information on
ServeRAID considerations.

v Read “Configuring the controller for Microsoft Cluster Service using Windows 2000 or
Windows NT 4.0” on page 105 for information on configuring Server A and Server B for
the high-availability cluster solution.

After configuring the ServeRAID controller, defining logical drives, and setting up
merge-group numbers, you can install Microsoft Cluster Service (MSCS) on
Windows NT 4.0 or Windows 2000. Refer to the following instructions:

v “Installing the Microsoft Cluster Service software on Windows NT 4.0”

v “Installing the Microsoft Cluster Service software on Windows 2000” on page 120.

Installing the Microsoft Cluster Service software on Windows NT 4.0

Important

Before beginning the procedure, ensure that you are using the IBM ServeRAID Support for
Windows NT 4.0 diskette during the installation of the Microsoft Windows NT Server
Enterprise Edition.

Installing the ServeRAID Manager program

Note: In order to run ServeRAID Manager as an installed program, you must install
the appropriate device driver for your server video controller.

Before installing MSCS, you must install the ServeRAID Manager program:

1. If the server is not running, turn on the server.

2. Insert the IBM ServeRAID Support CD (or the configuration CD that was
included with your server) into the CD-ROM drive of Server A. The ServeRAID
Manager setup program starts.

3. Click Next.

4. Click Yes to the Software License Agreement.

5. When prompted to select an operating system, select Windows NT/Windows
2000; then, click Next.

6. When prompted to install Windows NT Service, click Yes; then, click Next.

7. Select the Destination Folder; then, click Next.

8. After setup completes copying the files, click Finish.
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Installing the Microsoft Cluster Service
To install the Microsoft Cluster Service, do the following:

1. If you do not have Microsoft Windows NT Server Enterprise Edition installed
already, install it with Service Pack 3 (or later) on both servers. Do not install
the Microsoft Cluster Service software. When prompted, deselect the option to
install MSCS; it will be installed later in this procedure.

Note: The Microsoft Windows NT Server Enterprise Edition CD contains
Service Pack 3.

For information on installing Windows NT Server Enterprise Edition, refer to
documentation that is included with it. When you are finished, return to this
step and continue with this procedure.

2. Use the ServeRAID Manager program to scan for new drives on both servers.
Right-click on the controller, and click Scan for new or removed ready
drives.

3. On Server A, run the utility IPSHAHTO.EXE from the IBM ServeRAID Cluster
Solution for Windows NT and Windows 2000 diskette or the IBM ServeRAID
Support CD. At a Windows NT command line, type one of the following:

If installing from CD e:\winnt\cluster\support\ipshahto

If installing from diskette a:\support\ipshahto

where a is the diskette drive letter and e is the CD-ROM drive letter.

Running the IPSHAHTO program makes all the shared logical drives available
for access by Server A.

4. Using the Windows NT Disk Administrator, format all shared logical drives as
NTFS (NT File System), assign volume labels, and specify drive letters for
each.

Important

Before creating the ServeRAID logical cluster resource, you must assign a permanent
(sticky) drive letter to the shared logical drive on both servers. The two servers must have
the same drive letters on each shared drive. If you do not assign permanent drive letters,
Windows NT might assign different drive letters on each server. Assigning a permanent
drive letter ensures that Windows NT assigns the same drive letter to the partition on both
servers.

Notes:

a. It is helpful if the volume label contains the drive letter you assigned to the
drive, such as DRIVE E.

b. If you want to use the disk in a cluster, create only one partition on the
disk. Make the partition the full size of the disk and format the partition to
NTFS.

5. On Server B, run IPSHAHTO.EXE to make all shared logical drives available
for access by Server B.

6. On Server B, use the Windows NT Disk Administrator to assign the same drive
letters that you assigned to each drive on Server A.

Note: Use the volume label as a guide to make sure you assign the same
letters on Server B as you assigned on Server A.
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7. On Server A, run IPSHAHTO.EXE again, so that Server A regains control of all
shared logical drives.

8. On Server A, install the Microsoft Cluster Service (MSCS) software.

Note: The directory name and path where the MSCS software is installed
must be the same on both servers.

To start the installation, do the following.

Important

You must use the localquorum option when installing the Microsoft Cluster Service (MSCS)
software with ServeRAID controllers.

a. Insert the Windows NT Server Enterprise Edition Component CD into the
CD-ROM drive on Server A.

b. At the command line, type the following and press Enter:
e:\MSCS\CLUSTER\I386\SETUP /localquorum

where e is the CD-ROM drive letter.

Note: You must type the parameter localquorum in lowercase.

c. Install the Microsoft Cluster Service software. Follow the instructions in the
documentation included with the MSCS software.

Server A will restart when the installation is completed.

9. On Server B, make it join the cluster by doing the following.

Note: The directory name and path where the MSCS software is installed
must be the same on both servers.

a. Insert the Windows NT Server Enterprise Edition Component CD into the
CD-ROM drive on Server B. Type the following command (from either a
command line or Add/Remove Programs in the Control panel) and press
Enter:
e:\MSCS\CLUSTER\I386\SETUP

where e is the CD-ROM drive letter.

b. Install the Microsoft Cluster Service software. Follow the instructions in the
documentation included with the MSCS software.

Server B will restart when the installation is completed.

10. Install the IBM ServeRAID Windows NT Cluster Solution program by doing the
following:

a. On Server A, run the utility SETUP.EXE program from the IBM ServeRAID
Cluster Solution for Windows NT and Windows 2000 diskette or IBM
ServeRAID Support CD and follow the instructions that appear on the
screen. At a Windows NT command line, type one of the following and
press Enter:

If installing from CD e:\winnt\cluster\setup

If installing from diskette a:\setup

where a is the diskette drive letter and e is the CD-ROM drive letter.

b. When the setup is completed on Server A, run the utility SETUP.EXE
program on Server B.
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After the utility program has been installed on both servers, all shared
ServeRAID groups and disk resources will be automatically created by the
IBM ServeRAID Cluster Solution setup program and then brought online.
Server A is the current owner of these groups.

11. Move the quorum resource from localquorum to a ServeRAID disk resource by
doing the following:

a. On Server A, run the Microsoft Cluster Administrator program and click the
cluster name to select the cluster you are using.

b. Verify that the same server (for example, Server A) owns the ServeRAID
disk resources and the localquorum resource and that the quorum resource
is moved to a RAID level-1 logical drive.

Note: Set the quorum resources on a RAID level-1 logical drive. Do not
set the quorum resources on a RAID level-5 logical drive.

c. Right-click the cluster name to open the cluster.

d. Select Properties; then, click the Quorum tab.

e. In the Quorum Resource field, select a ServeRAID shared disk.

f. Click OK.

g. Delete the Local Quorum Resource and the Local Quorum Group.

Refer to the Microsoft Cluster Solution Administrator’s Guide for more
information.

12. Install the latest Windows NT 4.0 Service Pack.

Note: If you installed Service Pack 4 or later previously, you must reinstall it
now.

You now can move the shared disk resources manually using the Microsoft Cluster
Administrator program or automatically during failover.

Creating additional ServeRAID disk resources on a Windows NT 4.0
ServeRAID cluster

You can use a ServeRAID logical disk that has not already been designated as a
cluster resource, or you can create a new array and logical disk on Server A, using
the ServeRAID Manager program. For more information about creating new arrays
and logical drives, refer to “Chapter 4. Configuring ServeRAID controllers” on
page 29.

Note: Be sure to assign a unique shared merge-group number to the new shared
logical drive.

Important

Before creating the ServeRAID logical cluster resource, you must assign a permanent
(sticky) drive letter to the shared logical drive on both servers. The two servers must have
the same drive letters on each shared drive. If you do not assign permanent drive letters,
Windows NT might assign different drive letters on each server. Assigning a permanent
drive letter ensures that Windows NT assigns the same drive letter to the partition on both
servers.
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1. On Server A, do the following:

a. Click Start in the lower-left corner of the screen; then, click Programs →
Tools → Administrative Tools → Disk Administrator. The Disk
Administrator window opens.

b. Click the partition that you want to assign a permanent drive letter.

c. Click Tools → Assign Drive Letter. The “Assign drive letter” window opens.

d. In the Assign drive letter menu, click the drive letter for the partition.

e. Click OK. Windows NT permanently assigns the selected drive letter to that
partition, even if you add new partitions or rearrange your controllers.

f. To exit the Disk Administrator, click Partition → Exit.

2. On Server B, do the following:

a. Using the ServeRAID Manager program, scan for new or removed ready
drives.

b. Run IPSHAHTO.EXE program to move the newly defined logical drive to
this server.

c. Using the Windows NT Disk Administrator program, assign the same
permanent (sticky) drive letter as in step 1.

Perform the following operation on the cluster server that currently owns the shared
logical drive. The cluster server that owns the logical drives is the server on which
you last ran the IPSHAHTO.EXE program.

1. On the server owning the newly created logical drive, run the Cluster
Administration program and open a connection to the installed cluster.

2. To create the ServeRAID disk resource in an existing group, ensure that the
cluster server that owns the shared logical drive is the owner of that group. If
the cluster server is not the owner of the group, use Move Group to make this
cluster server the owner of the group where you will create the ServeRAID disk
resource. Then, create the ServeRAID disk resource.

3. Bring the new ServeRAID disk group online. If you create a new ServeRAID
group, the cluster server that owns the shared logical drive will be the owner of
this group by default.

4. Create a ServeRAID disk resource as part of the new group.

5. Bring the ServeRAID disk group online.

Deleting and re-creating a ServeRAID logical drive resource
This section describes how to delete and re-create a ServeRAID logical drive
resource without deleting a ServeRAID logical drive.

To delete a resource or resource group:

1. If the resource or resource group is not currently owned by the cluster server
from which you will delete the group, move the resource or resource group to
that cluster server.

Note: The cluster service must be running on both systems.

2. To delete the resource, run the Microsoft Cluster Administration program from
the cluster server that currently owns the resource or resource group.

Note: You can also run the Microsoft Cluster Administration program from a
remote administration system.
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Use the normal MSCS procedure for deleting a resource or a group. Refer to
the documentation that is included with the MSCS package for instructions.

To create a resource:

1. If the group that will own the resource you are creating is not currently owned
by the cluster server on which you want to create the resource, move the group
to the cluster server.

2. To create the resource, run the Microsoft Cluster Administration program from
the cluster server that currently owns the resource group.

Create a new ServeRAID logical disk. Refer to “Creating additional ServeRAID
disk resources on a Windows NT 4.0 ServeRAID cluster” on page 116.

Uninstalling MSCS on ServeRAID servers

Note: Do not use the uninstallation procedure if you are upgrading MSCS on
ServeRAID servers. To upgrade MSCS on ServeRAID servers, follow the
instructions in “Updating ServeRAID software in an MSCS cluster
environment” on page 119.

To uninstall MSCS on ServeRAID servers, you must perform the following
procedure on all servers in your cluster:

1. Select one of the cluster servers from which to uninstall MSCS.

2. Click Start in the lower-left corner of the screen; then, click Settings → Control
Panel. The Windows NT Control Panel window opens.

3. Double-click Services. The Services window opens.

4. Select Cluster Service from the list of services; then, click Stop.

5. Click Close to exit the Services window. For more information, refer to the
documentation that is included with the cluster services.

6. In the Windows NT control panel, double-click Add/Remove Programs.

7. Select Microsoft Cluster Service from the list of installed components; then,
click Add/Remove.

Note: Ignore the warnings regarding the removal of IBM ServeRAID Logical
Disks.

8. Follow the on-screen prompts by clicking OK or Yes.

9. After the uninstallation of MSCS is complete, restart the server when
prompted.

10. After the server has restarted, click Start; then, click Settings → Control
Panel.

11. Double-click Add/Remove Programs.

12. Select IBM ServeRAID Windows NT Cluster Solution from the list of
installed components; then, click Add/Remove.

13. Repeat step 1 through step 12 for the other server in the cluster.
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Updating ServeRAID software in an MSCS cluster environment

Note: If you are upgrading your ServeRAID software after downloading it from the
IBM Support Web site, perform this procedure. If you are installing your
software using the IBM ServeRAID Support CD, refer to “Chapter 4.
Configuring ServeRAID controllers” on page 29 for instructions.

Important

This upgrade procedure enables the cluster to remain online at all times. To upgrade the
cluster, perform the following steps on one server at a time. When all steps are completed
for Server A and both servers are reported in the Microsoft Cluster Administrator program as
“Up” and all resources are online, repeat the steps for Server B.

Note: Use these instructions on a cluster running Microsoft Cluster Service (MSCS)
Release 1.00 and the IBM ServeRAID Cluster Solution.

Step 1: Upgrading the IBM ServeRAID Manager program
To upgrade the ServeRAID Manager program, insert the IBM ServeRAID Support
CD into the CD-ROM drive. The Setup program starts automatically.

Step 2: Upgrading the IBM ServeRAID Microsoft Windows NT
Cluster Solution
To upgrade the IBM ServeRAID Microsoft Windows NT Cluster Solution, do the
following on the server you want to upgrade:

Run the utility SETUP.EXE program from the IBM ServeRAID Cluster Solution for
Windows NT and Windows 2000 diskette or IBM ServeRAID Support CD, and
follow the instructions that appear on the screen. At a Windows NT command line,
type one of the following:

If installing from CD e:\winnt\cluster\setup

If installing from diskette a:\setup

where a is the diskette drive letter and e is the CD-ROM drive letter.

Step 3: Upgrading the IBM ServeRAID Windows NT device driver
To upgrade the IBM ServeRAID Windows NT device driver on a server in the
cluster, do the following:

1. Insert the IBM ServeRAID Support CD (version 4.0 or later) into the CD-ROM
drive.

2. Click Start in the lower-left corner of the screen; then, click Settings → Control
Panel. The Windows NT Control Panel window opens.

3. Double-click SCSI-Adapters.

4. Click the Drivers tab.

5. Click Add.

6. Click Have Disk.

7. For the path, type the following:
e:\winnt\driver\nt4_0

where e is the CD-ROM drive.

8. Click OK.

Chapter 14. Installing the Microsoft Cluster Service software 119



9. When the IBM ServeRAID controller is highlighted, click OK.

10. Shut down and restart the server from the CD.

Step 4: Upgrading the IBM ServeRAID BIOS and firmware code
To upgrade the IBM ServeRAID BIOS and firmware on a server in the cluster, do
the following:

1. If you have not already done so, start the server with the IBM ServeRAID
Support CD, version 4.0 or later.

2. When prompted, click Update to flash the BIOS and download the firmware. If
no update is required, the ServeRAID Manager program starts.

3. When the download is complete, remove the CD from the CD-ROM drive and
press Ctrl+Alt+Del to restart (reboot) the server.

4. Allow the server to rejoin the cluster. When the server is reported in the
Microsoft Cluster Administrator program as “Up” and all resources are online,
the upgrade for this server is complete.

Step 5: Upgrading the software for the other server in the cluster
To upgrade the software for the other server in the cluster, do the following:

1. Ensure that Server A is online in the cluster.

2. For Server B, repeat “Step 1: Upgrading the IBM ServeRAID Manager program”
on page 119 through “Step 4: Upgrading the IBM ServeRAID BIOS and
firmware code”.

Installing the Microsoft Cluster Service software on Windows 2000

Important

Before beginning the procedure, consider the following:

v Ensure that you use the IBM ServeRAID Support for Windows 2000 Server diskette
during the installation of Windows 2000 Advanced Server Edition or Windows 2000
Datacenter Server Edition.

v To create a ServeRAID cluster, you must install the Windows 2000 operating system on
an NTFS partition, and any shared cluster disks must be formatted as NTFS.

v While installing Windows 2000, do not install Microsoft Cluster Service. You will install
MSCS later.

v To install the ServeRAID device driver version 4.0 (or later), refer to “Installing device
drivers after installing Windows 2000” in the IBM ServeRAID-4 Ultra160 SCSI Controller
Device Driver Installation Instructions on the IBM ServeRAID Support CD.

Installing the ServeRAID Manager program
Before installing MSCS, you must install the ServeRAID Manager program:

1. If the server is not running, turn on the server.

2. Log on to Windows 2000.

3. Insert the IBM ServeRAID Support CD (or the configuration CD that was
included with your server) into the CD-ROM drive of Server A. The ServeRAID
Manager setup program starts.

4. Click Next.

5. Click Yes to the Software License Agreement.

6. When prompted to select an operating system, select Windows NT/Windows
2000; then, click Next.

7. When prompted to install Windows NT Service, click Yes; then, click Next.
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8. Select the Destination Folder; then, click Next.

9. After setup completes copying the files, click Finish.

Installing the Microsoft Cluster Service
To install the Microsoft Cluster Service, complete the following procedure:

1. Use the ServeRAID Manager program to scan for new drives on all ServeRAID
controllers.

2. On Server A, run the utility IPSHAHTO.EXE program from the IBM ServeRAID
Windows NT Cluster Solutions Diskette or the IBM ServeRAID Support CD.

3. At a Windows 2000 command line, type one of the following:

If installing from CD e:\winsrv\cluster\support\ipshahto

If installing from diskette a:\support\ipshahto

where a is the diskette drive letter and e is the CD-ROM drive letter.

Running the program makes all the shared logical drives available for access
by Server A.

4. Using the right-mouse button, click My Computer on the desktop; then, click
Manage. The Computer Management window opens.

5. In the left pane, click to expand the Storage icon; then, click Disk
Management. The Disk Signature and Upgrade Wizard window opens.

6. To assign disk signatures for the shared disks, click Next.

7. Microsoft Cluster Service using Windows 2000 requires you to set shared
logical drives to Basic Disk. To do this, click Cancel in the Upgrade Disks pane
of the window.

8. Format all shared logical drives to NTFS (NT File System), assign volume
labels, and specify drive letters for each.

Important

Before creating the ServeRAID logical cluster resource, you must assign a permanent
(sticky) drive letter to the shared logical drive on both servers. The two servers must have
the same drive letters on each shared drive. If you do not assign permanent drive letters,
Windows 2000 might assign different drive letters on each server. Assigning a permanent
drive letter ensures that Windows 2000 assigns the same drive letter to the partition on both
servers.

Notes:

a. It is helpful if the volume label contains the drive letter you assigned to the
drive, such as DRIVE E.

b. If you want to use the disk in a cluster, create only one partition on the
disk. Make the partition the full size of disk and format the partition to
NTFS.

c. Make sure that all shared logical drives are the type Basic Disk. If they are
marked Dynamic Disk, change them to Basic Disk by doing the following:

1) Right-click the Disk icon at the bottom of the Disk Management window
(see Figure 37 on page 122).

2) Click Revert to Basic Disk.
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9. On Server B, use the ServeRAID Manager program to scan for new drives on
all ServeRAID controllers.

10. On Server B, run the same utility, IPSHAHTO.EXE, to make all shared logical
drives available for access by Server B.

Note: If all logical drives are not displayed as okay, there was a problem
bringing drives over from the other server. To diagnose the problem,
use the log files or the ServeRAID Manager to determine if the drives
are critical or offline.

11. Using the Windows 2000 Disk Management Snap-in Computer Management
program, scan for new drives and assign them the same drive letters that you
assigned to each drive on Server A.

Notes:

a. Use the disk volume label as a guide to make sure you assign the same
drive letters on Server B as you assigned on Server A.

b. You might need to press the F5 key multiple times to update the displayed
information. Wait until all logical drive letters appear before attempting to
change the property of any drives.

c. If the Disk Signature Wizard prompts you to write signatures on drives, the
drives have not been correctly recognized. Do the following:

1) On Server A, run the IPSHAHTO.EXE utility.

2) After Server A has successfully brought over all drives, run the
IPSHAHTO.EXE utility on Server B.

3) Repeat step 11.

12. Run IPSHAHTO.EXE from Server A again, so that control of all shared logical
drives returns to Server A.

13. Using the Windows 2000 Disk Management Snap-in Computer Management
program on Server A, verify that the shared logical drives display with the
correct size, volume label, and drive letter.

Figure 37. Changing a shared logical drive to Basic Disk
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Note: The drive letters for the shared disks must be the same on each server
in the cluster.

14. Ensure that both servers are turned on.

Note: If you have a two-node cluster that has a private network consisting of
the two servers directly connected to each other using an Ethernet
cross-over cable, make sure that both servers are turned on before you
proceed.

Failure to have both servers turned on will cause Windows 2000 to
mark the network adapter as failed, and you will not be able to select it
as the private network interface during cluster setup.

15. Insert the IBM ServeRAID Cluster Solution for Windows NT and Windows
2000 diskette or IBM ServeRAID Support CD into the Server A diskette or
CD-ROM drive.

16. Type one of the following and press Enter:

If installing from CD e:\winsrv\cluster\setup

If installing from diskette a:\setup

where a is the diskette drive letter and e is the CD-ROM drive letter. The
SETUP.EXE program copies some files and launches the Windows
Component Wizard.

17. In the Windows Component Wizard, select the check box to install the Cluster
Service component; then, click Next.

18. When prompted, insert the CD labeled Windows 2000 Advanced Server
CD-ROM into the CD-ROM drive; then, click OK. The Microsoft Cluster Service
Configuration Wizard opens.

Note: To configure the Microsoft Cluster Service, follow the instructions in the
Microsoft Cluster Service documentation.

19. After you install and configure the cluster, the IBM ServeRAID Cluster
Configuration Wizard opens and applies ServeRAID-specific configurations to
the cluster. When prompted, select a shared ServeRAID logical drive on which
to set the quorum resources.

Note: Set the quorum resources on a RAID level-1 logical drive. Do not set
the quorum resources on a RAID level-5 logical drive.

20. Repeat step 14 through step 18 for Server B. The cluster installation is
complete, and the cluster is ready for use.

Creating additional ServeRAID disk resources on a Windows 2000
ServeRAID cluster

You can use a ServeRAID logical disk that has not already been designated as a
cluster resource, or you can create a new array and logical disk on Server A, using
the ServeRAID Manager program. For more information about creating new arrays
and logical drives, refer to “Chapter 4. Configuring ServeRAID controllers” on
page 29.

Note: Be sure to assign a unique shared merge-group number to the new shared
logical drive.
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Important

Before creating the ServeRAID logical cluster resource, you must assign a permanent
(sticky) drive letter to the shared logical drive on both servers. The two servers must have
the same drive letters on each shared drive. If you do not assign permanent drive letters,
Windows 2000 might assign different drive letters on each server. Assigning a permanent
drive letter ensures that Windows 2000 assigns the same drive letter to the partition on both
servers.

1. On Server A, do the following:

a. Right-click My Computer; then, click Manage. The Computer Management
window opens.

b. Double-click Storage.

c. Click Disk Management. The Write Signature and Upgrade Disk Wizard
opens.

d. Right-click Disk Management → Rescan Disks.

e. On each of the new disks, do the following:

1) Right-click a new disk; then, click Write Signature. The Write Signature
Wizard opens. Follow and complete the wizard.

2) Make sure that all shared logical drives are the type Basic Disk. If they
are marked Dynamic Disk, change them to Basic Disk by doing the
following:

a) Right-click the Disk icon at the bottom of the Disk Management
window.

b) Click Revert to Basic Disk.

3) Create one partition on the disk (the full size of disk), assign a drive
letter, and format the partition to NTFS.

Note: To help recognize the drive on the cluster partner server, assign a
descriptive volume label that includes the drive letter.

2. On Server B, do the following:

a. Using the ServeRAID Manager program, scan for new or removed ready
drives on all ServeRAID controllers.

b. To move the newly defined logical drive to Server B, start the
IPSHAHTO.EXE program by typing:
%systemroot%\cluster\ipshahto.exe

where%systemroot% is expanded by the operating system to the root
directory of the operating system on Server B.

c. Using the Windows 2000 Disk Management Snap-in Computer Management
program, assign the same drive letters that you assigned to the new drives
on Server A.

Note: Use the disk volume label as a guide to make sure you assign the
same drive letters on Server B as you assigned on Server A.

d. To create a new ServeRAID disk resource and group for each newly defined
logical drive on Server B, start the MSCSCFG.EXE program by typing:
%systemroot%\cluster\mscscfg.exe

where%systemroot% is expanded by the operating system to the root
directory of the operating system on Server B.
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Deleting and re-creating a ServeRAID logical drive resource
This section describes how to delete and re-create a ServeRAID logical drive
resource without deleting a ServeRAID logical drive.

To delete a resource or resource group:

1. To delete the resource, run the Microsoft Cluster Administration program from
the cluster server that currently owns the ServeRAID resource or resource
group.

Notes:

a. The cluster service must be running on both servers.

b. You can also run the Microsoft Cluster Administration program from a
remote administration system.

2. Use the normal MSCS procedure for deleting a resource or a group. Refer to
the documentation that is included with the MSCS package for instructions.

3. After deleting the ServeRAID resource, shut down and restart the cluster server
from which the resource was deleted.

Note: Restarting one cluster server will not shut down the entire cluster.

To create the new ServeRAID disk resource and group for the ServeRAID logical
drive, start the MSCSCFG.EXE program by typing:
%systemroot%\cluster\mscscfg.exe

where%systemroot% is expanded by the operating system to the root directory of
the operating system on Server B.

Upgrading the IBM ServeRAID Cluster Solution from Microsoft
Windows NT 4.0 to Windows 2000

To upgrade from Windows NT 4.0 with Service Pack 5 (or later) to Windows 2000
Advanced Server, do the following.

Note: Before upgrading from Windows NT 4.0 Enterprise Edition, make sure you
have updated Windows NT 4.0 Enterprise Edition with the latest Service
Pack on both Server A and Server B.

1. On the server that you want to upgrade, click Start → Programs →
Administrative Tools → Cluster Administrator.

2. Move all cluster resources and groups to the other cluster node (that is, the
server that is not running the Cluster Administrator program).

3. Insert the IBM ServeRAID Support CD (version 4.0 or later) into the CD-ROM
drive; then, type the following command and press Enter:
e:\winsrv\cluster\setup.exe

where e is the CD-ROM drive.

4. When prompted A previous installation of “IBM ServeRAID NT Cluster
Solution” has been found. Do you want to upgrade?, click Yes.

5. When prompted You are currently running Windows NT 4.0. Is this upgrade
to “IBM ServeRAID NT Cluster Solution” being done as procedure to
upgrade cluster to run Windows 2000?, click Yes.
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6. The IBM ServeRAID Windows NT Solution Setup program copies the necessary
Windows 2000 files; then, it prompts you to upgrade the server to Windows
2000.

Note: After you complete this step, you cannot use this server as a Windows
cluster node anymore.

7. Insert the Microsoft Windows 2000 Advanced Server CD into the CD-ROM
drive.

8. Run the Windows 2000 Advanced Server Setup program to upgrade this node
to Windows 2000. After successfully upgrading the server, it joins the cluster.

Note: If your cluster installation includes ServeRAID-4M, ServeRAID-4Mx,
ServeRAID-4L, or ServeRAID-4Lx controllers, you must manually install
the ServeRAID device driver. To do so, do the following:

a. When Windows 2000 restarts the first time, the Windows 2000 Setup
window opens.

b. Press F6 promptly. You have only a few seconds to press this key.

c. Select the IBM ServeRAID 4M/4Mx/4L/4Lx (Windows 2000) device
driver.

For additional information about installing ServeRAID device drivers, refer
to the “IBM ServeRAID-4 Ultra160 SCSI Controller Device Driver
Installation Instructions” (4DEVDRV.PDF) on the IBM ServeRAID Support
CD.

9. Repeat step 1 on page 125 through step 8 for the other server in the cluster.

Uninstalling MSCS on ServeRAID servers
To uninstall MSCS on a ServeRAID server using Windows 2000 Advanced Server,
do the following:

1. On the server you want to remove from the cluster, click Start → Programs →
Administrative Tools → Cluster Administrator.

2. Move all cluster resources and groups to the other cluster server (that is, the
server that is not running the Cluster Administrator program).

3. In the tree view, click the server from which you want to remove MSCS.

4. Using the right-mouse button, click Stop Cluster Service; then, click Evict
Node.

5. Click Start → Settings → Control Panel. The Control Panel window opens.

6. Double-click Add/Remove Programs. The Add/Remove Programs window
opens.

7. In the left pane, click Add/Remove Windows Components. The Windows
Components Wizard opens.

8. Deselect Cluster Service in the Components list; then, click Next.

9. After the Microsoft Cluster Service is uninstalled, the Windows Component
Wizard prompts you to restart the server.

10. After the server restarts, click Start → Settings → Control Panel. The Control
Panel window opens.

11. Double-click Add/Remove Programs. The Add/Remove Programs window
opens.

12. Select IBM ServeRAID NT Cluster Solution from the list of installed
components.
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13. To uninstall the IBM ServeRAID Windows NT Cluster Solution, click
Change/Remove.

If you uninstall clustering on Windows 2000, you might not be able to access the
ServeRAID logical drives shared by the two nodes of the cluster. If this occurs, do
one of the following:

v Delete the logical drives and restart the server.

v Set the logical drives to non-shared by changing the merge-group numbers. Use
the ServeRAID Manager program in startable-CD mode to make this change.

Note: If you use the installed version of the ServeRAID Manager program to
delete and recreate the logical drives that have the same merge-group
number, you will not be able to access the logical drives. You must delete
the logical drives, restart the server, and re-create the logical drives.
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Chapter 15. Monitoring and updating an IBM ServeRAID
Cluster Solution

You can use the ServeRAID Manager program to check the ownership of a physical
drive on another server or to add or remove a logical drive in the cluster. The
ServeRAID Manager program supports three features for cluster functions:
v View shared drives
v Validate cluster
v Configure for clustering

Note: Make sure that you installed the ServeRAID Manager program on your
server. If you need to install it, refer to “Installing the ServeRAID Manager
program” on page 87 for instructions.

Checking the ownership of a physical drive
A physical drive that is owned (and configured) on Server B will appear in the ready
or defunct state on Server A. To determine whether a ready drive is owned by the
other server, do the following:

1. In the ServeRAID Manager tree, click the controller that contains the ready
drives. A window similar to the following opens.

2. Click Actions → Clustering actions → View shared drives. The “View shared
drives” window opens.

3. Click Enable view shared drives.

4. Select the SCSI channel and SCSI ID of a physical drive on a shared channel.

Figure 38. ServeRAID Manager window
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5. Click OK. Physical drives that are available for use are labeled Ready in the
tree. If the physical drive is not available for use (that is, it is owned by the other
server), the drive is labeled Reserved in the tree.

Important
Hot-spare drives owned by the other server are not labeled Reserved. Be sure you do not
inadvertently use a hot-spare drive in both servers.

Adding logical drives to a cluster
If you want to add logical drives to a cluster, do the following:

1. Install the hard disk drives in the server or shared expansion enclosure. For
installation information, refer to the documentation that is included with the hard
disk drive and the server.

Important

Physical drives that are configured by one controller in the pair must appear as ready drives
to the other controller in the pair. Be sure to verify this status when you add drives after the
servers are started. Before creating logical drives, restart both servers, or scan for new
drives using the ServeRAID Manager program on both servers, to make sure the added
physical drives appear as ready drives on both servers. For more information, see
“ServeRAID considerations” on page 102.

2. Using the ServeRAID Manager program, configure the physical drives for the
ServeRAID controller. Refer to “Chapter 4. Configuring ServeRAID controllers”
on page 29 for instructions.

Note: If the drives will be shared, define only one logical drive per array.

3. In the ServeRAID Manager tree, click the controller for the cluster.

4. Click (Configure for clustering) on the toolbar. A window similar to the
following opens.

5. Click Shared or Non-shared for the logical drive you have just defined.

Figure 39. “Configure for clustering” window
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6. Select the merge-group number that you want to use for the logical drive you
just defined.

7. Click OK.

8. If you are using Windows NT 4.0, continue with “Creating additional ServeRAID
disk resources on a Windows NT 4.0 ServeRAID cluster” on page 116.

If you are using Windows 2000, continue with “Creating additional ServeRAID
disk resources on a Windows 2000 ServeRAID cluster” on page 123.

Validating a cluster
Use this feature to determine whether your cluster is configured correctly.

Note: You must have the ServeRAID Manager program installed and running on all
servers in the cluster for this feature to work.

To validate a cluster, do the following:

1. In the ServeRAID Manager tree, click a server in the cluster.

2. Click Actions → Validate cluster. A window similar to the following opens.

The server you selected in step 1 is listed in the Node A field.

Note: You cannot change the Node A system in the “ServeRAID cluster
validation” window. To select a different system, click Cancel to return to
the ServeRAID Manager tree.

3. From the Node B menu, select your second server.

Note: The Node B system defaults to the first system in the tree other than the
Node A system. If there are no remote systems in the tree, click Cancel
to return to the tree and add a remote system. You can also type the
Node B name.

Figure 40. “ServeRAID cluster validation” window

Chapter 15. Monitoring and updating an IBM ServeRAID Cluster Solution 131



4. Click Start. The ServeRAID Manager program scans both systems to verify the
ServeRAID cluster configuration. The progress indicator reports the progress of
the validation.

5. If you want to stop the validation before it is completed, click Cancel.
Otherwise, if the ServeRAID Manager program finds problems with the
ServeRAID cluster configuration, it reports the problems in the Problems found
message field. If there are no problems with the ServeRAID cluster
configuration, the message field reports only the cluster pairings found.

6. To view the problem report events in an easy-to-read window, double-click an
event in the Problems found message field.

7. To save the contents of the Problems found message field, click Save. A “Save
as” window opens. Specify the file name for the message field log and click OK.

8. Click Done to exit the “ServeRAID cluster validation” window. If the ServeRAID
cluster configuration has problems, fix the problems; then, use Validate cluster
again.

Viewing merge-group numbers and other cluster information
To view the merge-group numbers and other cluster information, do the following:

1. In the ServeRAID Manager tree, click the controller you are using for the cluster.

2. Click (Configure for clustering) on the toolbar. A window similar to the
following opens.

Note: In this case, you can view this information only. You cannot change the
information.

Figure 41. “Configure controller for clustering” window
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Part 4. Maintenance and troubleshooting
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Chapter 16. Obtaining ServeRAID updates

IBM periodically makes updated versions of the ServeRAID software available from
the IBM Support page on the World Wide Web.

Note: If you download ServeRAID software, you must download and install all
ServeRAID software at the same time. This will ensure that all levels of the
software are compatible. The ServeRAID software includes:
v Device drivers
v BIOS and firmware code
v ServeRAID Manager program
v Command-line programs

If you have already installed an operating system on your server, you should
update the device drivers before updating the BIOS and firmware code.

If you do not have access to the World Wide Web, contact your place of purchase,
your IBM reseller, or your IBM marketing representative for replacement CDs.

Downloadable files from the World Wide Web
You can download files for the IBM ServeRAID and Clustering products from the
IBM Support Web site:

http://www.ibm.com/pc/support/

To access ServeRAID and Clustering support, do the following:

1. From the Browse the support site list box, select Servers. The IBM xSeries,
Netfinity, and PC Server Support page opens.

2. From the Family list box, select ServeRAID or Clustering. The ServeRAID or
Clustering Support page opens.

3. Click one of the following options that appear in the left margin:

Downloadable files
Download the latest versions of Clustering software, the ServeRAID
Manager program, BIOS and firmware code, device-driver updates, and
other important information.

Hints and tips
Obtain useful information about IBM Clustering and ServeRAID
products, as well as tips for troubleshooting potential problems.

Online publications
Download the installation and user’s guides, references, white papers,
and other IBM publications.

4. From the . . . by Category list box, select RAID; a list of downloadable files
appears below the list box.
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Chapter 17. Updating the ServeRAID BIOS, firmware, and
software code for clustering

Use the following CD and diskette, together as a set, with the IBM ServeRAID
Cluster Solution:
v IBM ServeRAID Support CD
v The appropriate IBM ServeRAID Support diskette for your Windows operating

system

Ensure that the ServeRAID controllers have the latest IBM ServeRAID software
installed; you must have version 4.0, or later, at a minimum. For instructions on how
to determine the versions of the software on your ServeRAID controller, refer to the
documentation that was included with your server or your controller.

Note: If you are using the latest version of the IBM ServeRAID Support CD, the
BIOS and firmware code is automatically verified when you start the server
with the CD in the CD-ROM drive. If the BIOS and firmware code needs
updating, you will be prompted to do so.

You can obtain the latest ServeRAID software from the IBM Support Web site. See
“Downloadable files from the World Wide Web” on page 135 for additional
information.

When you update ServeRAID software, you must update all RAID software at the
same time. This will ensure that all levels of the software are compatible. The
ServeRAID software includes:
v Device drivers
v BIOS and firmware code
v Command-line programs
v ServeRAID Manager
v IBM ServeRAID Cluster Solution software

Note: If you have already installed an operating system on your server, you should
update the device drivers before updating the BIOS and firmware code.

Ensure that you are using a version of the ServeRAID software that has been
certified by Microsoft for Windows 2000 and Windows NT 4.0 compatibility, as noted
on the IBM Support Web site.

Note: If you are using Windows 2000, check the Windows 2000 Hardware
Compatibility List (HCL) included on the Windows 2000 Advanced Server CD
or the IBM ServerProven® List on the IBM Support Web site to determine if
your server devices are supported by the Windows 2000 operating system. If
not, contact the device manufacturer to receive a device driver for Windows
2000.
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Chapter 18. Upgrading a ServeRAID controller

This section contains instructions for upgrading a ServeRAID controller.

Upgrade from . . . Upgrade to . . .
ServeRAID-2 ServeRAID-3x ServeRAID-4x

ServeRAID-2 Yes Yes Yes
ServeRAID-3x No Yes Yes
ServeRAID-4x No No Yes

The above table displays possible upgrade scenarios. Backward compatibility is not
supported. In addition, you must usually upgrade to a controller with the same or
greater number of channels; upgrading to a controller with fewer number of
channels is possible only if the new controller contains as many or more channels
than those actually used on the original controller.

You must select a ServeRAID controller that meets the conditions outlined above.
After updating the device driver, BIOS and firmware code, and utility programs, you
can replace the older controller with the new controller and copy the configuration
from the physical drives.

Notes:

1. When upgrading an existing system, you must update the device driver before
flashing the controller with the new BIOS and firmware code.

2. This procedure assumes that you are replacing an existing ServeRAID controller
in a fully-functioning system.

Updating device drivers, BIOS and firmware code, and utility programs
To upgrade the device driver, BIOS and firmware code, and utility programs, do the
following:

1. Install the device driver for the new ServeRAID controller. Refer to the IBM
ServeRAID-4 Ultra160 SCSI Controller Device Driver Installation Instructions on
the IBM ServeRAID Support CD for more information.

2. Update the BIOS and firmware code for your existing ServeRAID controller,
using the IBM ServeRAID Support CD that came with the new controller. Refer
to “Updating BIOS and firmware code” on page 30 for more information.

3. If the IPSSEND command-line program is currently installed on the server,
upgrade to the latest version. Refer to “Installing the IPSSEND command-line
program” on page 63 for more information.

4. Upgrade or install the ServeRAID Manager program. Refer to “Installing the
ServeRAID Manager program” on page 87 for more information.

5. Ensure that the server is functioning properly before continuing to “Replacing
the old controller”.

Replacing the old controller
To replace the old controller, do the following:

1. Shut down the server.

2. Make note of which SCSI cables were attached to specific channels.

3. Remove any cables from the old controller; remove the controller.
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4. Insert the new controller into a PCI slot. If possible, use the PCI slot into which
the old controller was inserted.

5. Attach the SCSI cables to the new controller.

Note: If the new controller has the same number of channels as the old
controller, attach storage devices to the same channels as used
previously.

6. Insert the IBM ServeRAID Support CD into the server CD-ROM drive, and turn
on the server. The IBM ServeRAID ROM Update Wizard automatically starts.

If the BIOS and firmware code do not require updating, the wizard
automatically stops, and the ServeRAID Manager starts. Go to step 7.

If necessary, update the BIOS and firmware code for the new controller. Leave
the IBM ServeRAID Support CD in the CD-ROM drive; shut down and start the
server.

7. After the ServeRAID Manager program starts, click the new controller in the
left pane.

8. Click Actions → Restore to factory-default settings.

9. Click Actions → Copy configuration from drives.

10. Shut down the server, and remove the IBM ServeRAID Support CD from the
CD-ROM drive.

11. Restart the server.
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Chapter 19. Solving ServeRAID problems

This section describes the ServeRAID text and numeric messages that might be
displayed during startup. This section also includes some basic information about
rebuilding a defunct drive.

IBM ServeRAID Support CD warning message while starting
If you start a server with the IBM ServeRAID Support CD in the CD-ROM drive, the
following warning message might be displayed:
You passed an undefined mode number.
Press <RETURN> to see video modes available,
<SPACE> to continue or wait 30 secs

Press the Spacebar to continue starting the IBM ServeRAID Support CD. The
following message appears, and the CD starts:
Uncompressing Linux... Ok, booting the kernel.

ServeRAID controller messages
This section lists the ServeRAID messages that might appear during system
startup.

The ServeRAID controllers provide a Device Event Log that collects statistics on the
number and types of events that occur on a selected physical drive. After correcting
a problem with the disk array, clear the log so that you can identify any subsequent
errors quickly. For information about clearing the event log, see “eraseevent” on
page 79.

All physical drives contain unique identifiers, such as the drive serial number and
manufacturer. During configuration, the ServeRAID controller stores this information.

The following are the messages associated with the ServeRAID subsystem listed in
alphabetical order.

Message Explanation Action

A new drive was
installed.

When the ServeRAID controller detects
a new drive that is not part of the
current configuration, the following
message appears:

x new Ready drives found

where x is the number of ready drives
found.

This is an information message. No action is required.

Auto rearrange. Auto rearrange is enabled or disabled. This is an information message. No action is required.

Battery-backup
cache not
responding.

BIOS code detected a bad or failed
battery-backup cache.

Press F9 to remove the battery-backup cache from the
configuration, or press F10 to exit without change.

Battery-backup
cache
replacement.

The ServeRAID controller detects that
the battery-backup cache is defective.

If the battery-backup cache must be replaced, contact your
IBM service representative.

Press F8 if you replaced the battery-backup cache, or
press F10 if you have not replaced the battery-backup
cache.
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Message Explanation Action

Configured
drives are
missing.

When the ServeRAID controller detects
that a previously configured drive is
missing, the following message
appears:

x Online drive(s) not responding
or found at new location(s)

where x is the number of drives not
responding.

After pressing F2, a more detailed
message appears:

Online Drive on Channel x SCSI
ID y is not responding.

where x is the channel ID and y is the
SCSI ID.

Press one of the following keys:

F2 Detailed description. Press this key for a detailed
description of the problem.

F4 Retry. Press this key after correcting a problem.
For example, press F4 after you turn on the
external storage enclosure that contains the
physical drive.

F5 Change the configuration and set the drives to
defunct. Press this key to accept the new state
that the ServeRAID controller will assign to the
drive. For example, the ServeRAID controller will
assign the drive a state of defunct or empty.

You also can press F5 when you must remove a
drive. RAID level-1 and RAID level-5 logical
drives are present, and performance in a
degraded mode is acceptable. The ServeRAID
controller will assign the drive a state of defunct,
but the server can complete startup. However, the
array will remain in the critical state and the
potential for data loss will exist until you replace
and rebuild the defunct drive. To prevent the loss
of data, replace and rebuild the defunct drive in a
timely manner.
Note: A physical drive in the defunct state does
not necessarily mean that you need to replace
the drive. Before you replace the drive, ensure
that:

1. All cables are connected properly to the
backplane and to the physical drive. Also,
ensure that all cables inside the server are
connected properly.

2. The hot-swap drive trays are seated properly
in the drive bay.

3. If multiple drives fail in separate arrays (one
physical drive per array), replace each of the
defunct physical drives. If multiple physical
drives fail at the same time within the same
array, contact your IBM service
representative. See “Rebuilding a defunct
drive” on page 153 for more information.

After you perform these steps, if the physical
drive does not function properly, replace the drive.

F10 Continue starting without changing the
configuration. Press this key to continue without
change to the configuration.
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Message Explanation Action

Configured
drives are not in
the configured
location.

When the ServeRAID controller detects
that a previously configured drive is
present but the drive is in a new
location, the following message
appears:

x Online drive has been rearranged

where x is the number of drives that
have been rearranged.

After pressing F2, a more detailed
message appears:

Online Drive on Channel w SCSI
ID x moved to Channel y SCSI
ID z

where w and y are the channel
numbers, and x and z are the SCSI
IDs.

Press one of the following keys:

F2 Detailed description. Press this key for a detailed
description of the problem.

F4 Retry. Press this key after correcting a problem.
For example, press F4 after you move the
physical drive to its previously assigned location.

F5 Change the configuration and set the drive to
defunct. Press this key to accept the new state
that the ServeRAID controller will assign to the
drive. For example, the ServeRAID controller will
assign the drive a state of defunct or empty.
Note: A physical drive in the defunct state does
not necessarily mean that you need to replace
the drive. Before you replace the drive, ensure
that:

1. All cables are connected properly to the
backplane and to the physical drive. Also,
ensure that all cables inside the server are
connected properly.

2. The hot-swap drive trays are seated properly
in the drive bay.

3. If multiple drives fail in separate arrays (one
physical drive per array), replace each of the
defunct physical drives. If multiple physical
drives fail at the same time within the same
array, contact your IBM service
representative. See “Rebuilding a defunct
drive” on page 153 for more information.

After you perform these steps, if the physical
drive does not function properly, replace the drive.

F6 Change the configuration and accept the
rearrangement. Press this key to change the
configuration to match the current drive location.

You might remove the hot-swap drives from the
server for security or maintenance reasons. If you
replace the drives but install them in different
drive bays, you can press F6 to accept the new
locations, and the ServeRAID controller will
update the configuration.

F10 Continue startup without changing the
configuration. Press this key to continue without
change to the configuration.

Controller is not
responding to
commands. No
logical drives are
installed.

The ServeRAID controller is not
operational.

Contact your IBM service representative.

Error: Cannot
disable this
controller BIOS.

The ServeRAID controller was unable
to prevent an extra copy of its BIOS
code from being stored on the server.
This condition occurs when the server
contains multiple ServeRAID
controllers.

Contact your IBM service representative.
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Message Explanation Action

Installation
stopped.

The server cannot access the
ServeRAID controller.

This is a follow-on message to a preceding message.
Follow the Action instructions for the preceding message
to resolve the problem.

New controller
installed in a
configured server
or drives are
imported.

When the ServeRAID controller detects
that the identifiers of the drives do not
match the controller configuration
information, the following message
appears:

x Online drive(s) found with
incorrect configuration

where x is the number of drives found
with incorrect configuration.

After pressing F2, a more detailed
message appears:

Configuration mismatch Channel
x with Host ID y

where x is the channel number and y
is the Host ID.

Press one of the following keys:

F2 Detailed description. Press this key for a detailed
description of the problem.

F4 Retry. Press this key after correcting the problem.
For example, press F4 after you move the
physical drive to its previously assigned location,
or after you install the original physical drives
back in the server.

F5 Change the configuration and set the drive to
defunct. Press this key to accept the new state
that the ServeRAID controller will assign to the
drive. For example, the ServeRAID controller will
assign the drive a state of defunct or empty.
Note: A physical drive in the defunct state does
not necessarily mean that you need to replace
the drive. Before you replace the drive, ensure
that:

1. All cables are connected properly to the
backplane or system board and to the
physical drive. Also, ensure that all cables
inside the server are connected properly.

2. The hot-swap drive trays are seated properly
in the drive bay.

3. If multiple drives fail in separate arrays (one
physical drive per array), replace each of the
defunct physical drives. If multiple physical
drives fail at the same time within the same
array, contact your IBM service
representative. See “Rebuilding a defunct
drive” on page 153 for more information.

After you perform these steps, if the physical
drive does not function properly, replace the drive.
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Message Explanation Action

F7 Import configuration information from drive. Press
this key to restart the server. Press this key to
import the configuration information from the drive
and to update the configuration information for the
ServeRAID controller. This choice is useful when
you replace the ServeRAID controller in an
existing ServeRAID subsystem.

You also might press F7 if you replace a whole
set of drives with drives that were configured in
another server with a ServeRAID controller.
Note: When you install drives in a server that
has no logical drives defined, the F7 choice will
not appear. The ServeRAID controller does not
contain any logical drives in its factory
configuration. Therefore, F7 will not appear. In
this case, do the following:

1. Restart the server and press Ctrl+I to start the
Mini-Configuration program. (See “Chapter 7.
Using the ServeRAID Mini-Configuration
program” on page 59 for more information.)

2. Select Advanced Functions.

3. Select Copy the Configuration from Drives
to the Controller and follow the instructions
on the screen.

Recoverable
configuration
error.

The configuration data stored in
NVRAM does not match the
configuration data stored in the
EEPROM.

1. Press Ctrl+I to access the ServeRAID
Mini-Configuration menu. (See “Chapter 7. Using the
ServeRAID Mini-Configuration program” on page 59 for
more information.)

2. Select Advanced Functions from the main menu.

3. Select Copy the Configuration from Drives to the
Controller. (See “Using the advanced configuration
functions” on page 60 for more information.)

Unrecoverable
configuration
error.

The configuration data stored in
NVRAM does not match the
configuration data stored in the
EEPROM.

1. Press Ctrl+I to access the ServeRAID
Mini-Configuration menu. (See “Chapter 7. Using the
ServeRAID Mini-Configuration program” on page 59 for
more information.)

2. Select Advanced Functions from the main menu.

Attention: Restoring to factory-default settings sets
all online drives in an array to ready. You must import
the configuration from the drives or diskette.
Otherwise, you must create a new array and logical
drives. When you create new logical drives, they are
automatically initialized. All data is lost and you must
reinstall the operating system and data.

3. Select Restore to the Factory-Default Settings. (See
“Using the advanced configuration functions” on
page 60 for more information.)

WARNING: n
logical drives are
critical; n logical
drives are offline.

One or more physical drives have
failed.

Replace the defunct drives as soon as possible to prevent
data loss.

Chapter 19. Solving ServeRAID problems 145



Message Explanation Action

Your server has
an error due to a
Blocked Logical
Drive.

One or more logical drives are
blocked. A blocked logical drive cannot
be accessed. See “Logical-drive-state
descriptions” on page 26 and
“Rebuilding a defunct drive” on
page 153 for more information.

Press F4 to unblock the logical drive, or press F5 to
continue without unblocking.

ServeRAID startup (POST) messages
During power-on self-test (POST), the ServeRAID controller compares the stored
configuration information to the configuration that is actually present. If a
discrepancy exists, one or more status messages appear after POST is completed,
but before the operating system loads.

When you press F2 for detailed information, the following register information
appears on the screen:

ISPR displays the four-digit Interrupt Status Port Register code, BCS displays the
Basic Configuration Status Register code, and ECS displays the Extended
Configuration Status Register code.

If no errors occur:

ISPR = EF10 BCS = 0F or 09 ECS = 00

If an error occurs, refer to: “ISPR (Interrupt Status Port Register) codes” on
page 147 for the ISPR error codes and “Basic and Extended Configuration Status
register codes” on page 147 for the BCS and ECS error codes.

IBM ServeRAID BIOS
Copyright IBM Corp. 1995, 2001

BIOS Version: 4.10.05

Controller 1 Slot 4, Logical Drive=1, Firmware=4.00.20, Status=Fail
2 Drives(s) not responding or found at new location(s)

Press: F2 - Detailed information
F4 - Retry
F5 - Change the configuration and set drive(s) defunct
F10 - Continue booting without changing the configuration

Detailed information
----------------------------------------------------------------------

Online Drive on Channel 2 SCSI ID 0 is not responding
Online Drive on Channel 2 SCSI ID 1 is not responding

----------------------------------------------------------------------
Controller Status Codes: ISPR = EF10 BCS = 07 ECS = 08

Press PgUp = Page Up PgDn = Page Down Esc = Exit panel
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ServeRAID ISPR, BCS, and ECS POST error codes
Notes:

1. When the ServeRAID controller requires your input, a list of function keys will be
displayed below the message.

2. Where the Action information tells you to start the IBM ServeRAID configuration
program, insert the IBM ServeRAID Support CD into the CD-ROM drive; then,
restart the server. The Action column also provides general information about
the message.

3. Where sid or ch appears in these messages, sid is the SCSI ID for the device,
and ch is the channel to which the device is attached.

4. Where m or n appears in these messages, a number appears in the actual
message.

ISPR (Interrupt Status Port Register) codes

Code Explanation Action

1xxx to
7xxx

The POST detected an internal error. Contact your IBM service
representative.

2601 to
260B

The POST detected an error with the
ServeRAID subsystem.

Contact your IBM service
representative.

2610 The POST detected an error with the
ServeRAID controller hardware.

Contact your IBM service
representative.

2620 The POST detected that a ServeRAID
configuration or hard disk error
occurred.

Start the IBM ServeRAID Support CD
and view the existing device and
configuration information for your
ServeRAID subsystem. If you cannot
locate and correct the configuration
problem or the failing device, or if the
problem persists, contact your IBM
service representative.

8xxx to
Bxxx

The POST detected an error with the
SCSI interface.

Verify that the SCSI cables are correctly
connected and the SCSI termination is
set properly for each installed SCSI
device.

If you cannot locate and correct the
SCSI problem, or if the problem
persists, contact your IBM service
representative.

Basic and Extended Configuration Status register codes

BCS ECS Explanation Action

Code
not in
table

Code
not in
table

The ServeRAID controller is not functioning
properly.

Contact your IBM service representative.

00 01 Invalid flash configuration. Start the IBM ServeRAID Support CD and follow
the instructions that appear on the screen.

If no instructions appear or if the problem persists,
contact your IBM service representative.

00 02 Invalid NVRAM configuration.

00 03 Invalid flash and NVRAM configuration.

Chapter 19. Solving ServeRAID problems 147



BCS ECS Explanation Action

01 08 No configuration was found in drives, or the
online/rebuild drives are not responding.

To correct the problem:

1. If the controller is connected to an enclosure,
verify that the enclosure is on. If the enclosure
is off, turn on the power and press F4 to retry.

2. Verify that all the physical drives are present. If
any drives are missing, replace the drives and
press F4 to retry.

3. Verify that all the physical drives are connected
to the controller correctly. If any drives are
unconnected, connect the drives and press F4
to retry.

4. If all the physical drives are present and
connected correctly, one or more of the drives
might be defective. Identify and replace the
defective drives; then, press F5 to accept the
changes.

5. If you have intentionally switched physical
drives that are connected to this controller,
press F7 to import the configuration from the
drives and account for the drive rearrangement.

To exit without making changes, press F10.

01 18 No configuration was found in drives, or the
online/rebuild and hot spare/standby hot-spare
drives are not responding.

01 28 No configuration was found in drives, or the
online/rebuild and ready/standby drives are not
responding.

01 38 No configuration was found in drives, or the
online/rebuild, hot spare/standby hot-spare, and
ready/standby drives are not responding.

01 48 No configuration was found in drives, or the
online/rebuild drives are not responding and
unidentified drives were found.

01 58 No configuration was found in drives, or the
online/rebuild and hot spare/standby hot-spare
drives are not responding and unidentified
drives were found.

01 68 No configuration was found in drives, or the
online/rebuild and ready/standby drives are not
responding and unidentified drives were found.

01 78 No configuration was found in drives, or the
online/rebuild, hot spare/standby hot-spare, and
ready/standby drives are not responding and
unidentified drives were found.
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BCS ECS Explanation Action

03 88 A drive was imported from another server and it
has a valid configuration, and the online/rebuild
drives are not responding.

To correct the problem:

1. To keep the previous configuration in the
controller, replace the physical drives that were
switched and press F4 to retry.

Attention: Completing step 2 might result in a
loss of the original configuration and data on
the drives.

2. To accept the new configuration from the
physical drives, press F7.

3. If all the physical drives are present and
connected correctly, one or more of the drives
might be defective. Identify and replace the
defective drives; then, press F5 to accept the
changes.

To exit without making changes, press F10.

03 98 A drive was imported from another server and it
has a valid configuration, and the online/rebuild
and hot spare/standby hot-spare drives are not
responding.

03 A8 A drive was imported from another server and it
has a valid configuration, and the online/rebuild
and ready/standby drives are not responding.

03 B8 A drive was imported from another server and it
has a valid configuration, and the online/rebuild,
hot spare/standby hot-spare, and ready/standby
drives are not responding.

03 C8 A drive was imported from another server and it
has a valid configuration, and the online/rebuild
drives are not responding and unidentified
drives were found.

03 D8 A drive was imported from another server and it
has a valid configuration, and the online/rebuild
and hot spare/standby hot-spare drives are not
responding and unidentified drives were found.

03 E8 A drive was imported from another server and it
has a valid configuration, and the online/rebuild
and ready/standby drives are not responding
and unidentified drives were found.

03 F8 A drive was imported from another server and it
has a valid configuration, and the online/rebuild,
hot spare/standby hot-spare, and ready/standby
drives are not responding and unidentified
drives were found.

07 00 The specified drive is not responding. To correct the problem:

1. If the specified physical drive or drives are in an
external enclosure, verify that the enclosure is
turned on. If the enclosure is turned off, turn on
the power and press F4 to retry.

2. Download and install the latest version of IBM
ServeRAID software. See “Chapter 16.
Obtaining ServeRAID updates” on page 135 for
more information.

3. Replace the failed physical drive or drives.

07 08 The specified drives are not responding.
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BCS ECS Explanation Action

07 0C Online/rebuild drives are not responding, and a
drive was found at the incorrect SCSI ID.

To correct the problem:

1. To keep the previous configuration in the
controller, replace the physical drives and cable
connections that were switched or moved; then,
press F4 to retry.
Note: Pressing F4 might not correct the
problem. If you do not return the drives and
cables to the previous configuration, the
message might return.

2. If all the physical drives are present and
connected correctly, one or more of the drives
might be defective. Identify and replace the
defective drives; then, press F5 to accept the
changes.

3. To modify the configuration and accept the
rearrangement of the physical drives, press F6.

To exit without making changes, press F10.

07 1C Online/rebuild and hot spare/standby hot-spare
drives are not responding, and a drive was
found at the incorrect SCSI ID.

07 2C Online/rebuild and ready/standby drives are not
responding, and a drive was found at the
incorrect SCSI ID.

07 3C Online/rebuild, ready/standby, and hot
spare/standby hot-spare drives are not
responding, and a drive was found at the
incorrect SCSI ID.

07 4C Online/rebuild drives are not responding, and a
drive was found at the incorrect SCSI ID, and
unidentified drives were found.

07 5C Online/rebuild and hot spare/standby hot-spare
drives are not responding, a drive was found at
the incorrect SCSI ID, and unidentified drives
were found.

07 6C Online/rebuild and ready/standby drives are not
responding, a drive was found at the incorrect
SCSI ID, and unidentified drives were found.

07 7C Online/rebuild, ready/standby, and hot
spare/standby hot-spare drives are not
responding, a drive was found at the incorrect
SCSI ID, and unidentified drives were found.

07 18 Online/rebuild and hot spare/standby hot-spare
drives are not responding.

To correct the problem:

1. To keep the previous configuration in the
controller, replace the physical drives and cable
connections that were switched or moved; then,
press F4 to retry.

2. If all the physical drives are present and
connected correctly, one or more of the drives
might be defective. Identify and replace the
defective drives; then, press F5 to accept the
changes.

To exit without making changes, press F10.

07 28 Online/rebuild and ready/standby drives are not
responding.

07 38 Online/rebuild, ready/standby, and hot
spare/standby hot-spare drives are not
responding.

07 48 Online/rebuild drives are not responding, and
unidentified drives were found.

07 58 Online/rebuild and hot spare/standby hot-spare
drives are not responding, and unidentified
drives were found.

07 68 Online/rebuild and ready/standby drives are not
responding, and unidentified drives were found.

07 78 Online/rebuild, ready/standby, and hot
spare/standby hot-spare drives are not
responding, and unidentified drives were found.

09 00 No error occurred. No action is required. Press F10 to exit without
making any changes.
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BCS ECS Explanation Action

09 10 Hot spare/standby hot-spare drives are not
responding.

To correct the problem:

1. To keep the previous configuration in the
controller, replace the physical drives and cable
connections that were switched or moved; then,
press F4 to retry.

2. If all the physical drives are present and
connected correctly, one or more of the drives
might be defective. Identify and replace the
defective drives; then, press F5 to accept the
changes.

To exit without making changes, press F10.

09 20 Ready/standby drives are not responding.

09 30 Hot spare/standby hot-spare and ready/standby
drives are not responding.

0F 00 No error occurred. No action is required. Press F10 to exit without
making any changes.

0F 10 Hot spare/standby hot-spare drives are not
responding.

To correct the problem:

1. To keep the previous configuration in the
controller, replace the physical drives and cable
connections that were switched or moved; then,
press F4 to retry.

2. If all the physical drives are present and
connected correctly, one or more of the drives
might be defective. Identify and replace the
defective drives; then, press F5 to accept the
changes.

To exit without making changes, press F10.

0F 20 Ready/standby drives are not responding.

0F 30 Hot spare/standby hot-spare and ready/standby
drives are not responding.

Recovering from problems starting the ServeRAID Manager

Problem Explanation Action

The ServeRAID Manager program
hangs on the splash screen.

You might be using an old
version of the ServeRAID
device driver.

Upgrade the ServeRAID device driver to the
latest version. See “Chapter 5. Installing
ServeRAID device drivers” on page 43 for
more information.

When starting the ServeRAID Manager,
the following error message is
displayed:

Unable to find load file RAIDMAN

The ServeRAID Manager
program was not installed to
the root directory of the SYS
volume.

Reinstall the ServeRAID Manager. If the
installation is completed properly, there will be
a directory called RAIDMAN under the root
directory of the SYS volume.

When starting the ServeRAID Manager,
the following error message is
displayed:

-autounload is an invalid parameter

You are using an old version
of the Novell Java Virtual
machine (JVM).

Download and install the latest JVM from the
Novell Web site:
http://developer.novell.com/ndk/download.htm

When starting the ServeRAID Manager,
the following error message is
displayed:

ERROR: Unable to find Java

The Novell Java Virtual
machine (JVM) is not
installed on your server.

Download and install the latest JVM from the
Novell Web site:
http://developer.novell.com/ndk/download.htm
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Problem Explanation Action

The ServeRAID Manager program fails
to start, and the following error
message is displayed:

Can't find class
com.ibm.sysmgt.raidmgr.mgtGUI.
Launch

Your TCP/IP hosts file is not
configured for the local
server hostname.

Configure your TCP/IP hosts file for the local
server hostname.

1. Open the /etc/hosts file.

2. If TCP/IP networking is configured, do the
following:

a. If the hostname of the server is
identified on the line starting with
127.0.0.1, remove the hostname from
this line.

b. On a new line, type the IP address of
the server.

c. Press the Tab key to the second
column and type the fully qualified
hostname.

d. Press the Tab key to the third column
and type the nickname for the server.
Note: The following is an example of a
completed line:

1.1.1.1 matrix.localdomain matrix

where 1.1.1.1 is the IP address of the
server and matrix is the hostname of
the server.

3. If TCP/IP networking is not configured,
type the server name in the third column of
the line that starts with 127.0.0.1.
Note: The following is an example of a
completed line:

127.0.0.1 localhost matrix

where matrix is the server name.

4. Restart the server for these changes to
take effect.

Recovering from an incomplete format of a physical drive
During formatting of a physical drive, if the format process is stopped by a system
reset, system shutdown, power outage, or by some other means, the physical drive
becomes inoperable.

To enable the physical drive to communicate with the ServeRAID controller again,
do the following:

1. Note the channel of the ServeRAID controller to which the physical drive is
connected.

2. Note the SCSI ID of the physical drive.

3. Use the ipssend format function to restart the format of the physical drive. The
syntax is: ipssend format controller channel sid

where:
v controller is the ServeRAID controller number (1–12)
v channel is the channel number for the device (1–4)
v sid is the SCSI ID for the device (0–15)
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After the format process is complete, the ServeRAID controller will be able to
recognize the drive again.

Rebuilding a defunct drive
A physical drive is marked defunct when there is a loss of communication between
the controller and the physical drive. This can be caused by any of the following:

v An improperly connected cable, physical drive, or controller

v Loss of power to a drive

v An improperly assembled SCSI channel in an unsupported configuration

v A defective cable, backplane, physical drive, or controller

v Connecting unsupported SCSI devices (such as tape drives or CD-ROM drives)
to the same SCSI channel used for an array

In each case, after the communication problem is resolved, a rebuild operation is
required to reconstruct the data for the device in its disk array. The ServeRAID
controllers can reconstruct RAID level-1 and RAID level-5 logical drives. They
cannot, however, reconstruct data stored in RAID level-0 logical drives because
RAID level-0 is not redundant. If an array contains only RAID level-0 logical drives,
the logical drives in the array are marked offline and the logical drives contain
damaged data. You cannot rebuild the logical drives. You must correct the cause of
the failure or replace the physical drives; then, you must restore your data.

To prevent data-integrity problems, the ServeRAID controllers set the RAID level-0
logical drives in the affected array to blocked during the rebuild operation for RAID
level-1 or RAID level-5. After the rebuild operation is completed, you can unblock
the RAID level-0 logical drives and access them once again. Remember, however,
that the RAID level-0 logical drives contain damaged data.

Note: For logical drives in an IBM ServeRAID Cluster Solution:

v Because shared logical drives can have only one logical drive for each
array, blocking a RAID level-0 logical drive during a rebuild operation does
not apply to shared logical drives.

v Because non-shared logical drives can have more than one logical drive
for each array, blocking a RAID level-0 logical drive during a rebuild
operation does apply to non-shared logical drives.

Recovering from defunct drives
If multiple physical drives fail at the same time in the same array, or if the defunct
drives are not part of an array, contact your IBM service representative.

If a physical drive fails in an array or multiple physical drives fail in separate arrays
(one physical drive per array), do the following:

1. Replace each defunct physical drive. The ServeRAID controller starts the
rebuild operation when it detects the removal and reinsertion of a drive that is
part of an array.

2. If a rebuild operation is in progress, wait until the rebuild is complete. Otherwise,
go to step 3.

Note: If you are replacing multiple defunct drives, you must wait for each
rebuild operation to complete before starting subsequent rebuild
operations.

3. Verify the cables, physical drives, and controllers are installed properly.
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4. Attempt to rebuild the defunct physical drive by performing a hot-swap rebuild.
Refer to “Rebuilding a hot-swap drive” for instructions.

5. If the hot-swap rebuild fails, contact your IBM service representative.

Rebuilding a hot-swap drive
A hot-swap rebuild refers to a rebuild operation that is started by the ServeRAID
controller when it detects that a drive that is part of an array and in the defunct
state has been removed and reinserted on the SCSI cable or backplane. The
reinsertion of the physical drive, whether it is the same drive or a new drive, will
trigger the ServeRAID controller to start the rebuild operation. During the rebuild
operation, the drive being rebuilt is in the rebuild state, and the logical drive remains
critical until the rebuild operation has been successfully completed.

On IBM servers, when a hot-spare drive is available, the rebuild operation begins
automatically without the need to replace the failed drive. If more than one drive
fails within the same array, no rebuild takes place. If multiple drives fail in separate
arrays (one physical drive per array), the controller initiates a rebuild operation for
the logical drives within the array containing the first failed physical drive. This
rebuild operation is performed on the first hot-spare drive of sufficient size to
become a valid member of the array.

To start a hot-swap rebuild, do the following:

1. Without removing the drive completely, gently remove the physical drive from
the server, using the handle of the hot-swap tray. If necessary, refer to the
documentation that comes with your server for information about removing a
physical drive.

Attention

When power is removed from a hot-swap drive, the drive immediately parks the heads,
locks the actuator in the “landing zone,” and begins spinning down. However, the spinning
down of the disk might require up to 20 seconds after power is removed. Do not move the
drive while it is spinning down. Moving the drive while it is spinning down might damage the
drive.

2. Wait 20 seconds to allow the physical drive to completely stop spinning.

3. If you are certain there is nothing wrong with the physical drive you removed,
gently reinstall the drive into the server. Make sure the drive is completely
installed in the backplane connector.

Otherwise, replace the physical drive with a new drive that is the same size (or
larger) and continue with the rebuild operation.

Notes:

a. If multiple drives fail in separate arrays (one physical drive per array),
replace each defunct physical drive. If multiple physical drives fail at the
same time within the same array, contact your IBM service representative.

b. Although it is possible to rebuild a defunct physical drive to an online
physical drive that is defective, avoid doing so.
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Solving problems in a failover environment
Use these procedures to recover from problems in a failover environment. If you still
have problems after following these procedures, contact your IBM service
representative for further information. Also, you can find hints and tips to help you
solve problems on the IBM Support Web site. See “Downloadable files from the
World Wide Web” on page 135 for additional information.

Recovering from a failure in a failover environment
In a failover environment, when the ServeRAID device driver is unable to send a
command to the active controller and the active controller does not respond to a
reset command, the device driver attempts to failover to the passive controller.

Note: Loose cables or defective physical drives will not cause a failover to occur.

Replacing a controller of a failover pair in a non-hot-plug PCI
slot

Important

Before replacing the failed controller, ensure that you have the latest device drivers, BIOS,
and firmware code installed in your server. Follow the instructions in “Updating device
drivers, BIOS and firmware code, and utility programs” on page 139.

If a failed controller is not in a hot-plug PCI slot, do the following:

1. Shut down the server.

2. Replace the failed controller.

Note: Do not attach the SCSI cables to the new controller.

3. Insert the IBM ServeRAID Support CD (or the configuration CD that was
included with your server) into the CD-ROM drive; then, turn on the server.
The ServeRAID Manager program starts.

4. Select the controller that you just inserted, and click Actions → Restore to
factory-default settings.

5. If a confirmation window opens, click Yes. When the operation is complete, a
message appears at the bottom of the window indicating that the ServeRAID
Manager has successfully restored the configuration to the factory-default
settings.

6. Configure the new controller for failover. Click (Configure for
clustering) on the toolbar. The “Configure controller for clustering” window
opens.
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7. Type the controller name, partner name, and SCSI initiator IDs that you used
for the controller you are replacing.

8. Click OK.

9. Shut down the server.

Important

When connecting the cables, you must connect the same channel connectors on both
ServeRAID controllers to the enclosure. For example, if you connect the cable from
Channel 1 on the first ServeRAID controller to the enclosure, you must connect the cable
from Channel 1 on the second ServeRAID controller to the enclosure.

10. Reconnect the enclosure to the new ServeRAID controller.

11. Remove the IBM ServeRAID Support CD (or the configuration CD that was
included with your server) from the CD-ROM drive; then, turn on the server.

12. Start the ServeRAID Manager program that is installed on the server; then,
confirm that the ServeRAID controllers are correctly configured for failover (see
Figure 26 on page 55).

Replacing a controller of a failover pair in a hot-plug PCI slot
If the failed controller is in a hot-plug slot, refer to the documentation that comes
with the server for instructions for replacing the controller.

Note: Windows 2000 does not support the hot-replace feature. Refer to “Replacing
a controller of a failover pair in a non-hot-plug PCI slot” on page 155.

For Windows NT 4.0, use the following software to replace the controller. Follow the
on-screen directions:

v IBM Netfinity PCI Hot Plug for Windows NT 4.0 Package, version 4.1 or later

v (For the ServeRAID-4M, ServeRAID-4Mx, ServeRAID-4L, and ServeRAID-4Lx
controllers only) IBM PCI Hot Plug Adapter Update, version 1.0, for the IBM
Netfinity PCI Hot Plug for Windows NT 4.0

v IBM ServeRAID Manager program

v IBM ServeRAID Hot Replace Wizard

Recovering from a power failure during a failover
If a power failure occurs during a failover, the two controllers in the active-passive
pair might have the following problems:
v Some logical drives are configured on one controller and some logical drives are

configured on the other controller.

Figure 42. “Configure controller for clustering” window
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v A logical drive does not appear on either controller.

To recover from a power failure, do the following:

1. Run ipssend merge for every merge-group number configured on the active
controller.

Note: If ipssend merge fails, run ipssend merge partner for every
merge-group number configured on the active controller.

2. Run ipssend unmerge for every merge-group number configured on the
passive controller.

3. Shut down and restart the server. Windows 2000 and Windows NT 4.0 pairs the
controllers again.

Troubleshooting an IBM ServeRAID Cluster Solution
There is the possibility that one of the servers, one of the ServeRAID controllers, or
one of the hard disk drives in a cluster might fail. This section presents procedures
you can take to recover from these potential problems. If you still have problems
after following these procedures, contact your IBM service representative for further
information. Also, you can find hints and tips to help you solve problems on the IBM
Support Web site. See “Downloadable files from the World Wide Web” on page 135
for additional information.

Recovering from a failed ServeRAID server
When replacing a failed server in a high-availability configuration, you might not
need to replace the ServeRAID controller. However, if you replace your ServeRAID
controller, you must reconfigure the controller after installing your new server.

Important

The following procedure requires specific configuration settings for the ServeRAID
controller. If the server and controller that are being replaced are functional, you can obtain
these settings from the controller. However, if the controller or the server is not functional,
you will need a record of the settings, such as one created when the controller was
previously configured. If you are replacing your ServeRAID controller at the same time as
your server, you must have correct configuration information to complete this procedure.

To recover from a failed server, do the following:

1. Shut down the failed server.

2. Remove all local physical drives from the failed server.

As you remove your physical drives, be sure to note the bay in which each drive
was installed. If you are replacing your failed server with an identical server, you
can reinstall the drives in an identical configuration and get your server up and
running quickly.

3. If the ServeRAID controller is functional, remove it from the failed server. As you
remove the controller from the failed server, be sure to note the following:
v Which SCSI cables are connected to the SCSI channel connectors on the

controller
v Which PCI slot has the controller installed

4. Install all the local physical drives into the new server, using the location
information you recorded in step 2.
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For information on how to install a physical drive, see the documentation that
comes with your server. If you are replacing the failed server with an identical
server, install each physical drive in the same bay as the one it was removed
from in the failed server.

5. If the ServeRAID controller in the failed server is not functional, or if you are not
sure, continue with “Recovering from a failed ServeRAID controller”. Otherwise,
perform the following steps with the functional ServeRAID controller:
a. Install the controller in the new server.
b. Reinstall the cables as they were in the failed server.
c. Start the server.

Recovering from a failed ServeRAID controller
You must have the following configuration information to configure your new
ServeRAID controller:
v SCSI initiator IDs

The SCSI initiator IDs for a non-shared SCSI channel are set to 7. For shared
SCSI channels, the SCSI initiator IDs must be 7 or 6; they must be different from
the SCSI initiator IDs for the corresponding SCSI channels of the cluster partner
controller. Therefore, if you can obtain the SCSI initiator IDs for the
corresponding cluster partner system, you know the correct SCSI initiator IDs for
this system. For example, if the cluster partner system-shared SCSI initiator IDs
were set to 7, the controller you are replacing would need to have its SCSI
initiator IDs set to 6.

v Controller and partner name

You can also determine the names for the controller being replaced by reading
the settings from the cluster partner system.

v Stripe-unit size

The stripe-unit size must be the same on both controllers in a high-availability
cluster.

v Unattended mode setting

This setting is configured automatically as Enabled when a controller is set up for
clustering.

If the ServeRAID controller you are replacing is functional, you can obtain the
above configuration information by starting your server with the IBM ServeRAID
Support CD in the CD-ROM drive and using the ServeRAID Manager program.

Note: The configuration information is also available in the printable configuration
file you might have saved when configuring the ServeRAID controllers for
clustering.

If the ServeRAID controller is not functional, you will need to refer to a record of the
settings that was made when the controller was previously configured. If you do not
have a record of the configuration information, refer to “Obtaining the current
configuration information” for information that might help you to assign the proper
values.

Obtaining the current configuration information
To obtain the SCSI initiator IDs, controller name, partner name, and stripe-unit size
from the corresponding cluster partner controller, do the following:

1. Click Start → ServeRAID Manager.

or
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Start the cluster partner system with the IBM ServeRAID Support CD in the
CD-ROM drive. The ServeRAID Manager program starts.

2. In the ServeRAID Manager tree, click the cluster partner controller.

3. Click (Configure for clustering) on the toolbar. The “Configure
controller for clustering” window opens.

4. Note the settings in the fields.

5. To determine stripe-unit size, refer to the information displayed in the right pane
of ServeRAID Manager.

Replacing a ServeRAID controller
To replace a failed ServeRAID controller in your high-availability configuration, do
the following:

1. Shut down the server.

2. Note which SCSI cables are connected to the SCSI channel connectors on the
controller.

3. Note which PCI slot has the controller installed.

4. Remove the failed ServeRAID controller.

For instructions on how to remove and install the ServeRAID controller, see
“Chapter 2. Installing and cabling a ServeRAID controller” on page 9.

5. Install the new ServeRAID controller. Be sure to install the controller in the
same PCI slot from which you removed the failed ServeRAID controller.

Important
v Do not reconnect the SCSI channel cables to the controller at this time.
v You must ensure that you have the same level of ServeRAID BIOS and firmware on both

controllers in the cluster.

The software is available on the IBM Support Web site. See “Chapter 16. Obtaining
ServeRAID updates” on page 135 for additional information.

6. Start the system with the IBM ServeRAID Support CD (version 4.0, or later) in
the CD-ROM drive. The ServeRAID Manager program starts.

7. In the ServeRAID Manager tree, click the new controller.

Figure 43. “Configure controller for clustering” window
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8. Click Actions → Restore to factory-default settings. The ServeRAID
Manager program initializes the controller configuration.

9. With the new controller still selected in the tree, click (Configure for
clustering) on the toolbar. The “Configure controller for clustering” window
opens.

10. Using the settings that were assigned to the previous ServeRAID controller
(that is, the controller you are replacing), complete each of the following fields:
v SCSI initiator IDs
v Controller name
v Partner name

11. Click OK. The new controller stripe-unit size setting defaults to 8 KB. If you
need to change this setting to match the partner controller, go to step 12.
Otherwise, go to step 15.

12. In the ServeRAID Manager tree, click the new controller.

13. Click Actions → Change stripe-unit size.

14. Click the new stripe-unit size for your installation.

15. Shut down and turn off the server.

16. Reconnect the SCSI channel cables to the controller.

Note: Be sure to connect the cables to the correct SCSI channels as noted in
step 2 on page 159.

17. If the ServeRAID controller being replaced is attached to the server startup
disk array or other non-shared disk arrays, start the system with the IBM
ServeRAID Support CD (version 4.0, or later) in the CD-ROM drive. The
ServeRAID Manager program starts.

If the ServeRAID controller being replaced is not attached to any of these
items, go to step 21.

18. In the ServeRAID Manager tree, click the new controller.

19. Click Actions → Copy configuration from drives.

20. Click the merge-group number for the non-shared logical drives (that is, 206 or
207).

Note: The last number in the merge-group number is the shared SCSI initiator
ID. That is, if the merge-group number is 206, the SCSI initiator ID is 6.

21. Remove the IBM ServeRAID Support CD from the CD-ROM drive.

Figure 44. “Configure controller for clustering” window
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22. Restart your server.

Note: If the controller you replaced is the startup controller, the system will
now start the operating system properly.

Recovering from a failover in a Microsoft Cluster Service server
After a failover occurs in a Microsoft Cluster Services server, the red drive lights in
external expansion enclosures might turn on for physical drives that are online.
There is no hardware problem; the lights turn off within an hour.

Recovering from a failed server in a ServeRAID cluster
Contact IBM technical support for assistance.

Chapter 19. Solving ServeRAID problems 161



Troubleshooting ServeRAID subsystems in a cluster environment
Following is a series of common problems and solutions that can help you
troubleshoot your IBM ServeRAID Cluster Solution.

Problem Action

The ServeRAID Manager program shows
physical drives in defunct state.

1. Enable the View shared drives feature in the ServeRAID
Manager program. Doing so will display a drive as reserved,
instead of defunct, in the following situations:
v A drive has been moved.
v A drive has failed-over to the other server in the cluster.

Note: It is normal for drives in the above situations to be
displayed as defunct if you have not enabled the View shared
drives feature. In this case, the drives shown in the defunct state
are not really defective.

2. Check RAID level-1 and RAID level-5 arrays to make sure they
are not in critical state. If they are in critical state, replace the
failed drive and perform a rebuild operation.

ServeRAID shared logical drives do not
failover properly.

1. Ensure that the resource type of each ServeRAID controller
shared disk resource is IBM ServeRAID logical disk.

If the resource type is shown as “physical drive,” the localquorum
option was not specified properly when MSCS under Windows
NT 4.0 was installed.

To correct this problem, you must reinstall the high-availability
cluster solution using Microsoft Windows NT.

2. Ensure that shared SCSI buses on the ServeRAID controller pair
are connected in the same way that corresponding SCSI
channels are connected. For example, SCSI channel 1 on the
controller in the first cluster server is connected to SCSI channel
1 on the controller in the second cluster server, channel 2 is
connected to channel 2, and so forth.

3. Ensure that the physical SCSI drives that contain logical drives
are all connected to shared SCSI channels.

4. Ensure that there are no more than eight shared logical drives
defined per pair of ServeRAID controllers.

5. Make sure each shared logical drive has a unique merge-group
number assigned. Shared merge-group numbers must be in the
range 1–8.

6. Make sure each ServeRAID controller has been assigned a
unique controller name and that each ServeRAID controller has
its partner name assigned properly to correspond to the
ServeRAID controller in the other cluster server that is attached
to the shared SCSI buses.

7. Check for loose shared SCSI bus cables.

8. Ensure that the physical drives that are expected to be moved or
to failover show up in a ready or reserved state on the server that
is attempting to take control of these drives.
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Problem Action

RAID level-5 logical drives cannot be
accessed by the operating system after a
failover.

Use the ServeRAID Manager program to check the state of the
logical drive to ensure that it is not blocked. Using this program,
select the logical drive and look for Blocked state Yes. If the logical
drive is blocked, make sure all physical drives that are part of the
logical drive are in the online state. If all physical drives are not in the
online state, a drive might have failed during one of the following
situations:
v A failover
v A resynchronization process after a failover

Data integrity cannot be guaranteed in this case and the logical drive
has been blocked to prevent the possibility of incorrect data being
read from the logical drive.

Unblock, reinitialize, and synchronize the logical drive and restore the
data from a backup source. Depending on the type of data contained
on the logical drive and the availability of a recent backup copy, you
can do one of the following:
v Unblock the drive and continue normal operation.
v Replace and rebuild one or more defunct drives.

However, if you do not reinitialize, synchronize, and restore the drive,
be aware that some data could be lost or damaged.

If one of the cluster servers fails and the
surviving server takes over the cluster
resources, occasionally one or more of the IP
address resources will stay in the online
pending state for several minutes after they
are moved over to the surviving server. After
this, the resource will go to the failed state,
and the following error message will be
displayed in the surviving server system log
(as viewed with the Event viewer).

For example, the Windows NT Event Log
Message:

Date: ??? Event ID: 1069
Time: ??? Source: ClusSvc
User: N/A Type: Error
Computer: ??? Category: (4)

Description:

Cluster resource 'ip address resource
name' failed

Do the following:

1. Right-click the IP resource in the Cluster Administrator.

2. From the General page, click Properties.

3. Select Run this resource in a separate Resource Monitor
check box. A message appears stating that the resource must be
restarted for the change to take effect.

Note: Placing IPSHA disk resources into their own Resource Monitor
can decrease failover time.
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Problem Action

After one of the cluster servers has been shut
down normally and the surviving server takes
over the cluster resources, occasionally one
or more of the IBM ServeRAID logical drive
resources will stay in the online-pending state
for several minutes, after they are moved over
to the surviving server (when viewed with the
Cluster Administrator). After this, the resource
will go to the Failed state and the following
error message will be displayed in the
surviving server system log (as viewed with
the Event viewer).

For example, the Windows NT Event Log
Message:

Date: ??? Event ID: 1069
Time: ??? Source: ClusSvc
User: N/A Type: Error
Computer: ??? Category: (4)

Description:

Cluster resource 'IBM ServeRAID Logical
Disk name' failed.

No action is necessary to bring the resource online after the failover.
MSCS will bring this resource online on the surviving server within
approximately 4 minutes.

If a previous version of IBM ServeRAID
Cluster Solution has been uninstalled, a
message is incorrectly displayed prompting
you to perform an upgrade when you attempt
to reinstall the ServeRAID Windows NT
Cluster Solution.

You must delete the C3E76E53-F841-11D0-BFA1-08005AB8ED05
registry key. To delete the registry key, do the following:

1. From the Start menu, click Run.

2. Type: REGEDIT and click OK. The Registry Editor window opens.

3. Select HKEY_CLASSES_ROOT\CLSID and delete
C3E76E53-F841-11D0-BFA1-08005AB8ED05.

4. Reinstall the ServeRAID Windows NT Cluster Solution. Refer to
“Chapter 13. Configuring ServeRAID controllers for clustering” on
page 105 for instructions.

Array identifiers and logical drive numbers
might change during a failover condition.

By design, the array identifiers and logical drive numbers might
change during a failover condition. Consistency between the
merge-group numbers and Windows NT or Windows 2000
permanent (sticky) drive letters is maintained, while the ordering
process during a failover condition is controlled by the Microsoft
Cluster Service software and the available array identifiers on the
surviving server.
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Chapter 20. Getting information, help, and service

If you need help, service, or technical assistance or just want more information
about IBM products, you will find a wide variety of sources available from IBM to
assist you. This section contains information about where to go for additional
information about IBM and IBM products, what to do if you experience a problem
with your computer, and whom to call for service should it be necessary.

Getting information
Information about your IBM server product and preinstalled software, if any, is
available in the documentation that comes with your server. That documentation
includes printed books, online books, README files, and help files. In addition,
information about IBM products is available on the World Wide Web and through
the IBM Automated Fax System.

Using the World Wide Web
On the World Wide Web, the IBM Web site has up-to-date information about IBM
products and support. The address for the IBM Personal Computing home page is
http://www.ibm.com/pc/.

You can find support information for your IBM products at
http://www.ibm.com/pc/support/.

If you click Profile from the support page, you can create a customized support
page that is specific to your hardware, complete with Frequently Asked Questions,
Parts Information, Technical Hints and Tips, and Downloadable Files. In addition,
you can choose to receive e-mail notifications whenever new information becomes
available about your registered products.

You also can order publications through the IBM Publications Ordering System at
http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi.

Getting information by fax
If you have a touch-tone telephone and access to a fax machine, in the U.S. and
Canada, you can receive, by fax, marketing and technical information on many
topics, including hardware, operating systems, and local area networks (LANs).

You can call the IBM Automated Fax System 24 hours a day, 7 days a week. Follow
the recorded instructions, and the requested information will be sent to your fax
machine. In the U.S. and Canada, to access the IBM Automated Fax System, call
1-800-426-3395.

Getting help and service
If you have a problem with your server product, you will find a wide variety of
sources available to help you.

Using the documentation and diagnostic programs
Many problems can be solved without outside assistance. If you experience a
problem with your server product, the first place to start is the troubleshooting
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information in your IBM documentation. If you suspect a software problem, see the
documentation, including README files and online help, that comes with the
operating system or application program.

Most IBM server products come with a set of diagnostic programs that you can use
to help you identify hardware problems. See the troubleshooting information in your
IBM documentation for instructions on using the diagnostic programs.

The troubleshooting information or the diagnostic programs might tell you that you
need additional or updated device drivers or other software. IBM maintains pages
on the World Wide Web where you can get the latest technical information and
download device drivers and updates. To access these pages, go to
http://www.ibm.com/pc/support/ and follow the instructions.

Calling for service
If you have tried to correct the problem yourself and still need help, during the
warranty period, you can get help and information by telephone through the IBM
HelpCenter®. The following services are available during the warranty period:

v Problem determination - Trained personnel are available to assist you with
determining if you have a hardware problem and deciding what action is
necessary to fix the problem.

v IBM hardware repair - If the problem is determined to be caused by IBM
hardware under warranty, trained service personnel are available to provide the
applicable level of service.

v Engineering Change management - Occasionally, there might be changes that
are required after a product has been sold. IBM or your reseller, if authorized by
IBM, will make selected Engineering Changes (ECs) available that apply to your
hardware.

The following items are not covered:
v Replacement or use of non-IBM parts or nonwarranted IBM parts. All warranted

parts contain a 7-character identification in the format IBM FRU XXXXXXX.
v Identification of software problem sources.
v Configuration of BIOS as part of an installation or upgrade.
v Changes, modifications, or upgrades to device drivers.
v Installation and maintenance of network operating systems (NOS).
v Installation and maintenance of application programs.

Refer to your IBM Statement of Limited Warranty for a full explanation of IBM
warranty terms. Be sure to retain your proof of purchase to obtain warranty service.

In the U.S. and Canada, these services are available 24 hours a day, 7 days a
week. In the U.K., these services are available Monday through Friday, from 9:00
a.m. to 6:00 p.m.

Note: Response time will vary depending on the number and complexity of
incoming calls.

In addition, you are eligible for IBM Start Up Support for 90 days after installation.
This service provides assistance for:
v Setting up your network operating system
v Installing and configuring interface adapters
v Installing and configuring network adapters
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Please have the following information ready when you call:
v Machine type and model
v Serial numbers of your IBM hardware products
v Description of the problem
v Exact wording of any error messages
v Hardware and software configuration information

Telephone numbers
Phone numbers are subject to change without notice. For the most up-to-date
phone numbers, go to http://www.ibm.com/pc/support/ and click Support Phone
List.

Country Telephone number

Austria Österreich 01-24 592 5901

Belgium - Dutch Belgie 02-210 9820

Belgium - French Belgique 02-210 9800

Canada Toronto only 416-383-3344

Canada Canada - all other 1-800-565-3344

Denmark Danmark 45 20 82 00

Finland Suomi 09-22 931 840

France France 02 38 55 74 50

Germany Deutschland 07032-1549 201

Ireland Ireland 01-815 9202

Italy Italia 02-482 9202

Luxembourg Luxembourg 298-977 5063

Netherlands Nederland 020-514 5770

Norway Norge 23 05 32 40

Portugal Portugal 21-791 51 47

Spain España 91-662 49 16

Sweden Sverige 08-477 4420

Switzerland Schweiz/Suisse/Svizzera 058-333 0900

United Kingdom United Kingdom 01475-555 055

U.S.A. and Puerto Rico U.S.A. and Puerto Rico 1-800-772-2227

In all other countries or regions, contact your IBM reseller or IBM marketing
representative.

Purchasing additional services
During and after the warranty period, you can purchase additional services, such as
support for IBM and non-IBM hardware, operating systems, and application
programs; network setup and configuration; upgraded or extended hardware repair
services; and custom installations. Service availability and service name might vary
by country or region.

For more information about these services, contact your IBM marketing
representative.
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Part 5. Appendixes
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Appendix A. Creating ServeRAID diskettes

Images for the following diskettes are in the \DISKETTE directory of the IBM
ServeRAID Support CD. Each of the operating-system specific diskettes contains
device drivers and the IPSSEND utility.

Note: The IPSMON utility is available only on the IBM ServeRAID Support for
Novell NetWare diskette.

Diskette image Diskette

biosfw1.img IBM BIOS and Firmware Update (1 of 2) for the ServeRAID-4M,
ServeRAID-4Mx, ServeRAID-4L, ServeRAID-4LX, ServeRAID-3H,
ServeRAID-3HB, and ServeRAID-3L controllers

biosfw2.img IBM BIOS and Firmware Update (2 of 2) for the ServeRAID-4H,
ServeRAID-II, ServeRAID on-board, and the ServeRAID controllers

clusnt.img IBM ServeRAID Cluster Solution for Windows NT and Windows 2000

winsrv.img IBM ServeRAID Support for Windows 2000 Server

winpro.img IBM ServeRAID Support for Windows (Professional Editions) for
Microsoft Windows XP Professional and Microsoft Windows 2000
Professional

winnt.img IBM ServeRAID Support for Windows NT 4.0

os2.img IBM ServeRAID Support for IBM OS/2

netware.img IBM ServeRAID Support for Novell NetWare

unixware.img IBM ServeRAID Support for Caldera UnixWare and Open UNIX

openserv.img IBM ServeRAID Support for SCO OpenServer

redhat1.img IBM ServeRAID Support for Red Hat Linux (1 of 2) for Red Hat Linux,
versions 6.x and 7.0

redhat2.img IBM ServeRAID Support for Red Hat Linux (2 of 2) for Red Hat Linux,
version 7.1

caldera.img IBM ServeRAID Support for Caldera OpenLinux

suse.img IBM ServeRAID Support for SuSE Linux

turbo.img IBM ServeRAID Support for Turbolinux

dos.img IBM ServeRAID Support for DOS

Creating diskettes on Windows
Do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. At the DOS or command prompt, type the following and press Enter:
e:\diskette\tools\dsk4w32 e:\diskette\disketteimage a:

where

v e is the drive letter for the CD-ROM drive

v disketteimage is the name of the diskette image

v a is the drive letter for the diskette drive

3. Remove the IBM ServeRAID Support CD from the CD-ROM drive.

4. Remove the diskette from the diskette drive and label the diskette appropriately.
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Creating diskettes on IBM OS/2
Do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. At the OS/2 prompt, type the following and Press Enter:
e:\diskette\tools\dsk4wrp e:\diskette\disketteimage a:

where

v e is the drive letter for the CD-ROM drive

v disketteimage is the name of the diskette image

v a is the drive letter for the diskette drive

3. Remove the IBM ServeRAID Support CD from the CD-ROM drive.

4. Remove the diskette from the diskette drive and label the diskette appropriately.

Creating diskettes on Linux or UNIX
Do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. Mount the CD-ROM drive by typing the following at a command prompt:
mount -t iso9660 /dev/cdromdevicefile /mnt

where cdromdevicefile is the specific device file for the CD-ROM block device.

3. Press Enter.

4. At the command prompt, type the following (all on one line):
dd if=/mnt/diskette/disketteimage of=/dev/diskettedevicefile bs=32k

where

v disketteimage is the name of the diskette image

v diskettedevicefile is the specific device file for the diskette block device.

5. Press Enter.

6. Unmount the CD-ROM drive by typing the following:
umount /mnt

7. Remove the IBM ServeRAID Support CD from the CD-ROM drive.

8. Remove the diskette from the diskette drive and label the diskette appropriately.
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Appendix B. Warranty information

This appendix contains the warranty period for your product, information about
obtaining warranty service and support, and the IBM Statement of Limited Warranty.

Warranty period
Contact your place of purchase for warranty service information. Some IBM
Machines are eligible for on-site warranty service depending on the country or
region where service is performed.

Machine

v IBM ServeRAID-4H Ultra160 SCSI Controller or

v IBM ServeRAID-4Mx Ultra160 SCSI Controller or

v IBM ServeRAID-4Lx Ultra160 SCSI Controller

Warranty period - Three years

Warranty service and support
With the original purchase of an IBM server product, you have access to extensive
support. During the IBM Machine warranty period, you may call IBM or your reseller
for problem-determination assistance under the terms of the IBM Statement of
Limited Warranty.

The following services are available during the warranty period:

v Problem determination - Trained personnel are available to assist you with
determining if you have a hardware problem and deciding what action is
necessary to fix the problem.

v IBM hardware repair - If the problem is determined to be caused by IBM
hardware under warranty, trained service personnel are available to provide the
applicable level of service, either on-site or at an IBM service center as
determined by IBM.

v Engineering Change management - Occasionally, there might be changes that
are required after a product has been shipped from IBM. In those instances, IBM
will make Engineering Changes (ECs) available that apply to your hardware.

The following items are not covered under warranty service:

v Replacement or use of non-IBM parts. All IBM parts contain a 7-character
identification in the format IBM FRU XXXXXXX.

v Identification of non-IBM software problem sources.

v Installation of customer replaceable units (CRUs).

v Installation and configuration of machine code or licensed internal code that is
designated as customer installable.

If you do not register your server with IBM, you might be required to present proof
of purchase to obtain warranty service.
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Before you call for service
You can solve many problems without outside assistance by following the
troubleshooting procedures that IBM provides in the online help or in the
publications that are provided with your server and software.

Most computers, operating systems, and application programs come with
information that contains troubleshooting procedures and explanations of error
messages and error codes. The information that comes with your server also
describes the diagnostic tests that you can perform.

If you suspect a software problem, refer to the information for the operating system
or application program.

Calling for service
Please have the following information ready:

v Machine type, model, and serial number

v Description of the problem

v Exact wording of any error messages

v Hardware and software configuration information

To find the telephone number for the HelpCenter nearest you, see “Telephone
numbers” in the “Getting information, help, and service” chapter.

IBM Statement of Limited Warranty Z125-4753-06 8/2000
This warranty statement consists of two parts: Part 1 and Part 2. Be sure to read
Part 1 and the country-unique terms in Part 2 that apply to your country or region.

Part 1 - General Terms
This Statement of Limited Warranty includes Part 1 - General Terms and Part 2 -
Country-unique Terms. The terms of Part 2 replace or modify those of Part 1. The
warranties provided by IBM in this Statement of Limited Warranty apply only to
Machines you purchase for your use, and not for resale, from IBM or your reseller.
The term “Machine” means an IBM machine, its features, conversions, upgrades,
elements, or accessories, or any combination of them. The term “Machine” does not
include any software programs, whether pre-loaded with the Machine, installed
subsequently or otherwise. Unless IBM specifies otherwise, the following warranties
apply only in the country where you acquire the Machine. Nothing in this Statement
of Limited Warranty affects any statutory rights of consumers that cannot be waived
or limited by contract. If you have any questions, contact IBM or your reseller.

The IBM Warranty for Machines

IBM warrants that each Machine 1) is free from defects in materials and
workmanship and 2) conforms to IBM’s Official Published Specifications
(“Specifications”). The warranty period for a Machine is a specified, fixed period
commencing on its Date of Installation. The date on your sales receipt is the Date
of Installation unless IBM or your reseller informs you otherwise.

If a Machine does not function as warranted during the warranty period, and IBM or
your reseller are unable to either 1) make it do so or 2) replace it with one that is at
least functionally equivalent, you may return it to your place of purchase and your
money will be refunded.
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Extent of Warranty

The warranty does not cover the repair or exchange of a Machine resulting from
misuse, accident, modification, unsuitable physical or operating environment,
improper maintenance by you, or failure caused by a product for which IBM is not
responsible. The warranty is voided by removal or alteration of Machine or parts
identification labels.

THESE WARRANTIES ARE YOUR EXCLUSIVE WARRANTIES AND REPLACE
ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THESE WARRANTIES GIVE YOU SPECIFIC LEGAL RIGHTS AND
YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO
JURISDICTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF EXPRESS OR IMPLIED WARRANTIES, SO THE ABOVE
EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU. IN THAT EVENT, SUCH
WARRANTIES ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO
WARRANTIES APPLY AFTER THAT PERIOD.

Items Not Covered by Warranty

IBM does not warrant uninterrupted or error-free operation of a Machine.

Any technical or other support provided for a Machine under warranty, such as
assistance via telephone with “how-to” questions and those regarding Machine
set-up and installation, will be provided WITHOUT WARRANTIES OF ANY KIND.

Warranty Service

To obtain warranty service for a Machine, contact IBM or your reseller. If you do not
register your Machine with IBM, you may be required to present proof of purchase.

During the warranty period, IBM or your reseller, if approved by IBM to provide
warranty service, provides without charge certain types of repair and exchange
service to keep Machines in, or restore them to, conformance with their
Specifications. IBM or your reseller will inform you of the available types of service
for a Machine based on its country of installation. At its discretion, IBM or your
reseller will 1) either repair or exchange the failing Machine and 2) provide the
service either at your location or a service center. IBM or your reseller will also
manage and install selected engineering changes that apply to the Machine.

Some parts of IBM Machines are designated as Customer Replaceable Units
(called “CRUs”), e.g., keyboards, memory, or hard disk drives. IBM ships CRUs to
you for replacement by you. You must return all defective CRUs to IBM within 30
days of your receipt of the replacement CRU. You are responsible for downloading
designated Machine Code and Licensed Internal Code updates from an IBM
Internet Web site or from other electronic media, and following the instructions that
IBM provides.

When warranty service involves the exchange of a Machine or part, the item IBM or
your reseller replaces becomes its property and the replacement becomes yours.
You represent that all removed items are genuine and unaltered. The replacement
may not be new, but will be in good working order and at least functionally
equivalent to the item replaced. The replacement assumes the warranty service
status of the replaced item. Many features, conversions, or upgrades involve the
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removal of parts and their return to IBM. A part that replaces a removed part will
assume the warranty service status of the removed part.

Before IBM or your reseller exchanges a Machine or part, you agree to remove all
features, parts, options, alterations, and attachments not under warranty service.

You also agree to
1. ensure that the Machine is free of any legal obligations or restrictions that

prevent its exchange;
2. obtain authorization from the owner to have IBM or your reseller service a

Machine that you do not own; and
3. where applicable, before service is provided:

a. follow the problem determination, problem analysis, and service request
procedures that IBM or your reseller provides;

b. secure all programs, data, and funds contained in a Machine;
c. provide IBM or your reseller with sufficient, free, and safe access to your

facilities to permit them to fulfill their obligations; and
d. inform IBM or your reseller of changes in a Machine’s location.

IBM is responsible for loss of, or damage to, your Machine while it is 1) in IBM’s
possession or 2) in transit in those cases where IBM is responsible for the
transportation charges.

Neither IBM nor your reseller is responsible for any of your confidential, proprietary
or personal information contained in a Machine which you return to IBM or your
reseller for any reason. You should remove all such information from the Machine
prior to its return.

Limitation of Liability

Circumstances may arise where, because of a default on IBM’s part or other
liability, you are entitled to recover damages from IBM. In each such instance,
regardless of the basis on which you are entitled to claim damages from IBM
(including fundamental breach, negligence, misrepresentation, or other contract or
tort claim), except for any liability that cannot be waived or limited by applicable
laws, IBM is liable for no more than

1. damages for bodily injury (including death) and damage to real property and
tangible personal property; and

2. the amount of any other actual direct damages, up to the charges (if recurring,
12 months’ charges apply) for the Machine that is subject of the claim. For
purposes of this item, the term “Machine” includes Machine Code and Licensed
Internal Code.

This limit also applies to IBM’s suppliers and your reseller. It is the maximum for
which IBM, its suppliers, and your reseller are collectively responsible.

UNDER NO CIRCUMSTANCES IS IBM LIABLE FOR ANY OF THE FOLLOWING:
1) THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES (OTHER THAN
THOSE UNDER THE FIRST ITEM LISTED ABOVE); 2) LOSS OF, OR DAMAGE
TO, YOUR RECORDS OR DATA; OR 3) SPECIAL, INCIDENTAL, OR INDIRECT
DAMAGES OR FOR ANY ECONOMIC CONSEQUENTIAL DAMAGES, LOST
PROFITS OR LOST SAVINGS, EVEN IF IBM, ITS SUPPLIERS OR YOUR
RESELLER IS INFORMED OF THEIR POSSIBILITY. SOME JURISDICTIONS DO
NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION
MAY NOT APPLY TO YOU.
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Governing Law

Both you and IBM consent to the application of the laws of the country in which you
acquired the Machine to govern, interpret, and enforce all of your and IBM’s rights,
duties, and obligations arising from, or relating in any manner to, the subject matter
of this Agreement, without regard to conflict of law principles.

Part 2 - Country-unique Terms
AMERICAS

BRAZIL

Governing Law: The following is added after the first sentence:Any litigation arising
from this Agreement will be settled exclusively by the court of Rio de Janeiro.

NORTH AMERICA

Warranty Service: The following is added to this Section: To obtain warranty
service from IBM in Canada or the United States, call 1-800-IBM-SERV (426-7378).

CANADA

Governing Law: The following replaces “laws of the country in which you acquired
the Machine” in the first sentence: laws in the Province of Ontario.

UNITED STATES

Governing Law: The following replaces “laws of the country in which you acquired
the Machine” in the first sentence: laws of the State of New York.

ASIA PACIFIC

AUSTRALIA

The IBM Warranty for Machines: The following paragraph is added to this Section:
The warranties specified in this Section are in addition to any rights you may have
under the Trade Practices Act 1974 or other similar legislation and are only limited
to the extent permitted by the applicable legislation.

Limitation of Liability: The following is added to this Section: Where IBM is in
breach of a condition or warranty implied by the Trade Practices Act 1974 or other
similar legislation, IBM’s liability is limited to the repair or replacement of the goods
or the supply of equivalent goods. Where that condition or warranty relates to right
to sell, quiet possession or clear title, or the goods are of a kind ordinarily acquired
for personal, domestic or household use or consumption, then none of the
limitations in this paragraph apply.

Governing Law: The following replaces “laws of the country in which you acquired
the Machine” in the first sentence: laws of the State or Territory.

CAMBODIA, LAOS, AND VIETNAM

Governing Law: The following replaces “laws of the country in which you acquired
the Machine” in the first sentence:laws of the State of New York.
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The following is added to this Section: Disputes and differences arising out of or in
connection with this Agreement shall be finally settled by arbitration which shall be
held in Singapore in accordance with the rules of the International Chamber of
Commerce (ICC). The arbitrator or arbitrators designated in conformity with those
rules shall have the power to rule on their own competence and on the validity of
the Agreement to submit to arbitration. The arbitration award shall be final and
binding for the parties without appeal and the arbitral award shall be in writing and
set forth the findings of fact and the conclusions of law.

All proceedings shall be conducted, including all documents presented in such
proceedings, in the English language. The number of arbitrators shall be three, with
each side to the dispute being entitled to appoint one arbitrator.

The two arbitrators appointed by the parties shall appoint a third arbitrator before
proceeding upon the reference. The third arbitrator shall act as chairman of the
proceedings. Vacancies in the post of chairman shall be filled by the president of
the ICC. Other vacancies shall be filled by the respective nominating party.
Proceedings shall continue from the stage they were at when the vacancy occurred.

If one of the parties refuses or otherwise fails to appoint an arbitrator within 30 days
of the date the other party appoints its, the first appointed arbitrator shall be the
sole arbitrator, provided that the arbitrator was validly and properly appointed.

The English language version of this Agreement prevails over any other language
version.

HONG KONG AND MACAU

Governing Law: The following replaces “laws of the country in which you acquired
the Machine” in the first sentence: laws of Hong Kong Special Administrative
Region.

INDIA

Limitation of Liability: The following replaces items 1 and 2 of this Section:
1. liability for bodily injury (including death) or damage to real property and tangible

personal property will be limited to that caused by IBM’s negligence;
2. as to any other actual damage arising in any situation involving nonperformance

by IBM pursuant to, or in any way related to the subject of this Statement of
Limited Warranty, IBM’s liability will be limited to the charge paid by you for the
individual Machine that is the subject of the claim.

JAPAN

Governing Law: The following sentence is added to this Section:Any doubts
concerning this Agreement will be initially resolved between us in good faith and in
accordance with the principle of mutual trust.

NEW ZEALAND

The IBM Warranty for Machines: The following paragraph is added to this Section:
The warranties specified in this Section are in addition to any rights you may have
under the Consumer Guarantees Act 1993 or other legislation which cannot be
excluded or limited. The Consumer Guarantees Act 1993 will not apply in respect of
any goods which IBM provides, if you require the goods for the purposes of a
business as defined in that Act.
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Limitation of Liability: The following is added to this Section: Where Machines are
not acquired for the purposes of a business as defined in the Consumer
Guarantees Act 1993, the limitations in this Section are subject to the limitations in
that Act.

PEOPLE’S REPUBLIC OF CHINA (PRC)

Governing Law: The following replaces this Section: Both you and IBM consent to
the application of the laws of the State of New York (except when local law requires
otherwise) to govern, interpret, and enforce all your and IBM’s rights, duties, and
obligations arising from, or relating in any manner to, the subject matter of this
Agreement, without regard to conflict of law principles.

Any disputes arising from or in connection with this Agreement will first be resolved
by friendly negotiations, failing which either of us has the right to submit the dispute
to the China International Economic and Trade Arbitration Commission in Beijing,
the PRC, for arbitration in accordance with its arbitration rules in force at the time.
The arbitration tribunal will consist of three arbitrators. The language to be used
therein will be English and Chinese. An arbitral award will be final and binding on all
the parties, and will be enforceable under the Convention on the Recognition and
Enforcement of Foreign Arbitral Awards (1958).

The arbitration fee will be borne by the losing party unless otherwise determined by
the arbitral award.

During the course of arbitration, this Agreement will continue to be performed
except for the part which the parties are disputing and which is undergoing
arbitration.

EUROPE, MIDDLE EAST, AFRICA (EMEA)

THE FOLLOWING TERMS APPLY TO ALL EMEA COUNTRIES: The terms of this
Statement of Limited Warranty apply to Machines purchased from IBM or an IBM
reseller.

Warranty Service:

If you purchase an IBM Machine in Austria, Belgium, Denmark, Estonia, Finland,
France, Germany, Greece, Iceland, Ireland, Italy, Latvia, Lithuania, Luxembourg,
Netherlands, Norway, Portugal, Spain, Sweden, Switzerland or United Kingdom, you
may obtain warranty service for that Machine in any of those countries from either
(1) an IBM reseller approved to perform warranty service or (2) from IBM. If you
purchase an IBM Personal Computer Machine in Albania, Armenia, Belarus, Bosnia
and Herzegovina, Bulgaria, Croatia, Czech Republic, Georgia, Hungary,
Kazakhstan, Kirghizia, Federal Republic of Yugoslavia, Former Yugoslav Republic of
Macedonia (FYROM), Moldova, Poland, Romania, Russia, Slovak Republic,
Slovenia, or Ukraine, you may obtain warranty service for that Machine in any of
those countries from either (1) an IBM reseller approved to perform warranty
service or (2) from IBM.

If you purchase an IBM Machine in a Middle Eastern or African country, you may
obtain warranty service for that Machine from the IBM entity within the country of
purchase, if that IBM entity provides warranty service in that country, or from an
IBM reseller, approved by IBM to perform warranty service on that Machine in that
country. Warranty service in Africa is available within 50 kilometers of an IBM

Appendix B. Warranty information 179



authorized service provider. You are responsible for transportation costs for
Machines located outside 50 kilometers of an IBM authorized service provider.

Governing Law:

The applicable laws that govern, interpret and enforce rights, duties, and obligations
of each of us arising from, or relating in any manner to, the subject matter of this
Statement, without regard to conflict of laws principles, as well as Country-unique
terms and competent court for this Statement are those of the country in which the
warranty service is being provided, except that in 1) Albania, Bosnia-Herzegovina,
Bulgaria, Croatia, Hungary, Former Yugoslav Republic of Macedonia, Romania,
Slovakia, Slovenia, Armenia, Azerbaijan, Belarus, Georgia, Kazakhstan, Kyrgyzstan,
Moldova, Russia, Tajikistan, Turkmenistan, Ukraine, and Uzbekistan, the laws of
Austria apply; 2) Estonia, Latvia, and Lithuania, the laws of Finland apply; 3)
Algeria, Benin, Burkina Faso, Cameroon, Cape Verde, Central African Republic,
Chad, Congo, Djibouti, Democratic Republic of Congo, Equatorial Guinea, France,
Gabon, Gambia, Guinea, Guinea-Bissau, Ivory Coast, Lebanon, Mali, Mauritania,
Morocco, Niger, Senegal, Togo, and Tunisia, this Agreement will be construed and
the legal relations between the parties will be determined in accordance with the
French laws and all disputes arising out of this Agreement or related to its violation
or execution, including summary proceedings, will be settled exclusively by the
Commercial Court of Paris; 4) Angola, Bahrain, Botswana, Burundi, Egypt, Eritrea,
Ethiopia, Ghana, Jordan, Kenya, Kuwait, Liberia, Malawi, Malta, Mozambique,
Nigeria, Oman, Pakistan, Qatar, Rwanda, Sao Tome, Saudi Arabia, Sierra Leone,
Somalia, Tanzania, Uganda, United Arab Emirates, United Kingdom, West
Bank/Gaza, Yemen, Zambia, and Zimbabwe, this Agreement will be governed by
English Law and disputes relating to it will be submitted to the exclusive jurisdiction
of the English courts; and 5) in Greece, Israel, Italy, Portugal, and Spain any legal
claim arising out of this Statement will be brought before, and finally settled by, the
competent court of Athens, Tel Aviv, Milan, Lisbon, and Madrid, respectively.

THE FOLLOWING TERMS APPLY TO THE COUNTRY SPECIFIED:

AUSTRIA AND GERMANY

The IBM Warranty for Machines: The following replaces the first sentence of the
first paragraph of this Section: The warranty for an IBM Machine covers the
functionality of the Machine for its normal use and the Machine’s conformity to its
Specifications.

The following paragraphs are added to this Section:

The minimum warranty period for Machines is six months. In case IBM or your
reseller is unable to repair an IBM Machine, you can alternatively ask for a partial
refund as far as justified by the reduced value of the unrepaired Machine or ask for
a cancellation of the respective agreement for such Machine and get your money
refunded.

Extent of Warranty: The second paragraph does not apply.

Warranty Service: The following is added to this Section: During the warranty
period, transportation for delivery of the failing Machine to IBM will be at IBM’s
expense.
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Limitation of Liability: The following paragraph is added to this Section: The
limitations and exclusions specified in the Statement of Limited Warranty will not
apply to damages caused by IBM with fraud or gross negligence and for express
warranty.

The following sentence is added to the end of item 2: IBM’s liability under this item
is limited to the violation of essential contractual terms in cases of ordinary
negligence.

EGYPT

Limitation of Liability: The following replaces item 2 in this Section: as to any
other actual direct damages, IBM’s liability will be limited to the total amount you
paid for the Machine that is the subject of the claim. For purposes of this item, the
term “Machine” includes Machine Code and Licensed Internal Code.

Applicability of suppliers and resellers (unchanged).

FRANCE

Limitation of Liability: The following replaces the second sentence of the first
paragraph of this Section:In such instances, regardless of the basis on which you
are entitled to claim damages from IBM, IBM is liable for no more than: (items 1
and 2 unchanged).

IRELAND

Extent of Warranty: The following is added to this Section: Except as expressly
provided in these terms and conditions, all statutory conditions, including all
warranties implied, but without prejudice to the generality of the foregoing all
warranties implied by the Sale of Goods Act 1893 or the Sale of Goods and Supply
of Services Act 1980 are hereby excluded.

Limitation of Liability: The following replaces items one and two of the first
paragraph of this Section:1. death or personal injury or physical damage to your
real property solely caused by IBM’s negligence; and 2. the amount of any other
actual direct damages, up to 125 percent of the charges (if recurring, the 12
months’ charges apply) for the Machine that is the subject of the claim or which
otherwise gives rise to the claim.

Applicability of suppliers and resellers (unchanged).

The following paragraph is added at the end of this Section: IBM’s entire liability
and your sole remedy, whether in contract or in tort, in respect of any default shall
be limited to damages.

ITALY

Limitation of Liability: The following replaces the second sentence in the first
paragraph:In each such instance unless otherwise provided by mandatory law, IBM
is liable for no more than: 1. (unchanged) 2. as to any other actual damage arising
in all situations involving nonperformance by IBM pursuant to, or in any way related
to the subject matter of this Statement of Warranty, IBM’s liability, will be limited to
the total amount you paid for the Machine that is the subject of the claim.
Applicability of suppliers and resellers (unchanged).
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The following replaces the third paragraph of this Section: Unless otherwise
provided by mandatory law, IBM and your reseller are not liable for any of the
following: (items 1 and 2 unchanged) 3) indirect damages, even if IBM or your
reseller is informed of their possibility.

SOUTH AFRICA, NAMIBIA, BOTSWANA, LESOTHO AND SWAZILAND

Limitation of Liability: The following is added to this Section: IBM’s entire liability
to you for actual damages arising in all situations involving nonperformance by IBM
in respect of the subject matter of this Statement of Warranty will be limited to the
charge paid by you for the individual Machine that is the subject of your claim from
IBM.

UNITED KINGDOM

Limitation of Liability: The following replaces items 1 and 2 of the first paragraph
of this Section:
1. death or personal injury or physical damage to your real property solely caused

by IBM’s negligence;
2. the amount of any other actual direct damages or loss, up to 125 percent of the

charges (if recurring, the 12 months’ charges apply) for the Machine that is the
subject of the claim or which otherwise gives rise to the claim;

The following item is added to this paragraph: 3. breach of IBM’s obligations implied
by Section 12 of the Sale of Goods Act 1979 or Section 2 of the Supply of Goods
and Services Act 1982.

Applicability of suppliers and resellers (unchanged).

The following is added to the end of this Section: IBM’s entire liability and your sole
remedy, whether in contract or in tort, in respect of any default shall be limited to
damages.
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Appendix C. Notices

This publication was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this publication to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product, and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Edition notice
© COPYRIGHT INTERNATIONAL BUSINESS MACHINES CORPORATION, 2001.
All rights reserved.

Note to U.S. Government Users — Documentation related to restricted rights —
Use, duplication or disclosure is subject to restrictions set forth in GSA ADP
Schedule Contract with IBM Corp.
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Non-IBM Web sites
Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product and use of those Web sites is at your own risk.

Trademarks
The following terms are trademarks of International Business Machines Corporation
in the United States, other countries, or both:

Alert on LAN OS/2 WARP
Chipkill Predictive Failure Analysis
EtherJet ServeRAID
e-business logo ServerGuide
HelpCenter ServerProven
HelpWare Tivoli
IBM Tivoli Enterprise
Light Path Diagnostics Update Connector
NetBAY Wake on LAN
NetView xSeries

Lotus and Domino are trademarks of Lotus Development Corporation in the United
States, other countries, or both.

Intel, Celeron, MMX, LANDesk, Pentium, Pentium II Xeon, and Pentium III Xeon are
trademarks of Intel Corporation in the United States, other countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Other company, product, or service names may be the trademarks or service marks
of others.

Important notes
Processor speeds indicate the internal clock speed of the microprocessor; other
factors also affect application performance.

CD-ROM drive speeds list the variable read rate. Actual speeds vary and are often
less than the maximum possible.

When referring to processor storage, real and virtual storage, or channel volume,
KB stands for approximately 1000 bytes, MB stands for approximately 1000000
bytes, and GB stands for approximately 1000000000 bytes.
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When referring to hard disk drive capacity or communications volume, MB stands
for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total user-accessible
capacity may vary depending on operating environments.

Maximum internal hard disk drive capacities assume the replacement of any
standard hard disk drives and population of all hard disk drive bays with the largest
currently supported drives available from IBM.

Maximum memory may require replacement of the standard memory with an
optional memory module.

IBM makes no representation or warranties regarding non-IBM products and
services that are ServerProven, including but not limited to the implied warranties of
merchantability and fitness for a particular purpose. These products are offered and
warranted solely by third parties.

Unless otherwise stated, IBM makes no representations or warranties with respect
to non-IBM products. Support (if any) for the non-IBM products is provided by the
third party, not IBM.

Some software may differ from its retail version (if available), and may not include
user manuals or all program functionality.

Electronic emission notices

Federal Communications Commission (FCC) statement
Note: This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause
harmful interference, in which case the user will be required to correct the
interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to
meet FCC emission limits. IBM is not responsible for any radio or television
interference caused by using other than recommended cables and connectors or by
unauthorized changes or modifications to this equipment. Unauthorized changes or
modifications could void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.

Industry Canada Class A emission compliance statement
This Class A digital apparatus complies with Canadian ICES-003.

Avis de conformité à la réglementation d’Industrie Canada

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du
Canada.
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Australia and New Zealand Class A statement
Attention: This is a Class A product. In a domestic environment this product may
cause radio interference in which case the user may be required to take adequate
measures.

United Kingdom telecommunications safety requirement
Notice to Customers

This apparatus is approved under approval number NS/G/1234/J/100003 for indirect
connection to public telecommunication systems in the United Kingdom.

European Union EMC Directive conformance statement
This product is in conformity with the protection requirements of EU Council
Directive 89/336/EEC on the approximation of the laws of the Member States
relating to electromagnetic compatibility. IBM cannot accept responsibility for any
failure to satisfy the protection requirements resulting from a nonrecommended
modification of the product, including the fitting of non-IBM option cards.

This product has been tested and found to comply with the limits for Class A
Information Technology Equipment according to CISPR 22/European Standard EN
55022. The Limits for Class A equipment were derived for commercial and industrial
environments to provide reasonable protection against interference with licensed
communication equipment.

Attention: This is a Class A product. In a domestic environment this product may
cause radio interference in which case the user may be required to take adequate
measures.

Taiwan electrical emission statement

Japanese Voluntary Control Council for Interference (VCCI) statement
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Glossary

A
array. Two or more physical drives combined for
increased capacity, speed, or fault tolerance. Once
created, an array is configured as one or more logical
drives. The operating system in the server recognizes a
logical drive as a single drive.

auto-synchronization. Synchronization on RAID
level-5, level-5E, and level-50 drives that is
automatically initiated when logical drives are created.
This type of synchronization works in the background.

B
battery-backup cache. Buffer storage that protects
data during write-back operations; in the event of a
power failure, it preserves the data in the controller
cache.

BIOS-compatibility mapping. A ServeRAID controller
setting with two options: “Limited” and “Extended.”
Selecting “Limited” informs the ServeRAID BIOS that
the operating system supports 2 GB or smaller physical
drives; selecting “Extended” informs the ServeRAID
BIOS that the system supports 8 GB or smaller physical
drives. The default value is “Extended”; setting this
option to “Limited” enables the user to migrate data
from older PCI or Micro Channel adapters.

block. A data unit created when data is striped across
physical drives.

blocked. A logical-drive state in which the data in a
RAID level-0 logical drive might be damaged and will
need to be restored. After an array fails and a rebuild
operation is initiated, the ServeRAID controller sets
RAID level-0 logical drives to the blocked state.

C
cluster. In ServeRAID technology, two independent
computer systems organized into a network for the
purpose of sharing resources and communicating with
each other. A cluster provides fault-tolerance at the
server level.

compression. The process by which a RAID level-5E
logical drive utilizes the distributed spare drive in the
event of a physical drive failure. After the data is
reconstructed, the original array undergoes compression
and the distributed spare drive becomes part of the new
array.

controller. A device that coordinates and controls the
operation of one or more input/output devices, such as

workstations, and synchronizes the operation of such
devices with the operation of the system as a whole.

controller names. In a cluster or failover pair, the
unique names that identify the members of the pair to
one another.

critical. The state of a RAID level-1, level-1E, level-5,
level-5E, level-10, level-1E0, or level-50 logical drive
that contains a defunct drive.

D
data mirroring. A technique that creates a single
logical drive from two physical drives. All data written to
the logical drive is written to both physical drives,
creating a pair of physical drives containing exactly the
same data.

data scrubbing. A feature that provides automatic,
continuous synchronization during system use. This
features works in the background, and ensures that the
redundant data and/or parity is correct.

data striping. A technique that divides a logical drive
into data blocks, called stripes, which are then
distributed over the physical drives. The layout is such
that a sequential read of data on the logical drive results
in parallel reads to each of the physical drives, resulting
in improved performance.

decompression. The process by which a compressed
array returns to its original striping scheme, after a
failed drive is replaced in a RAID level-5E logical drive.
Contrast with compression.

defunct. A physical-drive state in which the
ServeRAID controller cannot communicate properly with
the drive.

distributed spare drive. In RAID level-5E, the logical
drive designated as a spare drive. Because this spare
drive is spread over several physical drives, it is
described as distributed.

E
enclosure. A storage expansion unit, such as the
Netfinity

®
EXP300, that contains SCSI disk drives.

F
fault tolerance. The ability of a computer system to
operate correctly even though one or more of its
component parts are malfunctioning.

firmware. Proprietary code that is usually delivered as
microcode as part of an operating system. Firmware is
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more efficient than software loaded from an alterable
medium and more adaptable to change than pure
hardware circuitry. An example of firmware is the Basic
Input/Output System (BIOS) in read-only memory
(ROM) on a PC motherboard.

H
hot add. To add and configure a new ServeRAID
controller while the server is operational.

hot-spare drive. A physical drive that is defined for
automatic use when a similar drive fails.

hot-pluggable. Pertaining to a system in which
components can be added while the system is running.

hot-swappable. Pertaining to a component that can
be removed and/or replaced while the system is
running.

hot-swap rebuild. An operation that is started by the
ServeRAID controller when it detects that a physical
drive that is part of an array and in the defunct state
has been removed and replaced on a SCSI cable or
backplane.

I
initialize logical drive. In the ServeRAID utilities, to
erase the first 1024 sectors on a drive, preventing
access to any data previously stored on the drive.

initiator identifiers. The SCSI initiator IDs assigned to
a cluster or failover pair.

IPSSEND command-line program. An advanced
command-line program that can be used to manage
your ServeRAID controllers. It can be used to configure
your controller, isolate and debug problems, recover
from errors, and to copy controller configurations from
one server to another.

L
logical drive. A grouping of physical drives that the
operating system recognizes as a single drive.

logical-drive migration. To add or remove physical
drives from an existing array, to change RAID levels,
change logical-drive size, or effect an increase in free
space.

M
merge-group number. In a clustering configuration,
the numbers that identify each logical drive. Non-shared
logical drives are assigned merge-group numbers of
either 206 or 207; shared logical drives need unique

merge-group numbers, so that they can be identified
even if they move to the other server.

merge-group state. In a clustering environment,
whether or not a logical drive is shared.

migrating. The state of a logical drive undergoing a
logical-drive migration.

N
Notification Manager. A tool used to notify remote
systems of events, problems, and configuration changes
occurring on a local system.

O
offline. A logical-drive state in which the logical drive
is inaccessible.

okay. A logical-drive state in which the logical drive is
functional.

online. A physical-drive state in which the physical
drive is functioning properly and is part of an array.

P
partner name. In a cluster or failover pair, one of the
two controller names entered during configuration.

parity. The data stored on a RAID level-5, level-5E, or
level-50 logical drive that can be used, in conjunction
with the data on the remaining drives, to recreate a
failed physical drive’s data.

parity block. In a RAID level-5, level-5E, or level-50
logical drive, a data unit that contains a representation
of the data from other blocks in the same stripe.

physical drive. A hard disk drive.

POST. Power-on self-test. During POST, the
ServeRAID controller compares the stored configuration
information to the configuration that is actually present.
If a discrepancy exists, one or more status messages
appear after the POST completes but before the
operating system loads.

Q
quorum drive. In the Microsoft Clustering Solution, a
logical drive that stores the quorum resource
information.

R
rack enclosure. See enclosure.

188 IBM® User’s Reference: ServeRAID™ -4 Ultra160 SCSI Controller



RAID. A technology of grouping several physical drives
in a computer into an array that you can define as one
or more logical drives. Each logical drive appears to the
operating system as a single drive. This grouping
technique greatly enhances logical-drive capacity and
performance beyond the physical limitations of a single
physical drive.

RAID level-0. A RAID level that uses data striping to
distribute data evenly across physical drives. While it
enables full utilization of physical drive capacity and
performance acceleration, RAID level-0 provides neither
fault tolerance nor redundancy.

RAID level-1. A RAID level that uses data mirroring to
distribute data across two physical drives. It provides
data redundancy and performance acceleration,
although the usable physical drive space is reduced by
50 percent.

RAID level-1E. A RAID level that uses both data
striping and data mirroring to distribute data across
three or more physical drives. Data is striped across
each disk in the array; the first set of stripes are the
data stripes, and the second sets of stripes are mirror
copies of the first stripe, shifted one drive. It provides
data redundancy and performance acceleration,
although the usable physical drive space is reduced by
50 percent.

RAID level-5. A RAID level that uses data striping and
block interweaving to distribute data across three or
more physical drives. It provides full data protection and
performance acceleration, although only 67-94% of
physical drive storage capacity can be used.

RAID level-5E. A RAID level that uses data striping
and block interweaving to distribute data across four or
more physical drives; it uses some space on each
physical drive as a distributed hot-spare. It provides full
data protection and performance acceleration, although
only 50-88% of physical drive storage capacity can be
used.

RAID level-x0. Refers to RAID level-00, level-10,
level-1E0, and level-50. These RAID levels use
spanned arrays (arrays of arrays) to enable the use of
up to 60 physical drives. RAID level-00 provides no data
redundancy, but provides performance acceleration and
allows 100% of the physical drive storage capacity to be
used. RAID levels -10, -1E, and -50 provide full data
protection, performance acceleration, and greater
reliability, although only 67-94% of physical drive
storage capacity can be used.

read-ahead cache mode. A ServeRAID controller
setting that determines whether or not the ServeRAID
controller transfers data from disk to its local cache in
increments equal to the stripe-unit size.

ready. A physical-drive state in which the drive is
available for definition.

rebuild. An operation to reconstruct data after the
problem that caused a physical drive to become defunct
has been resolved.

rebuilding. The state of a physical drive undergoing a
rebuild operation.

rebuild rate. The speed (high, medium, or low) at
which a rebuild operation will occur.

redundant array of independent disks (RAID). See
RAID.

restore to factory-default settings. An action that
restores all parameters in the controller to the
factory-default settings. If logical drives are defined, the
data stored on them will be lost.

S
SCSI. See small computer system interface.

SCSI ID. A unique ID assigned to each SCSI device
connected to a SCSI controller. This ID enables the
controller to identify the device and ensure that different
devices on the same SCSI channel do not transfer data
simultaneously.

SCSI initiator ID. In a failover or clustering
environment, the ID assigned to a SCSI controller. Each
ServeRAID controller and its partner must have different
SCSI initiator IDS; one must be 6 and the other 7.

SCSI transfer speed. The speed at which data can be
transferred between a physical drive and the ServeRAID
controller.

ServeRAID Manager. A program used to configure
ServeRAID controllers, view the ServeRAID
configuration, create arrays and logical drives, delete
arrays, dynamically increase the logical-drive size,
change RAID levels, and more.

ServeRAID Mini-Configuration program. A program
that allows the user to display the ServeRAID controller
settings, and to perform a limited set of configuration
functions without using the IBM ServeRAID Support CD.

ServeRAID ROM Update Wizard. A program that
updates the BIOS and firmware codes on ServeRAID
controllers.

shared drives. The physical drives controlled by a
cluster or failover pair.

small computer system interface. A standard
hardware interface that enables a variety of peripheral
devices to communicate with one another.

spanned array. An array of arrays. Used in RAID
level-00, level-10, level-1E0, and level-50 to permit the
use of larger numbers of physical drives. The spanned
array contains arrays, each of which contains a
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sub-logical drive, which can be RAID level-0, level-1,
level-1E, or level-5. The RAID-level for the logical drive
contained within the spanned array is 0.

standby hot spare. A hot-spare physical drive that the
ServeRAID controller has spun down. If an online drive
becomes defunct and no suitable hot-spare drive is
available, a standby drive of the appropriate size
automatically spins up and enters the rebuild state.

stripe-unit size. The granularity at which data is
stored on one drive of the array before subsequent data
is stored on the next drive of the array. The
performance of a ServeRAID controller is maximized if
the stripe-unit size is close to the size of the system
input/output requests.

stripes. The collection of stripe units, from the first to
last drive of the array.

sub-logical drive. In a RAID level-x0 configuration, a
logical drive contained within each array of the spanned
array. A sub-logical drive can be RAID level-0, level-1,
level-1E, or level 5.

synchronization. The process of recalculating and
rewriting either redundant data (RAID level-1, level-1E,
level-10, and level-1E0 logical drives) or parity (RAID
level-5, level-5E, and level-50 logical drives).

T
throughput. The speed at which data can be moved
from one place to another, usually expressed in MB per
second.

U
unattended mode. A ServeRAID controller setting that
determines how the BIOS handles failures during
system startup. The options are “enabled” and
“disabled”; the default value is “disabled.”

unattended mode -- Disabled. An option of the
unattended mode. When the unattended mode is
disabled and the BIOS detects a failure, the system
stops at the recovery option screen and waits for the
user to respond.

unattended mode -- Enabled. An option of the
unattended mode. When the unattended mode is
enabled and the BIOS detects a failure, the system
waits for 30 seconds for the user to respond to the
recovery options screen. Then, the BIOS automatically
selects an appropriate option and continues the system
startup process. Unattended mode must be enabled in a
clustering environment.

W
write-cache mode. A ServeRAID controller setting that
determines whether the controller writes data to the
physical drive before or after sending a confirmation to
the operating system. The settings are “write back” and
“write through.”

write-cache mode -- write back. A setting of the
write-cache mode. When the write-cache mode is set to
write back and the operating system sends data to the
controller, the controller sends a confirmation back to
the operating system before actually writing the data to
a storage device. This increases performance, but, if a
battery-backup cache is not used, increases the risk of
data loss in the event of a power failure.

write-cache mode -- write through. A setting of the
write-cache mode. When the write-cache mode is set to
write through and the operating system sends data to
the controller, the controller writes the data to a storage
device before sending a confirmation to the operating
system. This mode decreases performance, but does
not risk data loss.
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Index

A
Active PCI 9, 10, 11, 88

DMI Service provider 9, 88
IBM Hot Plug for Windows NT 4.0 Package 9, 10,

88
adapter, see controller xi
adaptive read-ahead cache mode 83
Adobe Acrobat Reader xiv
array 15, 16

cluster 108
deleting 74, 82
failover 50

autosync (IPSSEND) 75

B
backup (IPSSEND) 71, 76
battery-backup cache 4, 5, 60
BCS error codes 147
BIOS

failover 45
IBM ServeRAID ROM Update Wizard xiii, 30
settings 76
updates 29, 135, 137
updating 30, 120

BIOS-compatibility mapping 60
blocked logical drive 26
built-in spare drive 22

C
cables

cluster 102
failover 46
SCSI, problems 80

cache memory 4, 5
Caldera OpenLinux

installing ServeRAID Manager 89
ServeRAID Manager 90
starting ServeRAID Manager 93

CD-ROM
IBM ServeRAID Support xii
Microsoft Windows 2000 Advanced Server 137
Microsoft Windows NT Server Enterprise Edition

Component 115
certify (IPSSEND) 79
Class A electronic emission notice 185
cluster 97

array 108
BIOS updates 137
cables 102
CD-ROM 102
controller

name 102
replacing 159

controller name 102
viewing 132, 158

cluster (continued)
creating

partition 121
ServeRAID disk resource 116, 123

detailed view (illus.) 98
error messages 162
failback 101
failed controller 158
failed server 157, 161
failover 101, 161
firmware updates 137
high-level view (illus.) 98
hot-spare drive 102, 108, 109, 130
logical drive 108, 109

adding 130
Basic Disk 121, 124
deleting 117, 125
maximum 103
merge-group number 110
migration 103
non-shared 102, 153
re-creating 117, 125
rebuilding 103
shared 102, 153

merge-group number 102
viewing 132, 158

partner name 158
viewing 132

physical drive ownership 129
problems 157
publications xiv
quorum drive 103, 109
RAID levels 109
SCSI initiator ID 102

viewing 132, 158
shared channel 108, 109
standby hot-spare drive 108
stripe-unit size 102
support 29, 135
synchronization 103
updating

BIOS 120
device drivers 119
firmware 120
other server 120
ServeRAID Manager 119
software 119

validating 105, 131
write back 102
write through 102

command-line programs 63, 85
configuration

custom 34
displaying 82
express 32
fine-tuning 38
loading from file 77
saving 76, 111
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configuration (continued)
summary window 37

configuration program
see ServeRAID Manager 30

connector locations 4
contents, option box 3
controller xi, 97

configuring 30
cluster 106
Microsoft Cluster Service 105

connector locations 4
failed in cluster 158
failover 45, 46

recovering from power failure 156
replacing in hot-plug PCI slot 156
replacing in non-hot-plug PCI slot 155

features 3
installing 10
list information 80
messages 141
monitoring 85
name

cluster 102
failover 46

onboard 46
problems 80
replacing 159
self-test 81
shared 103
startup, device drivers 33, 37

controller name
cluster 102
failover 46

copyId (IPSSEND) 76
create (IPSSEND) 81
critical logical drive 26
critical migrating logical drive 26
critical system logical drive 26
custom configuration 34

D
data loss 9, 79, 153

RAID level-0 18
RAID level-00 25

data mirroring 18
data striping 15, 17
debugging 80
defunct physical drive 26

recovering 153
delete (IPSSEND) 74, 82
device

Hardware Compatibility List 137
IBM Server Proven List 137
retrieve information 82

device drivers xiii
installation instructions 43
startup controller 33, 37
updates 29, 135

disk signatures 121

diskette
IBM ServeRAID BIOS and Firmware Update (1 of

2) xiii
IBM ServeRAID BIOS and Firmware Update (2 of

2) xiii
IBM ServeRAID Cluster Solution for Windows NT 4.0

and Windows 2000 xiii, 121
IBM ServeRAID for IBM OS/2 xiii
IBM ServeRAID Support for Caldera OpenLinux xiv
IBM ServeRAID Support for Caldera UnixWare and

Open UNIX xiv, 67
IBM ServeRAID Support for DOS xiv, 63
IBM ServeRAID Support for Novell NetWare xiv, 85
IBM ServeRAID Support for Red Hat Linux (1 of

2) xiv
IBM ServeRAID Support for Red Hat Linux (2 of

2) xiv
IBM ServeRAID Support for SCO OpenServer xiv,

66
IBM ServeRAID Support for SuSE Linux xiv
IBM ServeRAID Support for Turbolinux xiv
IBM ServeRAID Support for Windows 2000

Professional xiii
IBM ServeRAID Support for Windows 2000

Server xiii
IBM ServeRAID Support for Windows NT 4.0 xiii

diskette images xiii
distributed spare drive 22, 23
DMI Service provider 9, 88
DOS

IPSSEND 69
drive cloning 69
drive letter, permanent 114, 116, 121, 124
drivever (IPSSEND) 82

E
ECS error codes 147
electronic emission Class A notice 185
enclosure

cluster 97
failover 49

eraseevent (IPSSEND) 79
error

codes 147
messages 162

example
RAID level-0 17
RAID level-1 18
RAID level-10 24
RAID level-1E 19
RAID level-5 21
RAID level-5E 22
spanned array 24

express configuration 32

F
failback 101
failover 45

active-passive pair 45

192 IBM® User’s Reference: ServeRAID™ -4 Ultra160 SCSI Controller



failover (continued)
array 50
assigning merge-group numbers 53
BIOS 45
cables 46
cluster 101, 161
configuration

array 50
logical drive 50
saving 54

controller 45, 46
hot-plug PCI slot 156
non-hot-plug PCI slot 155

controller name 46
correctly-configured failover pair

illustration 55
enclosure 45, 49
failure 155
firmware 45
guidelines and restrictions 45
hot add 46
hot-spare drive 46, 51
logical drive 50
merge-group number 46
Microsoft Cluster Service 46
NVRAM 47, 106
partner name 46
recovering from power failure 156
SCSI initiator IDs 48, 49
stripe-unit size 45
write-cache mode 46

fault tolerance 45
FCC Class A notice 185
firmware

failover 45
IBM ServeRAID ROM Update Wizard xiii, 30
updates 29, 135, 137
updating 30, 120

FlashCopy 69
autosync 75
backup 69, 71, 76
copyId 76
delete 74
import 75
init 76
map 70
nobackup 69, 73
restore 77
spanned array 70
stop all 74
synch 77

FlashMan
see IBM ServeRAID ROM Update Wizard xiii, 30

format (IPSSEND) 79, 152

G
getbst (IPSSEND) 80
getconfig (IPSSEND) 82
getevent (IPSSEND) 80
getstatus (IPSSEND) 77

H
high-availability cluster solution 97
hot add 9, 46
Hot-plug PCI, see Active PCI 9
hot remove 9
hot replace 9, 10
Hot Replace Wizard 10, 88
hot-spare drive 26, 32, 46

cluster 102, 108, 109, 130
creating 34
failover 46, 51

hot-swap physical drive, rebuilding 154
hot-swap rebuild feature 83, 154
hsrebuild (IPSSEND) 83

I
IBM

Hot Plug for Windows NT 4.0 Package 9, 10, 88
ServeRAID

Cluster Solution xiv, 125
publications xiv
Support diskettes xiii, 63, 64, 65

Support Web site 29, 135
id (IPSSEND) 80
import (IPSSEND) 75
init (IPSSEND) 76
initializing logical drive 76
installation steps 29
installing

IPSMON 85
IPSSEND 63, 64, 65, 66, 67

IPSMON 85
log file 86
messages 86
starting 85

IPSSEND xiii, 63
certify 79
create 81
delete 82
drivever 82
eraseevent 79
FlashCopy 69

autosync 75
backup 69, 71, 76
copyId 76
delete 74
import 75
init 76
map 70
nobackup 69, 73
restore 77
stop all 74
synch 77

format 79, 152
getbst 80
getconfig 82
getevent 80
getstatus 77
hsrebuild 83
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IPSSEND (continued)
id 80
installing 63, 65, 66, 67
installing from CD 63, 65, 66, 67
installing from diskette 64, 65, 66, 67
logs 79
readahead 83
rebuild 78
scandrives 83
selftest 81
setconfig 83
setstate 78
startdely 84
starting 68
unattended 84
unblock 78
using 68

ISPR error codes 147

J
Java 89, 91
Java Runtime Environment 89

L
LEDs 4
Linux

IPSSEND 65, 68
logical drive 15

bad stripe 80
blocked 78
blocked state 26
cluster 108, 109

adding 130
blocked 153
deleting 117, 125
re-creating 117, 125

copying 76
creating

cluster 109
critical 78
critical migrating state 26
critical state 26
critical system state 26
failover 50
initializing 76
mapping 70
maximum, cluster 103
migrating state 26
migration

cluster 103
status 77

non-shared 102
merge-group number 110

offline state 27
okay state 27
rebuilding 77, 78, 103
shared 102

disk signatures 121
drive letter 123

logical drive (continued)
shared (continued)

merge-group number 110
states 26
status 77
sub-logical drive 25
synchronization 77
system state 27
volume label 122

logical drives
size limitations 33, 35

M
map (IPSSEND) 70
merge-group number

cluster 102
failover 46
logical drive

non-shared 110
shared 110, 116, 123

messages 141
POST 146
startup 141, 146

Microsoft Cluster Service
certified 137
configuring controllers 105
failover 46
installing

ServeRAID Manager 113, 120
Windows 2000 126
Windows NT 4.0 114

uninstalling 118, 126
updating

BIOS 120
device drivers 119
firmware 120
other server 120
ServeRAID Cluster Solution 119
ServeRAID Manager 119
software 119

migrating logical drive 26
Mini-configuration program 59

Advanced Functions 59, 60
Configure BIOS Settings 61
Copy the Configuration from Drives to Controller 61
Restore to Factory Default Settings 60
View Configuration 59, 60
View Controller and PCI Information 61
View Controller Status 59

multiserver rollout 69

N
NetWare

Active PCI 9
Hot-plug PCI 9
IPSMON 85
IPSSEND 63, 64, 68
ServeRAID Manager 88, 89
starting ServeRAID Manager 92
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NetWare (continued)
Web site 89
write-cache mode 40

nobackup (IPSSEND) 73
non-shared logical drive 110
notes, important 184
notices

Attention xii
electronic emission 185
FCC, Class A 185
Important xii
Notes xii

Novell
Java Virtual Machine 89
Web site 89

NVRAM
failover 47, 106

O
offline logical drive 27
okay logical drive 27
online physical drive 26
Open UNIX

IPSSEND 67, 68
ServeRAID Manager 91
starting ServeRAID Manager 93

OpenServer
IPSSEND 66, 68
Java Development Kit 91
Java Runtime Environment 91
ServeRAID Manager 90, 91
starting ServeRAID Manager 93

OS/2
IPSSEND 63, 64, 68
ServeRAID Manager 90
starting ServeRAID Manager 93

P
package contents 3
parity 20
partition, creating 121
partition table, erasing 76
partner name

failover 46
performance tuning

selecting a RAID level 16
stripe-unit size 15

permanent drive letter 114, 116, 121, 124
physical drive

data loss 79
defunct 153
defunct state 26
delaying 84
failure

RAID level-0 17
RAID level-1 19
RAID level-1E 20
RAID level-5 21
RAID level-5E 23

physical drive (continued)
failure (continued)

RAID level-x0 25
formatting 79

recovering from incomplete 152
hot-spare 51
hot-spare state 26
online state 26
ownership 129
ready state 26
rebuilding 153
rebuilding state 26
standby hot-spare state 26
starting 84
states 26, 78
verifying media 79

POST messages 146
Predictive Failure Analysis 79, 80
problems

cluster 157
error messages 162
failed controller 158
failed server 157, 161
failover 161
replacing controller 159

controller 80
defunct drives 153
error codes 147
failover 155

recovering from power failure 156
replacing controller in hot-plug PCI slot 156
replacing controller in non-hot-plug PCI slot 155

hot-swap drives 154
incomplete format 152
messages

controller 141
POST 146

SCSI 80
ServeRAID Manager 141
solving 141

program
IBM ServeRAID ROM Update Wizard xiii, 30
IPSMON 85
IPSSEND 63, 68
Mini-configuration 59
ServeRAID Hot Replace Wizard 10
ServeRAID Manager 30, 87
updates 29, 135

Q
quorum drive 103, 109, 116, 123

R
RAID

level-0 17
advantages and disadvantages 18
blocked 78, 153
supported number of drives 17

level-00, see RAID level-x0 24
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RAID (continued)
level-1 18

advantages and disadvantages 19
quorum drive 116, 123
supported number of drives 18
synchronization 103

level-1 Enhanced, see RAID level-1E 19
level-10, see RAID level-x0 24
level-1E 19

advantages and disadvantages 20
supported number of drives 19, 22

level-1E0, see RAID level-x0 24
level-5 20

advantages and disadvantages 22
supported number of drives 20
synchronization 75

level-5 Enhanced, see RAID level-5E 22
level-50, see RAID level-x0 24
level-5E 22

advantages and disadvantages 23
cluster 109

level-x0 24
advantages and disadvantages 25
supported number of drives 24

performance tuning 16
selecting level 16
technology 15

read-ahead cache mode 60, 83
readahead (IPSSEND) 83
ready physical drive 26
rebuild

defunct drive 153
physical drive 26

rebuild (IPSSEND) 78
Red Hat Linux

installing ServeRAID Manager 89
ServeRAID Manager 90
starting ServeRAID Manager 93

restore (IPSSEND) 77

S
safety information, electrical v
scan for new drives 114
scandrives (IPSSEND) 83
SCO, see also OpenServer and UnixWare

Web site 91
SCSI

channel 4, 5, 7
initiator ID 102
shared channels 108

self-test, controller 81
selftest (IPSSEND) 81
ServeRAID

device drivers xiii
diskette images xiii
diskettes xiii
Hot Replace Wizard 10, 88
installation steps 29
Manager

starting 92

ServeRAID (continued)
Manager (continued)

using 30
onboard controllers 46
publications xiv
ROM Update Wizard xiii, 30
software

downloading 29
Support diskettes xiii, 63, 64, 65
supported RAID levels 16

ServeRAID Manager xiii, 38, 87
Configuration wizard 31

(illus.) 32
illustration 50
using 32

installing 87, 88, 89, 90, 91, 113, 120
online help 40, 87

hints and tips 40
startable-CD mode 30, 31
starting 92, 93

service summary 165
setconfig (IPSSEND) 83
setstate (IPSSEND) 78
shared channel 109
shared logical drive 110, 116, 123

disk signatures 121
spanned array 24
spanned arrays 34

creating 37
standby hot-spare drive 26

cluster 108
startdely (IPSSEND) 84
startup (boot) drive 35, 52
startup messages 141, 146
stop all (IPSSEND) 74
stripe 15, 80
stripe-unit size 15, 39

cluster 102
performance tuning 15

sub-logical drive 25
SuSE Linux

installing ServeRAID Manager 89
ServeRAID Manager 90
starting ServeRAID Manager 93

synch (IPSSEND) 77
synchronization 75
system logical drive 27

T
tape backup 69, 71
throughput 15
trademarks 184
Turbolinux

installing ServeRAID Manager 89
ServeRAID Manager 90
starting ServeRAID Manager 93
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U
unattended (IPSSEND) 84
unattended mode 59, 84
unblock (IPSSEND) 78
United States electronic emission Class A notice 185
United States FCC Class A notice 185
UnixWare

IPSSEND 67, 68
ServeRAID Manager 91
starting ServeRAID Manager 93

updates 29, 135
updating

BIOS 120
device drivers 119
firmware 120
other server in cluster 120
ServeRAID Cluster Solution 119
ServeRAID software 119
software 119

upgrading, IBM ServeRAID Cluster Solution 125
Upgrading, ServeRAID controller 139

V
validate cluster 105, 131
volume label 122

W
Web sites

IBM Support 29, 135
Novell NetWare 89
SCO 91

Windows 2000
Active PCI 9
Advanced Server CD 137
failover 45
FlashCopy 69
Hardware Compatibility List 137
Hot-plug PCI 9
IBM Server Proven List 137
IPSSEND 63, 64, 68
ServeRAID Manager 88
starting ServeRAID Manager 92

Windows 95
installing ServeRAID Manager 88
starting ServeRAID Manager 92

Windows 98
installing ServeRAID Manager 88
starting ServeRAID Manager 92

Windows Me
installing ServeRAID Manager 88
starting ServeRAID Manager 92

Windows NT 4.0
Active PCI 9
failover 45
FlashCopy 69
Hot-plug PCI 9
IBM Hot Plug for Windows NT 4.0 Package 9
installing Microsoft Cluster Service 114

Windows NT 4.0 (continued)
IPSSEND 63, 64, 68
ServeRAID Manager 88
starting ServeRAID Manager 92

Windows XP
FlashCopy 69
IPSSEND 63, 68
ServeRAID Manager 88
starting ServeRAID Manager 92

write back 102
write-cache mode 40

failover 46
write back 4, 5

write through
cluster 102
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